Legal Notices

This guide is copyrighted ©2010 by Avid Technology, Inc., (hereafter “Avid”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Avid.


Product features, specifications, system requirements, and availability are subject to change without notice.

Guide Part Number 9329-62649-00 REV A 06/10

Documentation Feedback

At Avid, we are always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, email us at techpubs@avid.com.
# Contents

## Chapter 1. Welcome to the 003 Family
- 003 Family Features .................................................. 1
- Pro Tools LE Capabilities ........................................... 2
- System Requirements and Compatibility .......................... 3
- Registration .......................................................... 3
- Conventions Used in This Guide .................................... 4

## Chapter 2. Installing Pro Tools on Mac
- Installation Overview .................................................. 5
- Installing Pro Tools LE and Connecting Your Interface ........ 5
- Launching Pro Tools LE ............................................... 8
- Additional Software on the Pro Tools Installer Disc ............ 9
- Connecting FireWire Drives ........................................ 10
- Uninstalling Pro Tools ................................................ 11

## Chapter 3. Installing Pro Tools on Windows
- Installation Overview .................................................. 13
- Installing Pro Tools LE and Connecting Your Interface ........ 13
- Launching Pro Tools LE ............................................... 16
- Additional Software on the Pro Tools Installer Disc ............ 17
- Connecting FireWire Drives ........................................ 18
- Connecting to Laptops with 4-Pin FireWire Cable ............. 19
- Uninstalling Pro Tools ................................................ 19
## Chapter 10. Making Studio Connections

- Connecting Headphones .................................................. 77
- Connecting a Sound System .............................................. 77
- Connecting Audio Inputs .................................................... 79
- Connecting a Microphone ................................................... 80
- Connecting Instruments to 003 Family Interfaces .................. 83
- Connecting Equipment with Digital Ins and Outs .................. 86
- Word Clock ................................................................. 87
- Using External Effects Devices ........................................... 88
- Monitoring and Recording from Alternate Sources ............... 89
- Recording from a Digital Device ......................................... 90
- Connecting a Recorder for Mixdowns ................................. 91
- MIDI Connections ........................................................ 91
- Using a Footswitch ......................................................... 92

## Chapter 11. Pro Tools Mode with 003

- Saving a Session ........................................................... 93
- Working in Console View .................................................. 94
- Working in Channel View ................................................ 97
- Display Options in Console and Channel View ...................... 100
- Creating Custom Plug-In Maps ......................................... 102
- Navigating and Editing Values in Entry Fields .................... 103
- Working with Tracks ...................................................... 103
- Assigning Pro Tools Paths (Input, Output, Sends, Inserts) .... 104
- Working with Output Windows ......................................... 107
- Recording ................................................................ 108
- Navigating in the Edit Window ......................................... 108
- General Editing ............................................................ 109
- Working With Memory Locations ...................................... 110
- Controlling Track Display on the Control Surface ............... 110
- Working with Automation ............................................... 112
- 003 Top Panel Shortcuts ............................................... 113
Chapter 12. Using MIDI Mode with 003 ....................................................... 117

Overview of MIDI Mode ................................................................. 117
Selecting MIDI Mode ................................................................. 118
Recalling MIDI Map Presets ......................................................... 119
Mapping Controls ....................................................................... 120
Editing MIDI Map Presets ............................................................ 121
Naming MIDI Map Presets ............................................................. 123
Saving MIDI Map Presets .............................................................. 123
Factory Default ............................................................................ 124
Factory Presets ............................................................................ 124

Appendix A. Utility Mode (003 Only) .................................................. 145

Accessing Utility Mode ................................................................ 145
Viewing Firmware Version Data ................................................... 146
LCD Display Test .......................................................................... 146
LED Tests ..................................................................................... 146
Switch Test ................................................................................... 147
Encoder Test ................................................................................ 147
Fader Tests .................................................................................. 147
Vegas Mode .................................................................................. 148
MIDI Test ...................................................................................... 149
Audio Test ..................................................................................... 149

Appendix B. Configuring AMS (Mac OS X Only) .................................. 151

Audio MIDI Setup ......................................................................... 151
Patch Name Support ..................................................................... 154

Appendix C. Configuring MIDI Studio Setup (Windows Only) .............. 155

MIDI Studio Setup ......................................................................... 155
MIDI Patch Name Support ............................................................ 157
Appendix D. Hard Drive Configuration and Maintenance .......................... 159
  Avoid Recording to the System Drive ............................................. 159
  Supported Drive Formats and Drive Types ...................................... 159
  Formatting an Audio Drive ........................................................... 160
  Partitioning Drives ..................................................................... 161
  Defragmenting an Audio Drive ....................................................... 162
  Using Mac Drives on Windows Systems .......................................... 163
  Hard Disk Storage Space ............................................................... 164

Appendix E. Troubleshooting .............................................................. 167
  Backing Up Your Work .................................................................. 167
  Common Issues ........................................................................... 167
  Performance Factors ................................................................... 168
  Before You Call Avid Support ....................................................... 169

Appendix F. Resources ..................................................................... 171
  About the Pro Tools Guides ............................................................ 171
  About www.avid.com .................................................................. 172

Appendix G. Compliance Information ................................................ 173
  Environmental Compliance ............................................................. 173
  EMC (Electromagnetic Compliance) ................................................ 174
  Safety Compliance ....................................................................... 175

Index ......................................................................................... 177
Welcome to the 003® family of cross-platform Pro Tools® workstations for music, sound design, and multimedia production from Avid. The 003 family includes 003, 003 Rack, and 003 Rack+ devices.

**003 Family Features**

Each 003 family interface has unique features. However, all 003 family units share the following input and output capacity:

- Up to 18 channels of I/O.
- Eight analog audio inputs, with D/A converters supporting up to 24-bit, 96 kHz audio.
- Eight analog audio outputs, with D/A converters supporting up to 24-bit, 96 kHz audio.
- Main and Alternate Monitor Output pairs (+4 dBU) with a single level control. These outputs mirror Outputs 1–2 and provide direct connection to a monitoring system (such as a stereo power amp, powered speakers, or another stereo destination).
- Aux Input pair (+4 dBu) for direct monitoring of tape or CD input sources.
- Two 1/4-inch stereo headphone outputs (Headphone 1 and 2) with level controls. Headphone 2 can monitor Main Outputs 1–2 like Headphone 1, or be switched to monitor Outputs 3–4 for a discrete cue mix.
- Optical connectors for eight channels of Optical (ADAT) I/O (supporting up to 48 kHz) or two channels of Optical S/PDIF I/O.
- RCA connectors for two channels of S/PDIF digital I/O supporting up to 24-bit, 96 kHz audio.
- Word Clock In and Out ports, to receive or send 1x Word clock.
- Footswitch jack for starting and stopping playback or punching in/out while recording.
- Monitor section with Mute switch and switches for routing input and output signals.

**Audio and MIDI Features**

**003 and 003 Rack**

- Eight analog audio inputs.
- Inputs 1-4 feature:
  - Support for microphone (XLR) and DI (1/4”) inputs.
  - 75 Hz high-pass filters (HPFs), switchable per channel.
  - 48V phantom power on mic inputs, switchable in channel pairs.
- Line inputs 5–8 (1/4” TRS) switchable between +4 dBu (for pro-level gear) and –10 dBV (for consumer-level gear).
- One MIDI In port and two MIDI Out ports, providing up to 16 channels of MIDI input and up to 32 channels of MIDI output.
003 Rack+

- Eight analog audio inputs.
- Each input channel features:
  - Support for microphone (XLR) and Line/DI (1/4" TRS) inputs.
  - 75 Hz high-pass filter (HPF), switchable per channel.
  - 48V phantom power on mic inputs, switchable per channel.
  - –20 dB pad, switchable per channel.
- Front panel DI input.
- One MIDI In port and one MIDI Out port, providing up to 16 channels of MIDI input and up to 16 channels of MIDI output.

Control Surface Features

(Control Surface Features

(003 Only))

003 provides an integrated control surface that includes the following:

- Eight motorized touch-sensitive faders for controlling track volume and other parameters. Includes ability to disable faders during playback of automated mixes.
- Dedicated Solo, Mute and Channel Select/Record Arm switches.
- Eight multifunction rotary encoders for operating pan, send, and plug-in controls.
- Fast and convenient access to sends, inserts, plug-in pages, pan settings, and other track functions.
- Automation Mode switches for selecting and displaying Automation modes.
- Large, bright LCD for data display.
- Transport controls, plus Transport mode switches for loop playback, loop record, and QuickPunch.
- Dual-concentric Jog/Shuttle wheel.
- Save, Undo, and Enter switches. Memory Location switch for recalling Memory Locations or opening the Memory Location window.
- Windows switches for Pro Tools display of plug-in, Mix, and Edit windows.
- Navigation and Zoom controls.
- MIDI mode switches for MIDI mapping.
- Utility mode switch for testing 003.

Pro Tools LE Capabilities

Pro Tools LE™ with an 003 family device on Mac or Windows provides the following capabilities:

- Playback of up to 48 mono or stereo digital audio tracks, or a combination of playing back and recording up to 48 mono or stereo digital audio tracks, depending on your computer's capabilities.
- Up to 128 audio tracks (with up to 48 active tracks), 128 Auxiliary Input tracks, 64 Master Fader tracks, 256 MIDI tracks, and 32 Instrument tracks per session.
- 16-bit or 24-bit audio resolution, at sample rates up to 48 kHz.
- Non-destructive, random-access editing and mix automation.
- Audio processing with up to 10 inserts per track (RTAS plug-ins or hardware inserts).
- Up to 10 sends per track.
- Up to 32 internal mix busses.

⚠️ Pro Tools LE uses your computer’s CPU to mix and process audio tracks. Computers with faster clock speeds yield higher track counts and more plug-in processing.
Chapter 1: Welcome to the 003 Family

System Requirements and Compatibility

Avid can only assure compatibility and provide support for hardware and software it has tested and approved.

For complete system requirements and a list of qualified computers, operating systems, hard drives, and third-party devices, visit:

www.avid.com/compatibility

MIDI Requirements

003 and 003 Rack include one MIDI In port and two MIDI Out ports, providing 16 channels of MIDI input and 32 channels of MIDI output. The 003 Rack+ includes one MIDI In port and one MIDI Out port, providing 16 channels of MIDI I/O.

003 family interfaces support any device that supports MIDI continuous controller (CC) data. Drivers are provided to use 003 as a MIDI control surface on any supported Mac or Windows computer with virtually any compatible software.

In MIDI mode, 003 family units send the same MIDI control data over FireWire and the MIDI Out 1 port. It responds to MIDI data received over FireWire and from the MIDI In port. If you require additional MIDI ports, add a MIDI interface to your system. USB MIDI interfaces work effectively with Pro Tools systems on Windows or Mac.

Avoid Recording to the System Drive

Recording to your system drive is not recommended. Recording and playback on a system drive may result in lower track counts and fewer plug-ins.

Hard Drive Requirements

For optimal audio recording and playback, all Pro Tools systems require one or more qualified hard drives.

If you are using an ATA/IDE or FireWire hard drive, initialize your drive with the Disk Utility application included with Apple System software (Mac) or Windows Disk Management (Windows).

For more information, see Appendix D, “Hard Drive Configuration and Maintenance.”

Registration

Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online. By registering, you become eligible to receive the following:

- Technical support information
- Software update and upgrade notices
- Hardware warranty information

Only USB MIDI interfaces are compatible with Pro Tools systems for Mac OS X. Modem-to-serial port adapters and serial MIDI devices are not supported.

For a list of supported MIDI interfaces and controllers, visit www.avid.com.
Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 *User Tips* are helpful hints for getting the most from your system.

⚠️ *Important Notices* include information that could affect your data or the performance of your system.

🔍 *Shortcuts* show you useful keyboard or mouse shortcuts.

🔍 *Cross References* point to related sections in this guide and other Pro Tools guides.
This chapter contains information for Mac systems only. If you are installing Pro Tools on a Windows computer, see Chapter 3, “Installing Pro Tools on Windows.”

⚠️ Before installing this version of Pro Tools, see the Read Me information included on the Pro Tools Installer disc.

Installation Overview

Installing your 003 family system on a Mac includes the following steps:

1 “Installing Pro Tools LE and Connecting Your Interface” on page 5.
2 “Launching Pro Tools LE” on page 8.
3 “Launching Pro Tools LE” on page 8.
4 Configuring your system for improved performance (see Chapter 4, “Configuring Your Pro Tools System”).
5 Making audio and MIDI connections to your 003 family interface (see Chapter 10, “Making Studio Connections”).

💡 The Pro Tools Installer disc includes additional software for your system. For more information, see “Additional Software on the Pro Tools Installer Disc” on page 9.

Installing Pro Tools LE and Connecting Your Interface

Before connecting your 003 family interface to your computer, you need to install Pro Tools LE software.

⚠️ Do not connect your 003 family interface to your computer until you have installed Pro Tools LE software.

To install Pro Tools LE:

1 Make sure you are logged in as an Administrator for the account where you want to install Pro Tools.

⚠️ For details on Administrator privileges in Mac OS X, see your Apple OS X documentation.

2 Insert the Pro Tools LE Installer disc in your DVD drive.

3 On the Installer disc, locate and double-click Install Pro Tools LE.mpkg.
4 Follow the on-screen instructions to proceed with installation.

5 Click Continue each time you are prompted.

6 At the Installation Type page, do one of the following:
   - To install all Pro Tools application files and free plug-in suites (and associated content), leave the default Installation options selected and click Continue.
   - or –
   - Select (or deselect) a custom configuration of Installation options (see “Installation Options” on page 7) and click Continue.

7 Click Install.

8 If prompted, enter your Administrator password and click OK to authenticate the installation.

9 Follow the remaining on-screen instructions.

10 When installation is complete, click Restart.

11 Before launching Pro Tools LE software, shut down your computer and connect the 003 family interface to your computer.

12 Plug the 003 family interface into a standard AC outlet, using the AC power cable included with the unit. AC power is required to operate your 003 family interface.

13 Locate the FireWire cable that came with your unit.

14 Plug one end of the FireWire cable into one of the ports marked “1394” on the back panel of your 003 family interface. Either port will work.

15 Do one of the following, depending on your system configuration:
   - Plug the other end of the FireWire cable into an available FireWire port on your computer.
   - or –
   - If your computer has only one FireWire port, plug the other end of the FireWire cable into an available FireWire port on a FireWire hard drive connected to your computer.

⚠ Connecting your 003 family interface to your computer through a FireWire hard drive does not provide the maximum track count. To achieve the maximum track count, install a qualified PCI/PCMCIA/ExpressCard to increase the number of FireWire ports on your computer.

For information on supported PCI/PCMCIA/ExpressCard FireWire options, visit the Avid website (www.avid.com).

Be sure to note the orientation of the FireWire cable connector when you insert it in your 003 family interface. It is possible to damage the FireWire port if you force the connector in upside down.
Installation Options

Pro Tools LE Options

To install a subset of Pro Tools software and plug-ins (and associated content), click the reveal triangle for the Pro Tools LE option in the installer, and deselect any of the following options that you do not want installed.

Application Files (Required for Pro Tools) Installs the Pro Tools application and supporting library files needed to run Pro Tools. This option also installs the Avid CoreAudio Driver. This option must be selected to install Pro Tools.

DigiRack Plug-Ins installs free plug-ins including DigiRack plug-ins, free Bomb Factory plug-ins, Eleven Free, TL Utilities, and D-Fi and Maxim plug-ins. For more information, see the Audio Plug-Ins Guide.

Pro Tools Creative Collection

Select any of the Pro Tools Creative Collection options you want installed. For more information, see the Audio Plug-Ins Guide.

Effects Plug-Ins Installs 20 free effects plug-ins from Avid’s AIR group.

Virtual Instruments Installs six free virtual instrument plug-ins from Avid’s AIR Group.

Virtual Instrument Content Installs sample content for AIR virtual instruments.

💡 Virtual Instrument content is very large and may take up to 20 minutes to install. During this time, the progress bar may not appear to move but your software is still installing. Do not terminate the installation.

Additional Options

The Pro Tools installer provides the following additional options to install along with Pro Tools software and plug-ins.

Avid CoreAudio Driver This option installs the Avid CoreAudio Driver, which lets you use qualified audio interfaces with third-party applications that support the CoreAudio Driver standard.

Avid Video Engine This option lets you integrate Avid® video peripherals such as the Avid Mojo® with your Pro Tools system. Do not install unless you will be using one of these products.

Command|8 Controller and Driver This option installs the personality file and device driver for the Avid Command|8® control surface. Do not install unless you will be using Command|8.
Launching Pro Tools LE

When launching Pro Tools LE the first time, you are prompted to enter an authorization code to validate your software. (The code begins with the letters DIGI.)

To authorize Pro Tools LE software:

1. Make sure your 003 family interface is connected to your computer and powered on.

2. Do one of the following:
   - Click the Pro Tools LE icon in the Dock.
   - or –
   - Locate and double-click the Pro Tools LE application on your hard drive.

3. Enter the authorization code in the dialog (making sure to type it exactly as printed, observing any spaces and capitalization), then click Validate. (Your authorization code is located on the back of your Pro Tools DVD wallet.)

4. Use the Quick Start dialog to do one of the following:
   - Create a new session from a template.
   - Create a new blank session.
   - Open any other session on your system.

Quick Start dialog

Updating 003 Family Firmware

When you launch Pro Tools software, it automatically checks the version of the unit’s firmware and prompts you to update it if a newer version is available.

If you update your unit’s firmware, let the update complete before disconnecting or turning off your system.

When a firmware update completes, Pro Tools quits, and you must relaunch Pro Tools.

If during the update process you get a message that Pro Tools cannot communicate with your 003 family interface, wait up to 30 seconds for the message to close. If the message does not go away, power off 003 family interface and then power it on again.
Additional Software on the Pro Tools Installer Disc

The Pro Tools Installer disc provides additional software for your system, including drivers to let third party applications play and record through Pro Tools hardware, and a Pro Tools demo session.

Third-Party Applications and Plug-Ins

Your Pro Tools package also includes several free applications and plug-ins from Avid and selected Avid Third Party developers. Once you've completed your Pro Tools installation, you can install these separately.

003 Factory Bundle Plug-Ins

If you purchased a Factory version of your 003 family system, go to the Additional Files/Factory Bundle Installers folder on the Pro Tools LE Installer disc and run the Install 003 Factory Bundle installer.

Avid CoreAudio Driver

The Avid CoreAudio Driver is a multi-client, multichannel sound driver that allows CoreAudio-compatible applications to record and play back through Pro Tools hardware.

The Avid CoreAudio Driver is installed by default when you install Pro Tools.

Standalone CoreAudio Driver

The CoreAudio Driver can be installed as a standalone driver on Mac systems that do not have Pro Tools software installed.

For information on installing and configuring the standalone version of the Avid CoreAudio Driver, see the CoreAudio Drivers Guide.

If you uninstall Pro Tools, the Avid CoreAudio Driver is automatically uninstalled.

Pro Tools Demo Session

The Pro Tools LE Installer disc includes a demo session that you can use to verify that your system is working. The demo session for Pro Tool LE is named “Filtered Dream.”

Before installing the demo session to your audio drive, make sure the drive is configured as described in “Formatting an Audio Drive” on page 160.

To install the demo session:

1 Insert the Pro Tools LE Installer disc into your DVD drive.

2 On the Pro Tools LE Installer disc, locate and open the Additional Files/Pro Tools Demo Sessions Installer folder.

3 Double-click Install demo session.pkg.

4 Follow the on-screen instructions.

5 When prompted, select your audio drive as the install location and click Next to begin the installation.

6 When installation is complete, click Close.

The demo session can be opened by double-clicking the Filtered Dream.ptf file (in the Filtered Dream Demo Session folder).

Check your Pro Tools Installer disc for additional software and installers.

For information on configuring the Avid CoreAudioDriver, see the CoreAudio Drivers Guide.
Connecting FireWire Drives

Connect FireWire hard drives directly to an available FireWire port on your computer.


![Warning] Do not connect a FireWire hard drive to the second FireWire port on the back panel of your 003 family interface.

The FireWire ports on 003 family interfaces do not pass data when they are powered off. If you daisy-chain FireWire devices from your computer, it is best to connect FireWire hard drives directly to your computer and not to the 003 family interface. This will prevent hard drive errors and data loss in case the 003 family interface is powered off.


![Warning] To yield higher performance from audio drives, enable journaling. See “Enabling Journaling for Audio Drives” on page 32.

To connect a FireWire hard drive, do one of the following:

- If your computer has more than one FireWire port, connect the FireWire hard drive to one FireWire port on the computer, and connect your 003 family interface to another FireWire port on the computer.

  – or –

- If your computer has only one FireWire port, connect the FireWire hard drive directly to your computer and then connect your 003 family interface to an available FireWire port on the drive.

![Warning] Connecting your 003 family interface to your computer through a FireWire hard drive does not support maximum track count. To achieve the maximum track count, purchase a PCI/PCMCIA/ExpressCard to increase the number of FireWire ports on your computer.

For information on supported PCI/PCMCIA/ExpressCard FireWire options, visit the Avid website (www.avid.com).

Connecting Other FireWire Devices to 003 Family Interfaces

The second FireWire port on your 003 family interface is available for daisy-chaining FireWire devices such as digital cameras or digital video recorders. Even when it is powered off, 003 family interfaces supply power from the computer through its FireWire ports, letting you recharge batteries in connected FireWire devices.
Uninstalling Pro Tools

If you need to remove Pro Tools software from your computer, use the Uninstaller application.

To uninstall Pro Tools from your computer:

1. Make sure you are logged in as an Administrator for the account where Pro Tools is installed.

   For details on Administrator privileges in Mac OS X, see your Apple OS X documentation.

2. Go to Applications/Digidesign/Pro Tools/Pro Tools Utilities and double-click Uninstall Pro Tools.

3. Click Continue to proceed with the uninstall.

4. Choose the type of uninstall you want to perform:

   **Safe Uninstall** Leaves certain plug-ins and system files needed for compatibility with some Avid products. Use Safe Uninstall if you are using an Avid application or preparing to update to a .cs release.

   **Clean Uninstall** Removes all Pro Tools files, including system files, plug-ins, and MIDI patch names. Use Clean Uninstall whenever you are preparing to upgrade, or to troubleshoot from a clean system.

5. Click Uninstall.

6. Enter your Administrator password and click OK.

7. Click Finish to close the Installer window.
This chapter contains information for Windows systems only. If you are installing Pro Tools on a Mac computer, see Chapter 2, “Installing Pro Tools on Mac.”

⚠️ Before installing this version of Pro Tools, see the Read Me information included on the Pro Tools Installer disc.

### Installation Overview

Installing your 003 family system on a Windows computer includes the following steps:

3. Configuring your system for improved performance. (See Chapter 4, “Configuring Your Pro Tools System.”)
4. Making audio and MIDI connections to your 003 family interface. (See Chapter 10, “Making Studio Connections.”)

💡 The Pro Tools Installer disc includes additional software for your system. For more information, see “Launching Pro Tools LE” on page 16.

#### Installing Pro Tools LE and Connecting Your Interface

Before connecting your 003 family interface to your computer, you need to install Pro Tools LE software.

⚠️ Do not start this procedure with your 003 family interface connected to your computer.

**To install Pro Tools LE:**

1. Start Windows, logging in with Administrator privileges. For details on Administrator privileges, refer to your Windows documentation.

💡 When the installation is complete, you will need to restart your computer.

2. Insert the Pro Tools LE Installer disc in your DVD drive and do one of the following:
   - If Windows AutoRun is enabled, a mini-browser appears. Select Install Pro Tools LE to begin installation.
   - or –
   - If Windows AutoRun is not enabled, locate and double-click Setup.exe on the Installer disc.
3 Follow the on-screen instructions to proceed with installation and click Next when prompted.

4 To install the complete compliment of Pro Tools software and plug-ins, leave Pro Tools selected.

5 At the Select Features page, do one of the following:
   - To install all Pro Tools application files and free plug-in suites (and associated content), leave the default Installation options selected and click Continue.
   - or –
   - Select (or deselect) a custom configuration of Installation options (see “Installation Options” on page 15) and click Continue.

6 Click Next.

7 Click Install.

8 When prompted, connect the FireWire cable to your 003 family interface.

9 Do one of the following, depending on your system configuration:
   - If your computer has multiple FireWire ports, plug the other end of the FireWire cable into an available FireWire port on your computer.
   - or –
   - If your computer has only one FireWire port and you are using it for an external hard drive, plug the other end of the FireWire cable into an available FireWire port on the FireWire hard drive that is connected to your computer.

A Connecting your 003 family interface to your computer through a FireWire hard drive does may not provide the maximum track count. To achieve the maximum track count, install a qualified PCI/PCMCIA/ExpressCard to increase the number of FireWire ports on your computer.

For information on supported PCI/PCMCIA/ExpressCard FireWire options, visit the Avid website (www.avid.com).

If you are using a Windows laptop that has a 4-pin FireWire port (commonly labeled “1394”), see “Additional Software on the Pro Tools Installer Disc” on page 17 for FireWire cable information.

10 Plug your 003 family interface into a standard AC outlet using the AC power cable included with the unit.

11 Power up your 003 family interface. AC power is required to operate your device.
12 Click OK.

⚠️ In Windows 7 and Windows Vista, a series of Windows Security dialogs may appear. Click “Install” on each one until they go away.

⚠️ In Windows XP, a series of Software Installation dialogs about the driver not passing Windows Logo testing may appear. Click Continue Anyway on each until they go away. If any other dialogs appear (such as the “Found New Hardware” dialog), leave them open and do not click on them. These dialogs will close on their own.

13 Wait for the installer to finish installing all software components, drivers, and PACE System files before proceeding to the next step.

14 When installation is complete, click Finish and restart your computer.

Installation Options

Pro Tools LE Options

To install a subset of Pro Tools software and plug-ins (and associated content), click the plus (+) next to Pro Tools LE 8.0 option in the Select Features page of the installer, and deselect any of the following options that you do not want installed.

Application Files (Required for Pro Tools) Installs the Pro Tools application and supporting library files needed to run Pro Tools. This option must be selected to install Pro Tools.

DigiRack Plug-Ins Installs free plug-ins including DigiRack plug-ins, free Bomb Factory plug-ins, Eleven Free, TL Utilities, and D-Fi and Maxim plug-ins. For more information, see the Audio Plug-Ins Guide.

Pro Tools Creative Collection

Select any of the Pro Tools Creative Collection options you want installed. For more information, see the Audio Plug-Ins Guide.

Effects Plug-Ins Installs 20 free effects plug-ins from Avid’s AIR group.

Virtual Instruments Installs six free virtual instrument plug-ins from Avid’s AIR Group.

Virtual Instrument Content Installs sample content for AIR virtual instruments.

⚠️ Virtual Instrument content is very large and may take up to 20 minutes to install. During this time, the progress bar may not appear to move but your software is still installing. Do not terminate your installation.

Additional Options

The Pro Tools installer provides the following additional options to install along with Pro Tools software and plug-ins.

Mac HFS+ Disk Support Option This option lets your Pro Tools system read, write, record, and play back using Mac-formatted HFS+ disks. HFS+ disks are commonly referred to as Mac OS Extended (Journaled) disks.

⚠️ For information on using the Mac HFS+ Disk Support option, see the HFS+ Disk Support Option Guide.

Avid Video Engine This option lets you integrate Avid® video peripherals such as the Avid Mojo® with your Pro Tools system. Do not install unless you will be using one of these products.

Command|8 Controller and Driver This option installs the personality file and device driver for the Avid Command|8® control surface. Do not install unless you will be using Command|8.
Installing QuickTime

QuickTime is required for Pro Tools if you plan to include movie files, or import MP3 or MP4 (AAC) files in your sessions. QuickTime for Windows is available as a free download from the Apple website (www.apple.com).

⚠️ For information on which version of QuickTime is compatible with your version of Pro Tools, visit the compatibility pages of the Avid website (www.avid.com).

To install QuickTime:

2. Download the QuickTime installer application to your computer.
3. Double-click the QuickTime installer application and follow the on-screen installation instructions.
4. Restart your computer.

Launching Pro Tools LE

When launching Pro Tools the first time, you are prompted to enter an authorization code to validate your software. (The code begins with the letters DIGI.)

To authorize Pro Tools software:

1. Make sure your 003 family interface is connected to your computer and powered on.
2. Double-click the Pro Tools LE shortcut on your desktop (or the application icon in the Pro Tools folder inside the Digidesign folder).
3. Enter the authorization code in the dialog (making sure to type it exactly as printed, observing any spaces and capitalization), then click Validate. (Your authorization code is located on the back of your Pro Tools DVD wallet.)
4 Use the Quick Start dialog to do one of the following:

- Create a new session from a template.
- Create a new blank session.
- Open any other session on your system.

#### Additional Software on the Pro Tools Installer Disc

The Pro Tools Installer disc provides additional software for your system, including a Pro Tools demo session.

💡 Refer to your Pro Tools Installer disc for additional software and installers.

#### Third-Party Applications and Plug-Ins

Your Pro Tools package also includes several free applications and plug-ins from selected Third Party developers. Once you’ve completed your Pro Tools installation, you can install these separately. Go to the Additional Files\3rd Party Content folder on the Pro Tools LE Installer disc.

#### 003 Factory Bundle Plug-Ins

If you purchased a Factory version of your 003 family system, the installers for your Factory Bundle are located on your Pro Tools Installer disc in the \Additional Files\Factory Bundle Installers folder.

#### Avid Audio Drivers

The Avid Audio Drivers are multi-client, multi-channel sound drivers that allow Pro Tools and third-party audio programs that support the ASIO Driver or WaveDriver MME/DirectX (Multimedia Extension) standards to record and playback through qualified Pro Tools audio interfaces.

💡 For additional information on the Avid Audio Drivers, see the Windows Audio Drivers Guide.
Pro Tools Demo Session

The Pro Tools LE Installer disc includes a demo session that you can use to verify that your system is working. The demo session for Pro Tool LE is named “Filtered Dream.”

⚠️ Before installing the demo session to your audio drive, make sure the drive is configured as described in “Formatting an Audio Drive” on page 160.

To install the demo session:

1. Insert the Pro Tools LE Installer disc into your DVD drive.
2. On the Pro Tools LE Installer disc, locate and open the Additional Files\Pro Tools Demo Sessions Installer folder.
3. Double-click LE Demo Session Setup.exe.
4. Follow the on-screen instructions.
5. When prompted, select your audio drive as the install location and click Next to begin the installation.
6. When installation is complete, click Finish.

♀️ The demo session can be opened by double-clicking the Filtered Dream.ptf file (located in the Filtered Dream Demo Session folder).

Connecting FireWire Drives

Connect FireWire hard drives directly to an available FireWire port on your computer.

⚠️ Do not connect a FireWire hard drive to the second FireWire port on the back panel of your 003 family interface.

The FireWire ports on 003 family interfaces do not pass data when they are powered off. If you daisy-chain FireWire devices from your computer, it is best to connect FireWire hard drives directly to your computer and not to the 003 family interface. This will prevent hard drive errors and data loss in case your 003 family interface is powered off.

To connect a FireWire hard drive, do one of the following:

- If your computer has more than one FireWire port, connect the FireWire hard drive to one FireWire port on your computer, and connect your 003 family interface to another FireWire port on the computer.

  – or –

- If your computer has only one FireWire port, connect the FireWire hard drive directly to your computer and then connect your 003 family interface to an available FireWire port on the drive.

⚠️ Connecting your 003 family interface to your computer through a FireWire hard drive does not support maximum track count. To achieve the maximum track count, purchase a PCI/PCMCIA/ExpressCard to increase the number of FireWire ports on your computer.

For information on supported PCI/PCMCIA/ExpressCard FireWire options, visit the Avid website (www.avid.com).
Connecting Other FireWire Devices to 003 Family Interfaces

The second FireWire port on your 003 family interface is available for daisy-chaining FireWire devices such as digital cameras or digital video recorders. Even when it is powered off, 003 and 003 Rack supply power from the computer through its FireWire ports, letting you recharge batteries in connected FireWire devices.

Connecting to Laptops with 4-Pin FireWire Cable

003 family interfaces include a 6-pin to 6-pin FireWire cable. Some Windows laptops include only a 4-pin FireWire port (commonly labeled “1394”). To use your 003 family with these computers, a 4-pin to 6-pin cable is required. Purchase this cable (part number #9940-30779-00) through your authorized Avid dealer or online at www.avid.com.

⚠️ This cable can also be purchased at computer supply stores. Maximum supported cable length for FireWire (IEEE-1394) is 14 feet (4.3 meters).

Uninstalling Pro Tools

If you need to remove Pro Tools software from your computer, use the Uninstaller application.

To uninstall Pro Tools from your computer:

1. Start Windows, logging in with Administrator privileges. For details on Administrator privileges, refer to your Windows documentation.

2. Go to Program Files\Digidesign\Pro Tools\Pro Tools Utilities and double-click Uninstall Pro Tools.exe.

3. Click Next.

4. Click Uninstall to proceed with the uninstall.
chapter 4

Configuring Your Pro Tools System

After you have connected your system and installed Pro Tools software, you are ready to start up and configure your Pro Tools system.

Starting Up or Shutting Down Your System

To ensure that the components of your Pro Tools system communicate properly with each other, you need to start them in a particular order.

Start up your Pro Tools system in this order:

1. Lower the volume of all output devices in your system.
2. Turn on any external hard drives. Wait approximately ten seconds for them to spin up to speed.
3. Turn on any control surfaces (such as Command|8).
4. Turn on any MIDI interfaces, MIDI devices, or synchronization peripherals.
5. Turn on the 003 family interface.
6. Turn on your computer.
7. Launch Pro Tools or any third-party audio or MIDI applications.

Shut down your Pro Tools system in this order:

1. Quit Pro Tools and any other running applications.

   To quit Pro Tools, choose Pro Tools > Quit (Mac) or File > Exit (Windows).

2. Turn off or lower the volume of all output devices in your system.
3. Turn off your computer.
4. Turn off the 003 family interface.
5. Turn off any MIDI interfaces, MIDI devices, or synchronization peripherals.
6. Turn off any control surfaces.
7. Turn off any external hard drives.
Configuring Pro Tools LE Software

Pro Tools System Settings

In the Playback Engine dialog, Pro Tools lets you adjust the performance of your system by changing system settings that affect its capacity for processing, playback, and recording.

In most cases, the default settings for your system provide optimum performance, but you may want to adjust them to accommodate large or processing-intensive Pro Tools sessions.

Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) controls the size of the buffer used to handle host processing tasks such as RTAS plug-ins.

- Lower Hardware Buffer Size settings are useful for improving latency issues in certain recording situations or for improving certain system performance problems. On Pro Tools LE systems, lower settings reduce all input-to-output monitoring latency on any record-armed tracks or Auxiliary Input tracks with live inputs.
- Higher Hardware Buffer Size settings are useful for sessions that are using more RTAS plug-ins for playback. These settings allow for more audio processing. They can also be useful to reduce errors on machines that require a higher buffer size.

⚠️ In addition to causing slower screen response and monitoring latency, higher Hardware Buffer Size settings can increase the latency caused by RTAS plug-ins, and affect the accuracy of plug-in automation, mute data, and MIDI track timing.

To change the Hardware Buffer Size:

2. From the H/W Buffer Size pop-up menu, select the audio buffer size, in samples.
3. Click OK.
Host Processors

The Host Processors setting lets you manage multi-processor support for RTAS (Real-Time AudioSuite) plug-in processing.

Used in combination with the CPU Usage Limit setting, the Host Processors setting lets you control the way RTAS and other host-based processing tasks are carried out by the system.

For example:

- For sessions with large numbers of RTAS plug-ins, you can allocate 2 or more processors to Host Processing and set a high CPU Usage Limit.

- For sessions with few RTAS plug-ins, you can allocate fewer processors to host processing and set a low CPU Usage Limit to leave more CPU resources available for automation accuracy, screen response, and video.

- Depending on the importance of video and overall screen response, and on the density of automation being employed, try different combinations of Host Processors and CPU Usage Limit settings to achieve the best results. For example, to improve screen response in a medium-sized session using a moderate number of RTAS plug-ins, try reducing the number of RTAS plug-ins, but keep the CPU Usage Limit set to the maximum (up to 99% on a single processor system).

To set the number of Host Processors:


2. From the Host Processors pop-up menu, select the number of available processors you want to allocate. The number of processors varies depending on your computer:
   - Select 1 Processor to limit processing to one CPU in the system.
   - Choose 2 Processors to enable load balancing across two available processors.
   - On systems running four or more processors, choose the number of processors for processing.

3. Click OK.

System Usage Window and Processing

The System Usage window (Window > System Usage) displays the combined amount of processing occurring on all enabled processors with a single indicator, regardless of how many processors are available in the system. If the System Usage Window shows that you are at the limit of available resources, increase the number of processors and adjust the CPU Usage Limit setting.
CPU Usage Limit

The CPU Usage Limit setting controls the percentage of CPU resources allocated to Pro Tools host processing tasks. Used in combination with the Host Processors setting, the CPU Usage Limit setting lets you control the way Pro Tools tasks are carried out by the system.

- Lower CPU Usage Limit settings limit the effect of Pro Tools processing on other CPU-intensive tasks, such as screen redraws, and are useful when you are experiencing slow system response, or when running other applications at the same time as Pro Tools.
- Higher CPU Usage Limit settings allocate more processing power to Pro Tools, and are useful for playing back large sessions or using more RTAS plug-ins.

The maximum available CPU Usage Limit depends on the number of processors in your computer and on the number of processors you specify for host processing. This value can range from 85% for single-processor computers, and 99% for multiprocessor computers (which dedicate one entire processor to Pro Tools).

On multiprocessor computers, the maximum CPU Usage Limit is reduced when you use all your processors (as selected in the Host Processors pop-up menu). For example, on dual-processors, the limit is 90%, on four-processor computers, the limit is 95%.

⚠️ Increasing the CPU Usage Limit may slow down screen responses on slower computers.

To change the CPU Usage Limit:
2. From the CPU Usage Limit pop-up menu, select the percentage of CPU processing you want to allocate to Pro Tools.
3. Click OK.

Host Engine (Error Suppression)

The Host Engine option determines error reporting during playback and recording. This is especially useful when working with instrument plug-ins.

You should only enable error suppression if you are experiencing frequent RTAS errors that are interrupting your creative workflow. When error suppression is enabled, you can experience a degradation of audio quality. However, this may be acceptable in order to avoid interrupting playback and recording when working with instrument plug-ins. Be sure to disable error suppression when you need to ensure the highest possible audio quality, such as for a final mix.

To enable error suppression:
2. Select Host Engine: Ignore Errors During Playback/Record.
3. You can also select Minimize Additional I/O Latency.
4. Click OK.

Error Suppression Options

Ignore Errors During Playback/Record

When enabled, Pro Tools continues to play and record even if the RTAS processing requirements exceed the selected CPU Usage Limit. This can result in pops and clicks in the audio, but does not stop the transport.
**Minimize Additional I/O Latency**

When enabled, any additional latency due to suppressing errors during playback and record is minimized to 128 samples. Suppressing errors requires at least 128 samples of additional buffering on some systems. If this option is disabled, the buffer is half the H/W Buffer Size, or at least 128 samples (whichever is greater). If you are using an older, slower computer, you may want to disable this option to avoid adverse performance.

This option is only available if the Ignore Errors During Playback/Record option is enabled.

**DAE Playback Buffer Size**

The DAE Playback Buffer Size setting determines the amount of memory DAE allocates for disk buffers. In addition to levels, the DAE Playback Buffer Size shows values in milliseconds, which indicate the amount of audio buffered when the system reads from disk.

The optimum DAE Playback Buffer Size for most disk operations is 1500 msec; Level 2 (Default).

- DAE Playback Buffer Size settings lower than 1500 msec; Level 2 (Default) may improve playback and recording initiation speed, as well as preview in context in DigiBase browsers. However, a lower setting may make it difficult to play or record tracks reliably with sessions containing a large number of tracks or a high density of edits, or with systems that have slower or heavily-fragmented hard drives.

- DAE Playback Buffer Size settings higher than 1500 msec; Level 2 (Default) allow higher track count, higher density of edits in a session, or the use of slower hard drives. However, a higher setting may increase the time lag when starting playback or recording, starting preview in context from DigiBase browsers, or cause a longer audible time lag while editing during playback.

_Tip:_ Using a larger DAE Playback Buffer Size leaves less system memory for other tasks. The default setting of 1500 msec (Level 2) is recommended unless you are encountering –9073 (“Disk too slow or fragmented”) errors.

**To change the DAE Playback Buffer Size:**


2. From the DAE Playback Buffer pop-up menu, select a buffer size. Memory requirements for each setting are shown at the bottom of the Playback Engine dialog.

3. Click OK.

If Pro Tools needs more system memory for the DAE Playback Buffer, it will prompt you to restart your computer.
**Cache Size**

The Cache Size setting determines the amount of memory DAE allocates to pre-buffer audio for playback and looping when using Elastic Audio.

**Minimum** Reduces the amount of system memory used for disk operations and frees up memory for other system tasks. However, performance when using Elastic Audio features may decrease.

**Normal** Is the optimum Cache Size for most sessions.

**Large** Improves performance when using Elastic Audio features, but it also decreases the amount of memory available for other system tasks, such as RTAS processing.

💡 *Using a larger Cache Size leaves less system memory for other tasks. The default setting of Normal is recommended unless you are encountering -9500 (“Cache too small”) errors.*

**To change the Cache Size:**

2. From the Cache Size pop-up menu, select a disk cache size.
3. Click OK.

---

**Plug-In Streaming Buffer Size (Structure Plug-In Only)**

This setting appears in the Playback Engine dialog only if Structure, Structure LE, or Structure Free is installed on your system. The Plug-In Streaming Buffer Size determines the amount of memory DAE allocates for streaming playback from disk with the Structure plug-in. This setting only affects playback if disk streaming is activated in Structure’s plug-in controls (see the *Air Virtual Instruments Guide* for more information).

The optimum Plug-In Streaming Buffer Size for most sessions is 250 ms (Level 2).

- Plug-In Streaming Buffer Size settings lower than 250 msec (Level 2) reduce the amount of system memory used for sample playback and frees up memory for other system tasks. However, audio quality of sample playback may decrease.
- Plug-In Streaming Buffer Size settings higher than 250 msec (Level 2) improve the audio quality of sample playback, but they also decrease the amount of memory available for other system tasks, such as RTAS processing.

💡 *Using a larger Plug-In Streaming Buffer Size leaves less system memory for other tasks. The default setting of 250 ms (Level 2) is recommended unless you are experiencing problems with the audio quality of sample playback.*

**To change the Plug-In Streaming Buffer Size:**

2. From the Plug-In Streaming Buffer Size pop-up menu, select a buffer size.
3. Click OK.
Optimizing the Plug-In Streaming Buffer Size

(Structure Plug-In Only)

This option appears in the Playback Engine dialog only if one of the Structure sampler instrument plug-in is installed on your system. This option is useful when you are playing samples from the same drive that contains audio for the current session. When this option is selected, Pro Tools automatically optimizes the size of the Plug-In Streaming Buffer to facilitate disk access from both Pro Tools and Structure. The Plug-In Streaming Buffer Size pop-up menu is unavailable when this option is selected.

To set Pro Tools to optimize the Plug-In Streaming Buffer Size:

2. Select the Optimize for Streaming Content option.
3. Click OK.

Configuring the Pro Tools Hardware Settings

In the Hardware Setup dialog, Pro Tools lets you set the default sample rate and clock source for your system, and configure the digital inputs on the 003 family interface.

Default Sample Rate

The Sample Rate setting appears as the default sample rate when you create a new session. (This setting is available in the Hardware Setup dialog only when no session is open.)

💡 You can change the sample rate when creating a new Pro Tools session by selecting a different sample rate in the New Session dialog. See the Pro Tools Reference Guide for details.

To change the default Sample Rate:

1. Choose Setup > Hardware.

Hardware Setup dialog

2. Select the sample rate from the Sample Rate pop-up menu.
3. Click OK.
**Clock Source**

The Pro Tools Hardware Setup dialog lets you select the Clock Source for the system.

**Internal** If you are recording an analog signal directly into Pro Tools, you will usually use the Internal setting.

**External** If you are transferring material into Pro Tools from an external digital device, or if you utilize a common house clock signal, you will synchronize Pro Tools to the digital device or common signal. The external clock source corresponds to the connector on the back of the 003 family interface that is receiving your clock signal: S/PDIF (RCA), Optical, or Word Clock. If you are using an optical device, you also need to set the Optical Format (ADAT or S/PDIF).

⚠️ You can use only one pair of S/PDIF inputs (either RCA or Optical) at a time. At 96 kHz, it is recommended that you use the S/PDIF (RCA) port.

*Note that S/PDIF (RCA) output is still available when S/PDIF Optical is selected.*

**To select the Clock Source:**

1. Choose Setup > Hardware.

2. Choose the clock source from the Clock Source pop-up menu.

3. Click OK.

⚠️ Your digital input device must be connected and turned on for Pro Tools to synchronize to it. If your input device is not turned on, leave the Clock Source set to Internal.

⚠️ Only one S/PDIF input pair can be used at a time. When you select S/PDIF (RCA) as the Clock Source, the Optical Format setting will switch to ADAT (for sample rates 44.1 kHz and 48 kHz), or to None (for sample rates 88.2 kHz and 96 kHz).

Conversely, when you select S/PDIF as the Optical Format, the Clock Source setting will switch to Internal if it was previously set to S/PDIF (RCA).
Optical Format

The Optical port can be set for eight channels of ADAT Optical I/O (supporting up to 48 kHz) or two channels of S/PDIF Optical I/O. The Optical Format ADAT option is replaced by None for session rates 88.2 kHz and 96 kHz.

If you are using an optical device for recording, you need to set the Optical Format.

To select the digital format of the Optical I/O port:

1. Choose Setup > Hardware.
2. In the Optical Format section, do one of the following:
   - Select ADAT if your optical device is using the ADAT format.
   - or –
   - Select S/PDIF if your optical source device is using the S/PDIF format.
3. Click OK.

Configuring I/O Setup

Using the I/O Setup dialog, you can label Pro Tools LE input, output, insert, and bus signal paths. The I/O Setup dialog provides a graphical representation of the inputs, outputs, and signal routing of the 003 family interface.

Pro Tools LE has default I/O Setup settings that will get you started. Use the I/O Setup dialog only if you want to rename the default I/O paths.

To rename I/O paths in I/O Setup:

1. Choose Setup > I/O.
2. Click the Input, Output, Insert, or Bus tab to display the corresponding paths.
3 To change the name of a path or subpath, double-click directly on the Path Name, type a new name for the path, and press Return (Mac) or Enter (Windows).

4 Click OK.

See the Pro Tools Reference Guide (or choose Help > Pro Tools Reference Guide) for more information on renaming I/O paths.

Configuring MIDI Setup

If you plan to use any MIDI devices with Pro Tools, do one of the following:

- On Mac, configure your MIDI setup with Audio MIDI Setup. See Appendix B, “Configuring AMS (Mac OS X Only)” for details.
  
  – or –


Backing Up Your System Configuration

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Norton Ghost (Windows) or Bombich Carbon Copy Cloner (Mac). By doing this, you can quickly restore your system configuration and settings if you encounter any problems.

Optimizing a Mac System for Pro Tools

To ensure optimum performance with Pro Tools LE, configure your computer before using Pro Tools hardware and software.

Before configuring your computer, make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges in Mac OS X, refer to your Apple OS X documentation.

Do not use the Mac OS X automatic Software Update feature, as it may upgrade your system to a version of Mac OS that has not yet been qualified for Pro Tools. For details on qualified versions of Mac OS, visit www.avid.com/compatibility.

Turning Off Software Update

To turn off the Software Update feature:

1. Choose System Preferences from the Apple menu and click Software Update.

2. Click the Software Update tab.

3. Deselect Check for Updates.

Turning Off Energy Saver

To turn off the Energy Saver feature:

1. Choose System Preferences from the Apple menu and click Energy Saver.

2. Click the Sleep tab and do the following:
   - Set the computer sleep setting to Never.
   - Set the display sleep setting to Never.
   - Deselect the Put the hard disk(s) to sleep when possible option.
Disable or Reassign Mac Keyboard Shortcuts Used by Pro Tools

To have the full complement of Pro Tools keyboard shortcuts, you need to disable or reassign any conflicting Mac OS X Keyboard Shortcuts in the Apple System Preferences, including the following:

- “Show Help menu”
- Under “Keyboard Navigation”
  - “Move focus to the window drawer”
- Under “Dock, Exposé, and Dashboard”
  - “Automatically hide and show the Dock”
  - “All windows”
  - “Application windows”
  - “Desktop”
  - “Dashboard”
  - “Spaces”
- Under “Spotlight”
  - “Show Spotlight search field”
  - “Show Spotlight window”

For a complete list of Pro Tools keyboard shortcuts, see the Keyboard Shortcuts Guide (Help > Keyboard Shortcuts).

To disable or reassign Mac OS X keyboard shortcuts:

1. Choose System Preferences from the Apple menu and click Keyboard & Mouse.
2. Click the Keyboard Shortcuts tab.
3. Do one of the following:
   - Deselect the Mac OS X options that conflict with Pro Tools keyboard shortcuts.
   - or -
   - Assign different, non-conflicting keyboard shortcuts to the corresponding Mac OS X options.

Reassign Spaces Keyboard Shortcuts

If you want to use Spaces, you should reassign the Spaces keyboard shortcuts to avoid conflicts with important Pro Tools keyboard shortcuts. You can reassign Spaces keyboard shortcuts to use a combination of modifier keys (Command+Option+Control+Shift) in addition to the default Spaces keyboard shortcut assignments to avoid these conflicts.

To reassign Spaces keyboard shortcuts to use modifier key combinations that do not conflict with Pro Tools keyboard shortcuts:

1. Choose System Preferences from the Apple menu and click Exposé & Spaces.
2. Click the Spaces tab.
3. Ensure that Enable Spaces is selected.
4. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+F8” from the “To activate Spaces” pop-up menu.
5. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+Arrow Keys” from the “To switch between spaces” pop-up menu.
6. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+Number Keys” from the “To switch directly to a space” pop-up menu.
Disabling Spotlight Indexing

The Mac OS X Spotlight feature automatically indexes files and folders on local hard drives in the background. In most cases, this is not a concern for normal Pro Tools operation. However, if Spotlight starts indexing drives while recording in a Pro Tools session with high track counts for an extended period of time, it can adversely affect Pro Tools system performance. You may want to disable Spotlight indexing for all local drives before using Pro Tools for big recording projects.

⚠️ Disabling Spotlight indexing also disables the Find function in Mac OS X.

To disable Spotlight indexing:

1. Choose System Preferences from the Apple menu and click Spotlight.
2. In the Spotlight window, click the Privacy tab.
3. To prevent indexing of a drive, drag its icon from the desktop into the list.

Enabling Journaling for Audio Drives

To yield higher performance from audio drives, enable journaling.

To enable journaling:

1. Launch the Disk Utility application, located in Macintosh HD/Applications/Utilities.
2. Select the volume in the left column of the Disk Utility window.
3. Click Enable Journaling in the toolbar.

Optimizing a Windows System for Pro Tools

To ensure optimum performance with Pro Tools LE, configure your computer before using Pro Tools hardware and software.

⚠️ For Mac System Optimization, see “Optimizing a Mac System for Pro Tools” on page 30.

Before configuring your computer, make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges, see your Windows documentation.

Required Optimizations

To ensure optimum performance with Pro Tools, configure the following settings before using Pro Tools hardware and software.

⚠️ When you are finished changing Windows system settings, restart your computer.

Enabling DMA

Enabling your computer's DMA (Direct Memory Access) frees up CPU bandwidth so your computer can do other Pro Tools tasks.

In most cases the DMA option will already be set correctly, as Windows detects and activates DMA mode by default.
To enable DMA for any IDE hard drives:

1. Choose Start.
2. Right-click Computer (Windows 7, Windows Vista) or My Computer (Windows XP) and choose Manage.
3. In the left pane of Computer Management under System Tools, click on Device Manager.
4. In the right pane, click the triangle (Windows 7) or the plus (+) sign (Windows XP and Windows Vista) next to IDE ATA/ATAPI Controllers.
5. Double-click on an IDE Channel.
6. Click the Advanced Settings tab.
7. Under Device Properties, check the box Enable DMA (Windows 7, Windows Vista) or under each listed Device, set the Transfer Mode to DMA if available (Windows XP).
8. Click OK.
9. Repeat for each IDE Channel.

Configuring Windows Power Management Settings

Pro Tools requires maximum CPU performance for optimal RTAS processing and disk streaming. For best performance, use the following recommended Windows Power Management settings.

To configure Windows Power Management Settings (Windows 7, Windows Vista):

1. Choose Start > Control Panel.
2. Click Hardware and Sound > Power Options.
3. In the Power Options control panel, click High Performance.
4. Click Change plan settings.
5. Click Change advanced power settings to change additional settings.
6. Click Hard disk > Turn off hard disk after = Never. You can make optional changes such as disabling sleep and disabling shutting down the monitor.
7. Click OK or click Save changes to save the changes.
8. Close the window.

To configure Windows Power Management Settings (Windows XP):

1. Choose Start > Control Panel.
2. Double-click Power Options.
3. Click the Power Schemes tab.
4. From the Power Schemes pop-up menu, select Always On.
5. Verify that the following settings are set to Never:
   - Turn off hard disks
   - System standby
   - System hibernates
6. Click OK.
Disabling User Account Control
(Windows 7, Windows Vista)

Some third-party applications that interface with Pro Tools may require UAC to be disabled for proper operation.

To disable User Account Control (UAC):

1 Choose Start > Control Panel.
2 Click User Accounts and Family Safety.
3 In the User Accounts and Family Safety control panel, click User Accounts.
4 Click Change User Account Control settings (Windows 7) or Turn User Account Control on or off (Windows Vista).
5 Move the User Account Control slider to Never Notify (Windows 7), or deselect the Use User Account Control (UAC) to help protect your computer option (Windows Vista).
6 Click OK.
7 Restart your computer.

Recommended Optimizations

Pro Tools can also be affected by other software and hardware drivers installed on your computer. For best possible performance, it is recommended (but not required) that you do the following:

• Avoid running any unneeded programs at the same time as Pro Tools.
• Turn off any software utilities that run in the background, such as Windows Messenger, calendars, and disk maintenance programs.
• Turn off any non-essential USB devices while running Pro Tools.
• If your video display card supports it, enable Bus Mastering in the manufacturer's Control Panel. See the manufacturer’s instructions for details.

Optional Optimizations

The following system optimizations may help Pro Tools perform better on some systems. It is recommended that you only try these optimizations if necessary, as they may disable or adversely affect the functionality of other programs on your system.

Disabling Network Cards

If applicable, disable any networking cards (other than a FireWire card that you might use to connect an external drive to your system).

To disable a network card (Windows 7, Windows Vista):

1 Choose Start > Computer.
2 Click System Properties.
3 In the left-hand pane under Control Panel Home, click on Device Manager.
4 In the Device Manager window, double-click Network adapters.
5 Right-click on the network adapter and select Disable.
6 Repeat as necessary for additional network adapters.
7 Close the Device Manager window.
To disable a network card (Windows XP):

1. Right-click My Computer (Windows XP) and choose Manage.
2. Under System Tools, select Device Manager.
3. In the right-hand pane, click “+” to reveal Network adapters.
4. In the Device Manager window, double-click Network adapters, then double-click the Network Adapter card you want to disable.
5. Under the General tab, choose Do not use this device (disable) from the Device Usage pop-up menu, then click OK.

Adjusting Processor Scheduling

To adjust Processor Scheduling performance:

1. Right-click Computer (Windows 7, Windows Vista) or My Computer (Windows XP) and choose Properties.
2. Click the Advanced system settings link in the left pane (Windows 7, Windows Vista) or the Advanced tab (Windows XP).
3. Under the Performance section, click the Settings button.
4. In the Performance Options window, click the Advanced tab.
5. Under the Processor Scheduling section, select the Background Services option.
6. Click OK to close the Performance Options window.
7. Click OK to close the System Properties window.
8. Restart the computer for the changes to take effect.

Disabling System Startup Items

The fewer items in use by your computer, the more resources are available for Pro Tools. Some startup applications may be consuming unnecessary CPU resources, and can be turned off.

If you disable any of the following startup items, do so carefully:

- Portable media serial number (required for some applications that utilize a copy protection key)
- The Plug and Play service
- Event log
- Cryptographic services

To Disable System Startup Items:

1. From the Start menu, type “msconfig” in Start Search (Windows 7 and Windows Vista) or in Run (Windows XP) and click OK to open the System Configuration Utility.
2. Under the General tab, choose Selective Startup.
3. Deselect Load Startup Items and click OK.
4. Click Restart to restart the computer.
5. After restarting, the computer displays a System Configuration message. Check to see if Pro Tools performance has increased before you deselect the Don't show this message again option. If performance has not changed, run “msconfig” and return your computer Startup Selection back to Normal Startup - load all device drives and services. Alternatively, try disabling Startup items and non-essential processes individually.
003 Operating Modes

003 can be in any of five states when it is on:
- Standby mode
- Pro Tools mode
- MIDI mode
- Third-Party Software mode
- Utility mode

Standby Mode

003 is in this mode when you first power on the unit, waiting for you to launch Pro Tools (or another supported application).

In Standby mode, the unit displays “003 Offline” in the top row of the 003 display and the Monitor Mute switch is enabled (lit).

In Standby mode, the Monitor section I/O ports are available, without having to power on the computer.

While in Standby mode, you can also switch to MIDI mode to control external MIDI devices (without having to power on the computer). However, you cannot use 003 as a standalone MIDI router; you must route MIDI through software.

Pro Tools Mode

003 is in this mode when the 003 unit is connected to a computer and Pro Tools LE software is running.

If Pro Tools is running and no session is open, the unit normally displays “Open or create a new session.” When a session is being launched, the display changes to “Loading a session.”

💡 If no session is open and a Workspace browser is open and being used to audition an audio file, the unit displays “Working.”

When a Pro Tools session is open, the unit mirrors the on-screen controls. 003 faders, transport switches, rotary knobs, and switches control the corresponding elements in Pro Tools. You can also use 003 MIDI ports as you would those on a standard MIDI interface.

In Pro Tools mode, the Monitor section and MIDI I/O ports are available with a session open or closed.

To put 003 in Pro Tools mode:

1. Make sure the 003 unit is properly connected to the computer and powered on.
2. If Mute is disabled (unlit), enable Mute by pressing the Monitor Mute switch so that it is lit.
3. Launch Pro Tools LE and open or create a Pro Tools session.
MIDI Mode

003 is in this mode when either the MIDI Map A or B switch is enabled (lit). In this mode, 003 functions as a MIDI control surface for external devices and applications other than Pro Tools. MIDI mode can be enabled in Pro Tools mode, Third-Party Software mode, or Standby Mode. For more information, see Chapter 12, “Using MIDI Mode with 003.”

Third-Party Software Mode

003 is in this mode when the 003 unit is connected to a computer and you launch a third-party audio application (such as iTunes or Ableton Live), and then use 003 as your playback or recording device. You can also use 003 MIDI ports as you would those on a standard MIDI interface.

In this mode, the unit displays “Working” in the top row of the LCD.

On Windows, ASIO- and WaveDriver-compatible applications are supported. WaveDriver supports playback only. On Mac, CoreAudio Driver applications are supported.

For more information on third-party audio drivers, see the Windows Audio Drivers Guide (for ASIO or WaveDriver on Windows) or the CoreAudio Drivers Guide (Mac).

To use a third-party software application with 003:

1. Make sure 003 is properly connected to the computer and in Standby mode.
2. Configure your system and software for ASIO, WaveDriver, or CoreAudio Driver.
3. If Mute is disabled (unlit), press the Monitor Mute switch.
4. Launch your third-party audio application.
5. Disable the Monitor Mute switch (unlit).
6. Use monitor section controls and switches to adjust audio input routing, monitor levels, and headphone levels.

Playing Audio Audio from your third-party software application can be routed to 003’s outputs, via the FireWire connection.

Recording Audio (ASIO Driver and CoreAudio Driver Only) Audio from 003 inputs can be routed to software inputs in your third-party software applications, through the FireWire connection.

Refer to the documentation for your third-party software for information on configuring inputs and outputs.

Utility Mode

003 is in this mode when the Utility switch is enabled (flashing). In Utility mode, you can run pre-programmed diagnostic tests of the 003 unit (such as fader movement and LEDs). The Utility switch is unavailable in Pro Tools mode.

See Appendix A, “Utility Mode (003 Only)” for more information.
003 Top Panel Overview

Figure 1 identifies each of the main 003 control sections.

The 003 top panel is arranged in sections of controls with related functions. The Fader section includes standard channel strip controls, similar to any small-format mixer. The Console/Channel View section provides powerful multi-state controls for viewing and controlling inserts, plug-ins and sends in Pro Tools. The Transport and Navigation controls provide access to many of the on-screen navigation features of Pro Tools.

Figure 1. Major sections of the 003 top panel
Display Section

The top portion of the 003 includes an LCD display, Display mode switch, and status indicators.

**LCD Display**

For all 003 operating modes, the LCD display provides status information.

*For information on the status information displayed for each 003 operating mode, see “003 Operating Modes” on page 37.*

In Pro Tools mode, when a session is open, 003’s LCD is a large, two-row display. The LCD display dedicates two rows, each with up to six characters, to each channel strip.

In most views, the top row of the LCD shows the current view or mode status on the left side and the session’s Main Counter on the right side.

The bottom row of the LCD shows track, send, and insert names, and pan position, send levels, and plug-in control information, depending on the current view, as selected by the Channel/Console switches.

The default display is the name of the displayed element. Names of items with more than six characters are abbreviated to six characters. Full names of items with more than 6 characters can be temporarily displayed in the LCD. See “Displaying Full Names of Tracks, Insert Parameters, and Other Elements” on page 100.

When you move a fader or rotary encoder, the LCD will temporarily display the value for that control in the lower row of the LCD, then return to the default display. Values can also be temporarily displayed without moving a control or set to display always. See “Displaying Settings Instead of Track or Control Names” on page 100.

**Additional LCD Naming Conventions in Pro Tools Mode**

When a send or insert is muted, its names is capitalized in the LCD display.

When a track, send, or insert is inactive, “@” appears before its name in the LCD display.
**Display Mode Switch**

This switch is used to change default LCD displays:

- Full names of items with more than 6 characters can be temporarily displayed in the LCD. See “Displaying Full Names of Tracks, Insert Parameters, and Other Elements” on page 100.

- The lower row of the LCD shows track or control names by default. The display can be changed to temporarily show settings by pressing and holding the Display Mode switch, or be reset to always show settings. See “Displaying Settings Instead of Track or Control Names” on page 100.

The Display Mode switch flashes during a temporary display or when the LCD default has been reset to always show settings.

**Host (“1394”) Status Indicator**

The Host status LED, marked “1394” below its LED, indicates that communication has been established between the unit and Pro Tools LE software (or another software application) through FireWire.

**Sync Indicators**

The Sync LEDs indicate the current clock source. When the current clock source is not established, the respective LED flashes.

If none of the Sync LEDs are lit, 003’s clock source is set to internal.

There are three Sync LEDs:

- **W Clk (Word Clock) LED** Lights when clocking to Word Clock.
- **S/PDIF LED** Lights when clocking to the S/PDIF on the RCA or Optical port.
- **ADAT LED** Lights when clocking to ADAT on the Optical port.

**MIDI Data Indicators**

The MIDI Data LEDs indicate the presence of MIDI data on the MIDI In, MIDI Out 1, or MIDI Out 2 ports. Individual LEDs are provided for each port. Active sensing is not indicated.
Fader Section

The Fader section consists of eight channel strips, each with identical controls.

Each fader has a motorized touch-sensitive fader, solo and mute switches, a multi-state Channel Select switch, a rotary encoder and its LED ring, and meter LEDs. The LCD display dedicates two rows, each with up to six characters, to each channel strip.

Channel Strip Controls

Channel Faders

Each channel has its own 100 mm, servo-driven, touch-sensitive, motorized fader for controlling levels of audio, Auxiliary Input, Master Fader, MIDI, and Instrument tracks.

Flip Mode

In Flip mode (Flip switch lit), rotary encoder controls are taken over by the faders, which makes the rotary encoders available to control another parameter. For example, in normal Send View (Send switch lit), rotary encoders control send level, while faders control output gain. In Flip mode, faders (instead of rotary encoders) control the send level parameters and rotary encoders control pan.

For more information, see “Using Flip Mode” on page 110.
**Muting Fader Movement**

Because 003 faders are motorized, they move to follow automation when playing back and recording (when the track is set to an automation read or write mode, and not Off). During critical listening passes, the sound of the fader motors and their automated movements may be distracting. You can temporarily shut off (or mute) motorized fader movement using the Fader Mute switch.

When the Fader Mute switch is enabled (flashing), faders park and do not respond to touching or movement. Previously recorded automation continues to affect playback, while the faders are disengaged from reading.

*For more information, see “Muting Fader Movement” on page 112.*

**Channel Solo/Mute Switches**

Each channel has Solo and Mute switches, located above its fader. These switches let you solo or mute the channel. The switches also show the Pro Tools solo and mute status for each track. When a track is soloed (Solo switch lit), the Mute switches on other tracks in the session flash. When a track is muted, its Mute switch is lit continuously.

The Solo switch function follows the Pro Tools Operation preference for latched operation. (See the Pro Tools Reference Guide for details.)

**Channel Select Switches**

Each channel has a Channel Select switch that performs several functions, depending on the view or mode, as follows.

**Console View** Depending on the Console View (Pan, Send, or Insert), 003 can be used to do the following:

- Select tracks or inserts on a particular channel for editing.
- Assign inputs, outputs, sends, or inserts (plug-ins or hardware).
- Open track or send Output windows.
- Make track or send Outputs active or inactive.
- Select pre- or post-fader operation for sends.
- Bypass plug-ins.
- Reset faders and other parameters to their default settings.

*For information on using Console View for specific Pro Tools workflows, see Chapter 11, “Pro Tools Mode with 003.”*

**Channel View** Depending on the Channel View (EQ, Dynamics, Insert, or Pan/Send), 003 can be used to do the following:

- Display inserts or plug-ins on a channel.
- Select and edit individual send or insert settings as displayed across the LCD.
- Toggle switched plug-in controls (such as bypass and Phase Invert).
- Cycle through plug-in windows.

*For information on using Channel View for specific Pro Tools workflows, see Chapter 11, “Pro Tools Mode with 003.”*
**Record Arming Mode** When the Rec Arm switch is enabled (flashing), the Channel Select switch for a track enables or disables its Record Enable button, *plus* acts as a record-enabled indicator. When a track is record-enabled, its Channel Select switch flashes when the Transport is stopped. When Pro Tools is recording, the switch is lit continuously.

Tracks that are armed for recording will remain armed after Rec Arming mode is disabled.

See “Rec Arm (Record Arm) Switch” on page 45 for details on record-enabling tracks.

**Automation Mode** The Automation Mode switches (Write, Touch, Latch, Read, and Off) let you use the Channel Select switches to set the track’s Automation mode.

See “Automation Section” on page 54 for more information.

**Memory Location Mode** In this mode (Memory Location switch lit), Channel Select switches recall the Memory Location that corresponds to their channel number. Additionally, the Memory Location window can be opened.

See “Working With Memory Locations” on page 110 for more information.

**Rotary Encoders**

Each Channel has a rotary encoder. These knobs control a variety of parameters, depending on the view:

**Console View** The rotary encoders control pan, send level, or insert settings, depending on which Console View is enabled (Pan, Send, or Insert).

**Channel View** The rotary encoders control plug-in, pan/send, or insert settings, depending on which Channel View is enabled (EQ, Dynamics, Insert, or Pan/Send).

**Rotary Encoder LEDs**

Each rotary encoder has a ring of 11 LEDs for indicating data values controlled by the encoder. The style of display depends on the type of data. For example, discrete or stepped information such as pan position or frequency value is shown by a single LED, while an expanding series of LEDs shows values such as send levels, gain, or filter bandwidth. When you rotate the encoder, its LEDs update.

In Pan View, the Meter switch sets what the LEDs display (left pan, right pan, or no function in Automation mode).

**Channel Meter LEDs**

Each channel includes a five-segment LED meter, scaled at 0, –3, –6, –12, and –42 dBFS for track level. The meters are also labeled to indicate the track’s current Automation mode: Wrt (Write), Tch (Touch), Lch (Latch), or Rd (Read).

When the Meter switch is set to Left or Right, these meters display track level. When the Meter switch is set to Auto (Automation), the meter indicator corresponding to the track’s current Automation mode is lit.
**Meter Switch and LEDs**

The Meter switch (located to the right of the encoder row) configures the display mode for Channel Meter LEDs and the rotary encoder LEDs.

The Meter switch also sets whether Left or Right pan is controlled by a channel’s rotary encoder.

When you toggle through the three Meter switch modes, the corresponding Meter switch LED lights when its mode is enabled, as follows:

**Left** When enabled (LED lit), the Channel Meter LEDs function as level meters, displaying mono signals or the left channel of a stereo signal. Rotary encoder LEDs indicate the left pan position (available on stereo channels or sends). Additionally, the rotary encoder can be used to adjust the left pan position on stereo channels or sends.

**Right** When enabled (LED lit), the Channel Meter LEDs function as level meters, displaying the right channel of a stereo signal. Rotary encoder LEDs indicate the right pan position (available on stereo channels or sends). Additionally, the rotary encoder can be used to adjust the right pan position on stereo channels or sends.

**Auto (Automation)** When enabled (LED lit), the Channel Meter LEDs display the Automation mode for their channel. When the Auto switch is enabled, the rotary encoders do not function.

---

**Global Fader Controls**

The following controls affect the assignment and operation of all the faders:

**Rec Arm (Record Arm) Switch**

When the Rec Arm switch is enabled (flashing), 003 is in Record Arming mode. In this mode, channels can be armed (record-enabled) or disarmed for recording by pressing their Channel Select switch.

> For information on how to record arm tracks with 003, see “Recording” on page 108.

In this mode, the top row of the LCD shows “Record Arm” and the lower row of the LCD shows track names. Additionally, volume fader updates will not be reflected in the LCD, panning cannot be adjusted with rotary encoders, and the Display mode cannot be changed.

In Record Arming mode, the Channel Select switches act as record-enable switches and indicators. When a channel is record-enabled and the transport is stopped (or playing back without recording), its Channel Select switch flashes. When Pro Tools is recording, it is lit continuously.

Tracks that are armed for recording will remain armed after Rec Arming mode is disabled.
Mstr Faders (Master Faders) Switch

When enabled (flashing), the Master Faders switch arranges all Master Fader tracks in the current session on the right-hand side of the control surface. Pressing this switch a second time returns the control surface to the previous view.

In Pan View, the Master Fader levels are displayed in the LCD.

Fader Flip Switch

When enabled (flashing), the Flip switch invokes Flip mode. Flip mode transfers control assignments from the rotary encoders to the corresponding channel faders, allowing you to use the touch-sensitive faders to edit and automate send and plug-in values. Additionally, in certain views, the rotary encoders are available to control another parameter.

Flip mode is not available in Pan View.

See “Using Flip Mode” on page 110 for more information.

Default Switch

The Default switch is used in conjunction with a Channel Select switch to reset a fader (or fader-mapped plug-in parameter) to its default setting. For example, you can reset a channel volume fader to its default level of 0.0 dB.

See “Setting Track Controls to Defaults” on page 109 for more information.

Input Switch

The Input switch toggles Auto Input and Input Only Monitor mode for record-enabled tracks.

See the Pro Tools Reference Guide for more information about Pro Tools input monitoring modes.
Console/Channel View Section

The Console and Channel View sections give you control over many on-screen elements in Pro Tools.

003 Console and Channel View switches

Both Console and Channel Views let you view and access pan, sends, or plug-ins for editing, and automation.

Console View Switches

Console View switches let you toggle 003 to show pan position, send assignments, or insert assignments for all channels on the control surface.

003 is in Console View when any of the Console View switches (Pan, Send, or Insert) is lit in the Console View section.

💡 When you first open a Pro Tools session, the top row of the 003 is in Console View with the Pan switch enabled (lit). This default view is sometimes called the Home View.

Think of Console View as a global view of a given control type across the entire mixer console (such as send A for Channels 1–8).
Insert/Send Position Switches

These switches determine which of the five available insert positions (marked A–E in Pro Tools) or ten available send positions (marked A–J in Pro Tools) are displayed in Console View.

For information on using Console View for specific Pro Tools workflows, see Chapter 11, “Pro Tools Mode with 003.”

There are three Console Views, based on their corresponding switch name:

Pan Switch When enabled (lit), 003 is in Pan View. This is the default View when you first open a Pro Tools session.

In this view, rotary encoders adjust channel pan positions, and faders adjust track volume. The bottom row of the LCD shows the track names, and temporarily shows the channel pan positions when the encoder is moved, or volume information when the fader is moved. The top row of the LCD shows the pan mode (left or right) and Main Counter.

Send Switch When enabled (lit), 003 is in Send View. In this view, rotary encoders adjust Send level and the faders adjust track volume. The bottom row of the LCD shows the names of currently assigned sends across all channel strips for a given send position (Sends A–J in Pro Tools). The top row of the LCD shows the send position and Main Counter.

Insert Switch When enabled (lit), 003 is in Insert View. In this view, the bottom row of the LCD shows the names of currently assigned inserts (hardware inserts or plug-ins) across all channel strips for a given insert position (Inserts A–E in Pro Tools). The top row of the LCD shows the insert position and Main Counter.

Channel View Section Switches

The first four Channel View switches determine the type of information displayed for a selected track. The first two switches focus on particular types of plug-ins (EQ and Dynamics), while the second two address all types of inserts and sends.

For information on using Console View for specific Pro Tools workflows, see Chapter 11, “Pro Tools Mode with 003.”

The Channel View section also includes Page Left, Page Right, Master Bypass, and ESC switches.

003 is in Channel View when any of the first four Channel View Select switches (EQ, Dynamics, Insert, or Pan/Send) is lit in the Channel View section.
Think of Channel View as a way to temporarily focus on all the plug-ins, inserts or sends on a single channel.

**EQ Switch** When enabled (flashing), 003 is in Channel View. In this view, 003 identifies channels with equalizer plug-ins assigned to them by illuminating their Channel View switches. The top row of the LCD shows “Select EQ” and the Main Counter. The bottom row shows track names.

**Dynamics Switch** When enabled (flashing), 003 is in Channel View. In this view, 003 identifies channels with dynamics plug-ins (such as compressors or limiters) assigned to them by illuminating their Channel Select switches. The top row of the LCD shows “Select Dynamics” and the Main Counter. The bottom row shows track names.

**Insert Switch** When enabled (flashing), 003 is in Channel View. In this view, 003 identifies channels with any kind of insert assigned to them (including plug-ins or hardware I/O inserts) by illuminating their Channel Select switches. The top row of the LCD shows “Select Insert” and the Main Counter. The bottom row shows track names.

**Pan/Send Switch** When enabled (flashing), 003 is in Channel View. In this view, 003 identifies channels with sends assigned to them by illuminating their Channel Select switches. The top row of the LCD shows “Select Pan Send A–E” and the Main Counter. The bottom row shows track names.

**Page Switches** These switches provide access to additional pages of sends, plug-in parameters or Memory Locations. The Page switches flash to indicate a next or previous page is available.

**Plug-In Master Bypass Switch** This switch lets you bypass either a single plug-in or all plug-ins on a channel, depending on the current view.

**ESC (Escape/Cancel) Switch** When flashing, this switch acts as a cancel button for certain operations on 003 (such as Channel View selections) and many on-screen dialogs in Pro Tools.
Transport and Navigation Controls

The 003 provides a standard set of Transport controls that mirror Pro Tools on-screen controls (when in Pro Tools mode) and conform to standard MMC commands for controlling other devices (in MIDI mode). Navigation keys and shortcut switches support Pro Tools zooming, banking, and navigation features.

Transport Controls

These controls correspond to transport functions in Pro Tools.

**RTZ** (Return to Zero) Sets the playback cursor to the beginning of the session.

**REW** (Rewind) Rewinds through the session from the current cursor position.

**FFW** (Fast Forward) Fast-forwards through the session from the current cursor position.

**STOP** Stops playback or recording.

**Play** Begins playback from the current cursor position.

**Record** Arms Pro Tools for recording. Clicking Play then initiates recording on record-enabled tracks only.
Jog/Shuttle Wheel

The dual-concentric Jog/Shuttle wheel provides additional navigation controls.

Shuttle Mode

The outer ring of the Jog/Shuttle wheel is a Shuttle control. When you move the Shuttle ring, 003 enters Shuttle mode. In this mode, you can play forwards or backwards at a variable rate, depending on the Shuttle position. Full clockwise and counter-clockwise positions provide the fastest shuttle rates. The Shuttle ring returns to the center position (no shuttling) when you release the wheel.

For more information, see “Navigating with the Shuttle/Jog Wheel” on page 109.

Jog Mode

The inner part of the Jog/Shuttle wheel is a Jog control. When you move the Jog wheel, 003 enters Jog mode. In this mode, you can move the session transport (and cursor) forwards or backwards.

For more information, see “Navigating with the Shuttle/Jog Wheel” on page 109.

The Jog control can be used to bank tracks to different faders.

For more information, see “Banking Channels on 003” on page 111.

The Jog control can also be used to continuously zoom in or out horizontally or vertically on all tracks.

For more information, see “Working With Memory Locations” on page 110.

Jog/Shuttle Wheel Takeover

When using the Jog/Shuttle wheel, keyboard and mouse commands are not supported, and most 003 controls are unavailable. 003 faders can be used at the same time as the Jog/Shuttle wheel. However, 003 transport controls disable the Jog/Shuttle wheel.

Normal operating mode is returned a few seconds after last touching the Jog/Shuttle wheel.

Navigation and Display Keys and Switches

These multi-purpose keys and switches control the display of Pro Tools tracks on the 003 control surface, on-screen zoom functions, and other Pro Tools navigation functions.

Arrow Keys

The Arrow keys are used to navigate tracks, zoom in and out, navigate in text entry fields, and drop Selection In and Out markers on-the-fly.

For more information, see “Navigating with the Shuttle/Jog Wheel” on page 109.
Fader Bank, Nudge, and Zoom Display Switches

The Display switches define basic Arrow key functionality, as follows:

**Bank Switch** When enabled (lit), the Arrow keys let you bank 003 fader strips to the previous or next eight tracks. You can also control and adjust selections and scroll in the Pro Tools Edit window.

**Nudge Switch** When enabled (lit), the Arrow keys let you nudge the display of tracks on 003 one track at a time. You can also control and adjust selections and scroll in the Pro Tools Edit window.

**Zoom Switch** When enabled (lit), the Arrow keys zoom the Pro Tools Edit window display.

**Additional Arrow Key Functionality**

You can use the Arrow keys to perform additional functions in Pro Tools, regardless of the active Display switch.

For more information, see “Navigating in the Edit Window” on page 108.

Record/Playback Transport Mode Switches

**Loop Play Switch** Toggles Loop Playback on and off

**Loop Rec Switch** Toggles Loop Record mode on and off

**QuickPunch Switch** Toggles QuickPunch Record mode on and off

Mem Loc (Memory Location) Switch

The Mem Loc (Memory Location) switch provides access to all Memory Locations in a Pro Tools session and can be used to set Memory Locations.

For more information, see “Working With Memory Locations” on page 110.

Windows Show/Hide Switches

**Plug-In Switch** Opens or closes the window for the currently selected plug-in

**Mix Switch** Opens, brings forward, or closes the Pro Tools Mix window

**Edit Switch** Opens, brings forward, or closes the Pro Tools Edit window
**Miscellaneous Switches**

**Save Switch** Pressing the Save switch twice is equivalent to choosing File > Save in Pro Tools.

**Undo Switch** Pressing the Undo switch is equivalent to choosing Edit > Undo in Pro Tools. (See the *Pro Tools Reference Guide* for details on multiple undo capabilities.)

**Enter (OK) Switch** Pressing the Enter switch is equivalent to pressing Return or Enter on the computer keyboard. This lets you OK on-screen dialogs or create new Memory Locations in Pro Tools directly from the control surface.

**Utility Switch** When enabled (lit), 003 enters Utility mode. In this mode, you can run pre-programmed diagnostic tests of the 003 unit (such as fader movement and LEDs) and reset MIDI mappings to their factory presets. The Utility switch is unavailable in Pro Tools mode.

> See Appendix A, “Utility Mode (003 Only)” for more information.

**Fader Mute** In Pro Tools mode, this switch temporarily suspends 003 fader movement. When enabled (flashing), this lets you work with Pro Tools and monitor audio playback without fader noise.

The Fader Mute feature has no effect on fader automation or audio levels during playback.

**Focus** In Pro Tools mode, this switch toggles the LCD display between the current plug-in view and the previous 003 view (such as Console or Channel View).

**To toggle between a plug-in view and the original view:**

- Press the Focus switch.

**MIDI Map Switches**

003 provides switches for using the control surface as a MIDI controller.

> For more information, see Chapter 12, “Using MIDI Mode with 003.”

**MIDI Map A and B Switches** When one of these switches is enabled (lit), 003 is in MIDI mode. In this mode, 003 functions as a MIDI control surface for external devices and applications other than Pro Tools. 003 supports two different banks of MIDI Map presets, corresponding to MIDI Map switch A and B.

**MIDI Edit** In MIDI mode, this switch lets you edit and name custom MIDI maps.

**MIDI Recall** In MIDI mode, this switch lets you recall and select MIDI map presets.
Automation Section

This section provides switches for controlling how automation data is written and played back.

### Automation Mode Switches

The Write, Touch, Latch, Read, and Off switches are used to set the Pro Tools Automation mode for any track.

When the Meter switch is set to Auto, the Meter LEDs for each channel display its Automation status.

For more information, see “Working with Automation” on page 112.

### Automation Switch LEDs

The Write, Touch, Latch, and Read switch LEDs individually light when at least one channel has the corresponding Automation mode. The Off switch LED flashes when no channels are set to Write, Touch, or Latch, and at least one channel’s Automation mode is set to Off.

Multiple LEDs light when there are channels with different Automation modes.

Suspend Switch

When enabled (flashing), automation is suspended for all channels.

For more information, see “Working with Automation” on page 112.

Modifiers Section

The Modifiers section includes four switches for modifying commands in combination with 003 switches, keyboard shortcuts, and Right-click commands in Pro Tools:

**Shift (Add) Switch** This switch lets you extend a track selection or add to a group of selected items.

**Option/Alt (All) Switch** This switch lets you apply an action or command to all tracks in a Pro Tools session.

**Ctrl/Win Switch** This switch lets you temporarily disengage a control from grouped behavior.

**Command/Ctrl Switch** This switch lets you fine-adjust controls and automation breakpoints.
003 Shortcuts

Modifier switches provide shortcuts for 003 functions that can be accomplished without using your computer’s keyboard or mouse.

For a list of 003 shortcuts, see “003 Top Panel Shortcuts” on page 113.

Pro Tools Shortcuts

For increased operational speed, there are many Pro Tools keyboard and Right-click shortcuts to give you fast access to a wide variety of tasks. These shortcuts in Pro Tools use modifier keys, (such as the Shift key) which are pressed in combination with other keys or with a mouse action.

003 Modifier switches mirror the functions of modifier keys on the computer keyboard. For example, 003’s Shift (Add) switch is equivalent to your keyboard’s Shift key.

<table>
<thead>
<tr>
<th>003 Switch</th>
<th>003-to-QWERTY (Mac)</th>
<th>003-to-QWERTY (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift (Add)</td>
<td>Shift</td>
<td>Shift</td>
</tr>
<tr>
<td>Option/Alt (All)</td>
<td>Option</td>
<td>Alt</td>
</tr>
<tr>
<td>Ctrl/Win</td>
<td>Control</td>
<td>Win</td>
</tr>
<tr>
<td>Command/Ctrl</td>
<td>Command</td>
<td>Control</td>
</tr>
</tbody>
</table>

You can use the Modifier switches in any combination with keys on your computer or a mouse action while working with Pro Tools.

For a complete list of Pro Tools keyboard and Right-click shortcuts, refer to the Shortcuts Guide for your computer platform.

Mic/DI Input Controls

There are four high-quality preamplifiers with adjustable gain and phantom power (switchable in pairs, for Inputs 1–2 and Inputs 3–4). The phantom power switches are on the back panel.

Inputs 1–4 show up as “Analog 1–4” in the default Pro Tools I/O Setup.

Mic/DI Input controls for Inputs 1–4

Inputs 1–4 have the following controls:

Input 1–4 Gain Controls Each knob adjusts gain for the input, with a range of +15 dB to +60 dB of gain.

Mic/DI Switches (Inputs 1–4) Each switch toggles the corresponding input between microphone (unlit) or DI input (lit).

The DI and Mic switch LEDs indicate the current source input. The LEDs blink rapidly when the input is clipping.

Engage the Mic switch only if you have an XLR cable plugged into the mic connector. Leaving the switch engaged with nothing connected may introduce low-level noise.

HPF (High Pass Filter) Switches (Input 1–4) These switches enable a high pass filter (75 Hz, 12 dB/octave rolloff) on the corresponding input, for filtering out rumble or AC hum. The HPF LEDs are lit when the switch is enabled.
Monitor Section

The Monitor section provides the following control room monitoring features:

**Alternate Input Routing Controls**

**Aux In to 7/8 Switch** This switch routes the Aux In input pair to Inputs 7 and 8 of Pro Tools, and does not send it to the Main Monitor Outputs unless this routing is set up in Pro Tools, or the Aux In (to Monitor) switch is engaged. This lets you route an alternate input signal (such as a CD player) directly into Pro Tools without the need to repatch any cables.

When Aux In to 7/8 is enabled (lit), Analog Inputs 7–8 are disabled.

**3/4-HP2 Switch** This switch sets the Headphone 2 Output to mirror Output pair 3–4.

**Aux In (to Monitor) Switch** This switch routes the Aux In input pair directly to the Main Monitor and Headphone Outputs.

If you press the Aux In (to Monitor) switch in conjunction with the Aux In to 7/8 switch, you will hear the pre-fader input of the Aux In in the Main Monitor outputs, and can record that input into Pro Tools from Inputs 7/8. Additionally, if you send the output of any track with inputs 7/8 back to the Main Monitor outputs, this can result in a doubled signal.

**Alt CR (Control Room) Switch** This switch mutes the Main Monitor output and routes the signal to the Alt Monitor output.

**Mono Switch** This switch temporarily combines Output 1–2 in the Main and Alt Monitor Outputs and the Headphone Outputs. This is helpful for checking the phase relationships of stereo material.

**Monitor and Headphone Level Controls**

**Monitor Level Control** These knobs control the volume of the Main and Alt Monitor Outputs. These outputs mirror Analog Outputs 1–2, which correspond to outputs 1–2 in Pro Tools.

**Headphone 1 and 2 Level Controls** These knobs control the volume of the independent Headphone Outputs. The Headphone Outputs normally mirror outputs 1–2 in Pro Tools, and are independent of the Monitor Outputs.

Headphone 2 mirrors output pair 3–4 when the 3/4-HP2 switch is enabled (lit). Both headphones include Aux In signal when Aux In (to monitor) is enabled.

Headphone output is not affected by the status of the Monitor Mute switch, but does follow status of the Mono switch.

**Monitor Mute Switch** This switch mutes the Main and Alt Monitor Outputs only, and has no effect on the Headphone Outputs. Monitor Mute is automatically engaged when you power up the unit.

**Headphone Jacks**

Headphone Output 1 and 2 jacks accept standard 1/4-inch stereo headphone connectors. The jacks are located on the front of the 003.
chapter 6

003 Rack Front Panel

The 003 Rack front panel provides controls for Inputs 1–4, options for routing outputs and monitoring alternate input sources, and indicators for connections status, sync source, and MIDI data.

Power Switch
The Power switch is located on the front panel.

Headphone Jacks
Headphone Output 1 and 2 jacks accept standard 1/4-inch stereo headphone connectors.

Mic/DI Input Controls
There are four high-quality preamplifiers with adjustable gain and phantom power (switchable in pairs, for Inputs 1–2 and Inputs 3–4). The phantom power switches are on the back panel.

Inputs 1–4 show up as “Analog 1–4” in the default Pro Tools I/O Setup.

Inputs 1–4 have the following controls:

Input 1–4 Gain Controls Each knob adjusts gain for the input, with a range of +15 dB to +60 dB of gain.
Mic/DI Switches (Inputs 1–4) Each switch toggles the corresponding input between microphone (unlit) or DI input (lit).

The DI/Mic switch LEDs indicate the current source input. The LEDs blink rapidly when the input is clipping.

⚠️ Engage the Mic switch only if you have an XLR cable plugged into the mic connector. Leaving the switch engaged with nothing connected may introduce low-level noise.

HPF (High Pass Filter) Switches (Input 1–4)

These switches enable a high pass filter (75 Hz, 12 dB/octave rolloff) on the corresponding input, for filtering out rumble or AC hum. The HPF LEDs are lit when the HPF switch is enabled (lit).

Monitor Section

The Monitor section provides the following control room monitoring features:

Monitor and Headphone Level Controls

Headphone 1 and 2 Level Controls These knobs control the volume of the independent Headphone Outputs. The Headphone Outputs normally mirror outputs 1–2 in Pro Tools, and are independent of the Monitor Outputs.

Headphone 2 mirrors output pair 3–4 when the 3/4-HP2 switch is enabled (lit). Both head-phones include Aux In signal when Aux In (to monitor) is enabled.

Headphone output is not affected by the status of the Monitor Mute switch, but does follow status of the Mono switch.

Monitor Level Control These knobs control the volume of the Main and Alt Monitor Outputs. These outputs mirror Analog Outputs 1–2, which correspond to outputs 1–2 in Pro Tools.

Alternate Input Routing Controls

Aux In to 7/8 Switch This switch routes the Aux In input pair directly to Inputs 7–8 of Pro Tools, and does not send it to the Main and Alt Monitor Outputs. This lets you route an alternate input signal (such as a CD player) directly into Pro Tools without the need to repatch any cables.

When Aux In to 7/8 is enabled (lit), Analog Inputs 7–8 are disabled.

3/4-HP2 Switch This switch sets Headphone 2 Output to mirror Output pair 3–4.

Aux In (to Monitor) Switch This switch routes the Aux In input pair directly to the Main Monitor and Headphone Outputs.

Alt CR (Control Room) Switch This switch mutes the Main Monitor output and routes the signal to the Alt CR output.

Mono Switch This switch temporarily combines Output 1–2 in the Main and Alt Monitor Outputs and the Headphone Outputs. This is helpful for checking the phase relationships of stereo material.

Monitor Mute Switch This switch mutes the Main and Alt Monitor Outputs only, and has no effect on the Headphone Outputs. Monitor Mute is automatically engaged when you power up the unit.
**Status Indicators**

**Host (“1394”) Status Indicator**

The Host status LED, marked “1394” below its LED, indicates that communication has been established between the unit and Pro Tools LE software (or another software application) through FireWire.

**Sync Indicators**

The Sync LEDs indicate the current clock source. When the current clock source is not established, the respective LED flashes.

If none of the Sync LEDs are lit, 003 Rack’s clock source is set to Internal.

There are three Sync LEDs:

- **W Clk (Word Clock) LED** Lights when clocking to Word Clock.
- **S/PDIF LED** Lights when clocking to the S/PDIF on the RCA or Optical port.
- **ADAT LED** Lights when clocking to ADAT on the Optical port.

**MIDI Data Indicators**

The MIDI Data LEDs indicate the presence of MIDI data on the MIDI In, MIDI Out 1, or MIDI Out 2 ports. Individual LEDs are provided for each port. Active sensing is not indicated.
The 003 and 003 Rack back panels include audio, MIDI and computer connectors for the unit (see See Figure 3 on page 62). The functions of each connector and their associated switches are explained in this section.

The 003 and 003 Rack have identical connectors. The 003’s Power switch is on its back panel, whereas the 003 Rack’s Power switch is on its front panel.

⚠️ Avid does not recommend the use of unbalanced cables. Unbalanced connections may introduce noise into your audio system. Whenever possible, use balanced cables to make connections to 003 and 003 Rack.

### Sample Rate and Resolution Support

The Analog-to-Digital and Digital-to-Analog converters on all 003 and 003 Rack analog inputs and outputs, as well as the S/PDIF Digital I/O ports, support sample rates of 44.1, 48, 88.2, and 96 kHz. The Optical port can be set for eight channels of ADAT Optical I/O (supporting up to 48 kHz) or two channels of S/PDIF Optical I/O.

All the analog and digital inputs and outputs on 003 and 003 Rack support up to 24-bit resolution audio.

### Operating Levels and Headroom

All 003 and 003 Rack audio inputs and outputs are set for 14 dB of headroom below 0 dB, or full code. This means at the nominal reference input level (+4 dBu or –10 dBV) you can have up to 14 dB of headroom before input or output clipping occurs.

The maximum input and output of 003 or 003 Rack using balanced TRS cables on any of the +4 dBu, 1/4-inch connectors is +18 dBu (6.15 Vrms).
**Analog Inputs**

**Mic Inputs 1–4**

These are balanced, three-conductor XLR connectors for microphone-level analog inputs. Gain is controlled by the corresponding Input Gain Control knob (located on the top panel of 003, and on the front panel of 003 Rack). The source (Mic, Line, or DI) is chosen using the Mic/DI switch.

⚠️ The XLR connectors on Inputs 1–4 are wired specifically to match the impedance of microphones. Do not use these XLR connectors for line inputs; use the 1/4-inch connectors instead.

**DI Inputs 1–4**

The DI (“Direct Inject” or “Direct Interface”) Inputs are balanced connectors for guitars and other instrument level sources that support 1/4-inch TS connections. Operating levels for these inputs are fixed at +4 dBu. Gain is controlled by the corresponding Input Gain knob (located on the top panel of 003, and on the front panel of 003 Rack). The source (Mic, Line, or DI) is chosen using the Mic/DI switch.

**Phantom Power Switches**

These switches apply 48V phantom power to Mic Inputs 1–2 and Mic Inputs 3–4 channel pairs, respectively. Enable these switches for microphones that require phantom power to operate.

⚠️ For more information, see “Phantom Power” on page 80.
Analog Inputs 5–8 and Operating Level Switches

Analog Inputs 5–8 are balanced, 1/4-inch TRS jacks for line-level analog audio input connections.

Operating levels for each of these line-level inputs is switchable between +4 dBu and –10 dBV, using the Operating Level switches immediately to the right of the input jacks.

While Inputs 5–8 do accept unbalanced connections, this may result in a noisier signal than a balanced-to-balanced connection.

⚠️ Analog Inputs 7–8 are disabled when the Aux In to 7/8 switch is enabled (lit).

Analog Outputs

Main Analog Outputs 1–8

These are impedance balanced, 1/4-inch TRS jacks for line-level analog audio output connections. Operating levels for these outputs are fixed at +4 dBu.

While the Main Analog Outputs do accept unbalanced connections, this may result in a noisier signal than a balanced-to-balanced connection.

💡 If you plan on connecting Analog Outputs 1–8 to –10 dBV gear, you may want to place a transformer-based line level attenuator between the 003 or 003 Rack output and the input of the destination device to compensate for level differences.

Monitor Section

Main Monitor Outputs

These outputs support balanced TRS, or unbalanced TS, 1/4-inch connections. To monitor your mix, these outputs can be connected to a mixing board, directly to a monitoring system (such as a stereo power amp, powered speakers, or another stereo destination).

The Main Monitor Outputs play the audio that is routed to analog outputs 1 and 2 from within Pro Tools, respectively. These analog outputs feature 24-bit digital-to-analog converters. Operating levels for these outputs are fixed at +4 dBu.

Monitor gain level is controlled by the Monitor Level control (located on the top panel of 003, and on the front panel of 003 Rack).

Monitor output can be muted and the signal routed to the Alt CR Output with the Alt CR switch.

Alt Monitor Outputs

These outputs support balanced TRS, or unbalanced TS, 1/4-inch connections. These outputs can be used to monitor your mix through an alternate, or secondary studio monitoring system, instead of the system connected to the Main Monitor Outputs.

The Alt Monitor Out Left and Right play the audio that is routed to analog outputs 1 and 2 from within Pro Tools, respectively. These analog outputs feature 24-bit digital-to-analog converters. Operating levels for these outputs are fixed at +4 dBu.

Monitor gain level is controlled by the Monitor Level control (located on the top panel of 003, and on the front panel of 003 Rack).
These outputs are enabled when the Alt CR switch is enabled (lit).

**Aux In**

These are balanced, 1/4-inch TRS connectors for connecting alternate audio sources such as CD players or tape decks. The signal from these inputs can be routed directly to the Main Monitor Outputs (for monitoring) or to Inputs 7–8 (for direct input into Pro Tools) from the top panel of 003, or the front panel of 003 Rack.

Operating levels for these inputs are fixed at +4 dBu.

When the Aux In switch is enabled (lit), Aux In signal is routed to the Main Monitor Outputs. Audio in Pro Tools that is routed to Analog 1–2 will not be mirrored at the Monitor Outputs.

When the Aux In to 7/8 switch is enabled (lit), Aux In signal is routed to Inputs 7–8 and does not pass directly to the Monitor Outputs.

When the Alt CR switch is enabled (lit), audio routed to Aux In will pass out the Alt Monitor Outputs.

**Digital I/O**

**S/PDIF Digital I/O**

The S/PDIF in and out ports are unbalanced two-conductor phono (RCA) connectors that utilize a full 24-bit, two-channel digital data stream.

The Sony/Philips Digital Interface Format (S/PDIF) is used in many professional and consumer CD recorders and DAT recorders. For highest digital signal integrity, and lower jitter, use 75 Ohm coaxial cable for S/PDIF transfers and keep the cable length to a maximum of 10 meters.

003 and 003 Rack support consumer mode S/PDIF output format (IEC60958-3) at sample rates of 44.1 kHz and 48 kHz, and professional mode S/PDIF output format (IEC60958-4) at sample rates of 88.2 kHz and 96 kHz. For information on which S/PDIF formats are supported by your S/PDIF-compatible gear, see the manufacturer’s documentation.

**Optical I/O**

These are a pair of TOSLINK-style connectors for ADAT Optical (8 channels of I/O) or S/PDIF Optical (2 channels of I/O) devices. You can choose between these Optical I/O formats in the Pro Tools Hardware Setup dialog.

The Optical port can be set for eight channels of ADAT Optical I/O (supporting up to 48 kHz) or two channels of S/PDIF Optical I/O.

The Optical I/O ports support 24-bit, 20-bit and 16-bit resolutions in both modes.  

⚠️ Only one S/PDIF input pair can be used at a time. For example, if you use the Optical In for S/PDIF data, you cannot use the RCA inputs.

At 96 kHz, it is recommended that you use the S/PDIF (RCA) port.

The Optical I/O ports use a standard optical “lightpipe” cable.

⚠️ Avid recommends high-quality audio grade optical cable for all optical connections.

When the 003 or 003 Rack is on, its Optical Out port emits a red light.
About Lightpipe-Compatible Devices

Lightpipe is an industry standard, eight-channel optical digital audio connection developed by Alesis. Lightpipe is found on many devices, including ADAT decks, modular digital multitracks (MDMs), sound cards, standalone A/D or D/A converters, and digital consoles.

Word Clock

The Word Clock In and Out ports let you connect BNC cables to synchronize 003 and 003 Rack to incoming 1x Word clock, and synchronize other devices to Pro Tools-generated Word clock.

MIDI Connectors

The MIDI In and MIDI Out 1 and Out 2 ports are standard 5-pin MIDI ports. The MIDI In port supports 16 channels of MIDI input. Each MIDI Out port supports 16 channels of MIDI output, for a system total of 32 channels of MIDI output.

A MIDI driver for these MIDI ports is installed when you install Pro Tools LE, and is recognized automatically by Audio MIDI Setup (Mac) and MIDI Studio Setup (Windows). These connectors accept standard 5-pin MIDI cables.

Kensington Lock Port

Use the Kensington Lock port to secure your interface with a Kensington Lock (not supplied).

For more information, visit the Kensington website (www.kensington.com).

Footswitch Jack

This connector lets you use a footswitch pedal to control either playback start/stop or recording punch in/out. Both QuickPunch audio punch-in and punch-out and MIDI punch-in and punch-out recording are supported. The footswitch connector is designed specifically for instantaneous (momentary) on/off pedals with a 1/4-inch TS connector. Continuous on/continuous off pedals can also be used, but may result in unexpected behavior.

IEEE-1394 (FireWire) Ports

These ports, marked “1394” in reference to their IEEE specification, are commonly known as FireWire ports. These provide connections to the computer and other FireWire devices.

FireWire offers a high rate of data transfer and reliability that makes it ideal for audio applications (such as Pro Tools with 003 family devices). FireWire devices can be daisy-chained together without the need for terminators.

If you are using a Windows laptop that has a 4-pin FireWire port (commonly labeled “1394”), see “Additional Software on the Pro Tools Installer Disc” on page 17 for FireWire cable information.
Connecting 003 or 003 Rack and FireWire Hard Drives

The FireWire ports on 003 and 003 Rack do not pass data when they are powered off. If you daisy-chain FireWire devices from your computer, it is best to connect FireWire hard drives directly to your computer and not to the 003 family device. This will prevent hard drive errors and data loss in case the 003 family device is powered off.

⚠️ Connecting 003 to a FireWire port of an external drive that is connected to a computer does not support maximum track count. For information on supported PCI/PCM-CIA/ExpressCard FireWire options, visit www.avid.com.

Connecting Other FireWire Devices to 003 or 003 Rack

The second FireWire port on 003 or 003 Rack is available for daisy-chaining FireWire devices such as digital cameras or digital video recorders. Even when it is powered off, 003 and 003 Rack supply power from the computer through their FireWire ports, letting you recharge batteries in other FireWire devices.

Link Indicator

The Link indicator lights when a valid FireWire connection is established (between the 003 family device and a computer).

Power Switch
(003 Back Panel Only)

The Power switch for 003 is located on its back panel.

The Power switch for the 003 Rack is located on its front panel.

AC Power Connector

The AC power connectors on 003 and 003 Rack accept a standard modular AC power cable.

003 and 003 Rack are auto power-selecting (100V to 240V) and will work automatically when plugged into an AC power receptacle in any country.

⚠️ 003 and 003 Rack require AC power and cannot be powered by the FireWire bus.
The 003 Rack+ front panel provides controls for Inputs 1–8, options for routing outputs and monitoring alternate input sources, and indicators for connections status, sync source, and MIDI data. It also includes a single 1/4-inch DI input linked to channel 1.

**Power Switch**

The Power switch is located on the front panel.

**Headphone Jacks**

Headphone output jacks 1 and 2 accept standard 1/4-inch stereo headphone connectors.

**Front Panel DI 1 Input**

The front panel DI 1 input routes to Input Channel 1 and accepts 1/4-inch balanced (TRS) and unbalanced (TS) cables. This input supersedes the rear panel channel 1 Line/DI input. The Line-DI switch for Channel 1 must be engaged (see “Line-DI” on page 68).
Mic and Line/DI Input Controls

The 003 Rack+ has eight input channels, each featuring a high-quality preamplifier with adjustable gain, phantom power, a high-pass filter, and a pad. These inputs show up as “Analog 1–8” in the default Pro Tools I/O Setup.

Inputs 1–8 have the following controls:

**Input Channel Gain Controls**

Each knob adjusts gain for the input, with a range of +15 dB to +60 dB of gain. Gain control applies to mic, line, or DI input signals, as well as the front panel DI input.

**Input Channel Select Switches**

Pressing an Input Channel Select switch gives you access to that channel’s Control switches.

Only one channel can be selected at a time, and the following switches will be lit or unlit depending on the status of the selected channel:

**Line-DI** When enabled (lit orange), the selected channel receives input from the corresponding Line/DI (1/4-inch TRS) input (or the front panel DI if channel 1 is selected). These combination inputs accept both balanced or unbalanced line-level signals (from sources like outboard effect units), and low-level instrument signals (from sources like guitars and basses).

When unlit, the selected channel receives input from the mic (XLR) input.

**48V** When enabled (lit red), 48 volts is applied to the mic (XLR) input of the selected channel for mics requiring phantom power (such as condenser mics).

*If the Line-DI switch is enabled, 48V phantom power will not be applied to the 1/4-inch input.*

**HPF (High-Pass Filter)** When enabled (lit green), an analog 75 Hz, 12 dB/octave rolloff high-pass filter is applied to the selected channel’s mic or Line/DI input for filtering out rumble or AC hum.

**Pad** When enabled (lit green), a –20 dB pad is applied to the selected channel’s mic or Line/DI input.

Monitor Section

The Monitor section provides the following control room monitoring features:

**Monitor and Headphone Level Controls**

**Headphone 1 and 2 Level Controls** These knobs control the volume of the independent Headphone Outputs. The Headphone Outputs normally mirror outputs 1–2 in Pro Tools, and are independent of the Monitor Outputs.

Headphone 2 mirrors output pair 3–4 when the 3/4-HP2 switch is enabled (lit). Both headphones include Aux In signal when Aux In (to monitor) is enabled.

Headphone output is not affected by the status of the Monitor Mute switch, but does follow the status of the Mono switch.
Monitor Level Control These knobs control the volume of the Main and Alt Monitor Outputs. These outputs mirror Analog Outputs 1–2, which correspond to outputs 1–2 in Pro Tools.

Alternate Input Routing Controls

Aux In to 7/8 Switch This switch routes the Aux In input pair directly to Inputs 7–8 of Pro Tools, and does not send it to the Main and Alt Monitor Outputs. This lets you route an alternate input signal (such as a CD player) directly into Pro Tools without the need to repatch any cables.

When Aux In to 7/8 is enabled (lit), Analog Inputs 7–8 are disabled.

3/4-HP2 Switch This switch sets Headphone 2 Output to mirror Output pair 3–4.

Aux In (to Monitor) Switch This switch routes the Aux In input pair directly to the Main Monitor and Headphone Outputs.

Alt CR (Control Room) Switch This switch mutes the Main Monitor output and routes the signal to the Alt CR output.

Mono Switch This switch temporarily combines Output 1–2 in the Main and Alt Monitor Outputs and the Headphone Outputs. This is helpful for checking the phase relationships of stereo material.

Monitor Mute Switch This switch mutes the Main and Alt Monitor Outputs only, and has no effect on the Headphone Outputs. Monitor Mute is automatically engaged when you power up the unit.

Status Indicators

Host (“1394”) Status Indicator

The Host status LED, marked “1394” below its LED, indicates that communication has been established between the unit and Pro Tools LE software (or another software application) through FireWire.

Sync Indicators

The Sync LEDs indicate the current clock source. When the current clock source is not established, the respective LED flashes.

If none of the Sync LEDs are lit, 003 Rack’s clock source is set to Internal.

There are three Sync LEDs:

W Clk (Word Clock) LED Lights when clocking to Word Clock.

S/PDIF LED Lights when clocking to the S/PDIF on the RCA or Optical port.

ADAT LED Lights when clocking to ADAT on the Optical port.

MIDI Data Indicators

The MIDI Data LEDs indicate the presence of MIDI data on the MIDI In and MIDI Out ports. Individual LEDs are provided for each port. Active sensing is not indicated.
The 003 Rack+ back panel includes audio, MIDI and computer connectors for the unit (see Figure 5 on page 72) The functions of each connector and their associated switches are explained in this section.

⚠️ Avid does not recommend the use of unbalanced cables. Unbalanced connections may introduce noise into your audio system. Whenever possible, use balanced cables to make connections to the 003 Rack+.

**Operating Levels and Headroom**

All 003 Rack+ audio inputs and outputs are set for 14 dB of headroom below 0 dB, or full code. This means at the nominal reference input level (+4 dBu or –10 dBV) you can have up to 14 dB of headroom before input or output clipping occurs.

The maximum input and output of the 003 Rack+ using balanced TRS cables on any of the +4 dBu, 1/4-inch connectors is +18 dBu (6.15 Vrms).

**Sample Rate and Resolution Support**

The Analog-to-Digital and Digital-to-Analog converters on the 003 Rack+ analog inputs and outputs, as well as the S/PDIF Digital I/O ports, support sample rates of 44.1, 48, 88.2, and 96 kHz. The Optical port can be set for eight channels of ADAT Optical I/O (supporting up to 48 kHz) or two channels of S/PDIF Optical I/O.

All the analog and digital inputs and outputs on the 003 Rack+ support up to 24-bit resolution audio.
Analog Inputs

Mic Inputs 1–8
These are balanced, three-conductor XLR connectors for microphone-level analog inputs.

Gain is controlled by the corresponding Input Gain Control knob (located on the front panel of 003 Rack+). The source (Mic, Line, or DI) is chosen using the front panel Line-DI switch.

An unlit Line/DI switch means the mic (XLR) input is active.

⚠️ The XLR connectors on Inputs 1–8 are wired specifically to match the impedance of microphones. Do not use these XLR connectors for line inputs; use the 1/4-inch connectors instead.

Line/DI Inputs 1–8
The combination Line/DI (“Direct Input,” “Direct Inject,” or “Direct Interface”) inputs accept both balanced 1/4-inch balanced TRS connectors (for outboard effects and other line-level sources) and unbalanced 1/4-inch TS connectors (for guitars and other instrument level sources).

Gain is controlled by the corresponding Input Gain knob (located on the front panel of 003 Rack+). The source (Mic, Line, or DI) is chosen using the Line-DI switch.

An enabled (lit) Line-DI switch means the Line/DI (1/4-inch) input is active.

💡 If you have an instrument connected to the front panel DI 1 input and you have a line or DI input connected to the rear panel channel 1 Line/DI input, the front panel DI 1 input takes precedence over the rear panel channel 1 Line/DI input.
**Analog Outputs**

**Main Analog Outputs 1–8**

These are impedance balanced, 1/4-inch TRS jacks for line-level analog audio output connections. Operating levels for these outputs are fixed at +4 dBu.

While the Main Analog Outputs do accept unbalanced connections, this may result in a noisier signal than a balanced-to-balanced connection.

> If you plan on connecting Analog Outputs 1–8 to –10 dBV gear, you may want to place a transformer-based line level attenuator between the 003 Rack+ output and the input of the destination device to compensate for level differences.

**Monitor Section**

**Main Monitor Outputs**

These outputs support balanced TRS, or unbalanced TS, 1/4-inch connections. To monitor your mix, these outputs can be connected to a mixing board, directly to a monitoring system (such as a stereo power amp, powered speakers, or another stereo destination).

The Main Monitor Outputs play the audio that is routed to analog outputs 1 and 2 from within Pro Tools, respectively. These analog outputs feature 24-bit digital-to-analog converters. Operating levels for these outputs are fixed at +4 dBu.

Monitor gain level is controlled by the Monitor Level control (located on the front panel of the 003 Rack+).

Monitor output can be muted and the signal routed to the Alt CR Output with the Alt CR switch.

**Alt Monitor Outputs**

These outputs support balanced TRS, or unbalanced TS, 1/4-inch connections. These outputs can be used to monitor your mix through an alternate, or secondary studio monitoring system, instead of the system connected to the Main Monitor Outputs.

The Alt Monitor Out Left and Right play the audio that is routed to analog outputs 1 and 2 from within Pro Tools, respectively. These analog outputs feature 24-bit digital-to-analog converters. Operating levels for these outputs are fixed at +4 dBu.

Monitor gain level is controlled by the Monitor Level control (located on the front panel of 003 Rack+).

These outputs are enabled when the Alt CR switch is enabled (lit).

**Aux In**

These are balanced, 1/4-inch TRS connectors for connecting alternate audio sources such as CD players or tape decks. The signal from these inputs can be routed directly to the Main Monitor Outputs (for monitoring) or to Inputs 7–8 (for direct input into Pro Tools) from the front panel of the 003 Rack+.

Operating levels for these inputs are fixed at +4 dBu.

When the Aux In switch is enabled (lit), Aux In signal is routed to the Main Monitor Outputs. Audio in Pro Tools that is routed to Analog 1–2 will not be mirrored at the Monitor Outputs.

When the Aux In to 7/8 switch is enabled (lit), Aux In signal is routed to Inputs 7–8 and does not pass directly to the Monitor Outputs.
When the Alt CR switch is enabled (lit), audio routed to Aux In will pass out the Alt Monitor Outputs.

**Digital I/O**

**S/PDIF Digital I/O**

The S/PDIF in and out ports are unbalanced two-conductor phono (RCA) connectors that utilize a full 24-bit, two-channel digital data stream.

The Sony/Philips Digital Interface Format (S/PDIF) is used in many professional and consumer CD recorders and DAT recorders. For highest digital signal integrity, and lower jitter, use 75 Ohm coaxial cable for S/PDIF transfers and keep the cable length to a maximum of 10 meters.

The 003 Rack+ supports *consumer mode* S/PDIF output format (IEC60958-3) at sample rates of 44.1 kHz and 48 kHz, and *professional mode* S/PDIF output format (IEC60958-4) at sample rates of 88.2 kHz and 96 kHz. For information on which S/PDIF formats are supported by your S/PDIF-compatible gear, see the manufacturer’s documentation.

**Optical I/O**

These are a pair of TOSLINK-style connectors for ADAT Optical (8 channels of I/O) or S/PDIF Optical (2 channels of I/O) devices. You can choose between these Optical I/O formats in the Pro Tools Hardware Setup dialog.

The Optical port can be set for eight channels of ADAT Optical I/O (supporting up to 48 kHz) or two channels of S/PDIF Optical I/O.

The Optical I/O ports support 24-bit, 20-bit and 16-bit resolutions in both modes.

⚠️ Only one S/PDIF input pair can be used at a time. For example, if you use the Optical In for S/PDIF data, you cannot use the RCA inputs.

At 96 kHz, it is recommended that you use the S/PDIF (RCA) port

The Optical I/O ports use a standard optical “lightpipe” cable.

⚠️ Avid recommends high-quality audio grade optical cable for all optical connections.

When the 003 Rack+ is on, its Optical Out port emits a red light.

**About Lightpipe-Compatible Devices**

Lightpipe is an industry standard, eight-channel optical digital audio connection developed by Alesis. Lightpipe is found on many devices, including ADAT decks, modular digital multitracks (MDMs), sound cards, standalone A/D or D/A converters, and digital consoles.

**Word Clock**

The Word Clock In and Out ports let you connect BNC cables to synchronize your 003 Rack+ to incoming 1x Word clock, and synchronize other devices to Pro Tools-generated Word clock.
MIDI Connectors

The MIDI In and MIDI Out ports are standard 5-pin MIDI ports. The MIDI In port supports 16 channels of MIDI input. The MIDI Out port supports 16 channels of MIDI output.

A MIDI driver for these MIDI ports is installed when you install Pro Tools LE, and is recognized automatically by Audio MIDI Setup (Mac) and MIDI Studio Setup (Windows). These connectors accept standard 5-pin MIDI cables.

⚠️ The 003 Rack+ only has one MIDI Out port. However, MIDI Out 2 will still appear in Pro Tools. When using the 003 Rack+ with Pro Tools, only use MIDI Out 1. Selecting MIDI Out 2 will produce no MIDI output information.

Kensington Lock Port

Use the Kensington Lock port, located on the right side of the device’s chassis, to secure your 003 Rack+ with a Kensington Lock (not supplied).

For more information, visit the Kensington website (www.kensington.com).

Footswitch Jack

This connector lets you use a footswitch pedal to control either playback start/stop or recording punch in/out. Both QuickPunch audio punch-in and punch-out and MIDI punch-in and punch-out recording are supported. The footswitch connector is designed specifically for instantaneous (momentary) on/off pedals with a 1/4-inch TS connector. Continuous on/continuous off pedals can also be used, but may result in unexpected behavior.

IEEE-1394 (FireWire) Ports

These ports, marked “1394” in reference to their IEEE specification, are commonly known as FireWire ports. These provide connections to the computer and other FireWire devices.

FireWire offers a high rate of data transfer and reliability that makes it ideal for audio applications (such as Pro Tools with 003 family interfaces). FireWire devices can be daisy-chained together without the need for terminators.

⚠️ If you are using a Windows laptop that has a 4-pin FireWire port (commonly labeled “1394”), see “Additional Software on the Pro Tools Installer Disc” on page 17 for FireWire cable information.

Connecting 003 Rack+ and FireWire Hard Drives

The FireWire ports on the 003 Rack+ do not pass data when they are powered off. If you daisy-chain FireWire devices from your computer, it is best to connect FireWire hard drives directly to your computer and not to the 003 Rack+. This will prevent hard drive errors and data loss in case the 003 Rack+ is powered off.

⚠️ Connecting the 003 Rack+ to a FireWire port of an external drive that is connected to a computer does not support maximum track count. For information on supported PCI/PCMCIA/ExpressCard FireWire options, visit www.avid.com.
Connecting Other FireWire Devices 003 Rack+

The second FireWire port on 003 Rack+ is available for daisy-chaining FireWire devices such as digital cameras or digital video recorders. Even when it is powered off, 003 Rack+ supply power from the computer through their FireWire ports, letting you recharge batteries in other FireWire devices.

Link Indicator

The Link indicator lights when a valid FireWire connection is established (between the 003 Rack+ and a computer).

AC Power Connector

The AC power connectors on 003 Rack+ accepts a standard modular AC power cable.

003 Rack+ is auto power-selecting (100V to 240V) and will work automatically when plugged into an AC power receptacle in any country.

⚠️ 003 Rack+ requires AC power and cannot be powered by the FireWire bus.
To hear audio recorded into a Pro Tools session, you will need to connect headphones or an external sound system (such as powered monitors or a home stereo) to your 003 family interface. Sound from your 003 family interface cannot be played through your computer’s speakers or your computer’s sound output.

Connecting Headphones

There are two stereo 1/4-inch headphone jacks on 003 family interfaces.

To connect headphones:
- Connect headphones with a 1/4-inch stereo connector (or adapter) to the Headphone 1 or 2 jack.

To adjust headphone levels:
- Adjust the Headphone 1 or 2 Level knobs.

To set Headphone 2 Output to mirror Output pair 3–4:
- Press the 3/4-HP2 switch.

Connecting a Sound System

The Main Monitor Outputs on the back of 003 family interfaces support 1/4-inch plugs. These connections can be balanced, TRS (Tip, Ring, Sleeve) style connectors, or unbalanced connectors. To listen to your Pro Tools session, these outputs can be connected to any amplification system: powered speakers, a home stereo system, or an audio mixer.

An alternate monitoring system can be connected to the Alt Monitor Outputs.
When connecting to a stereo system, connect the left channel to Main Monitor Output L, and right channel to Main Monitor Output R.

![Main Monitor Outputs](image)

**Main Monitor Outputs (all models)**

Home stereo systems often use RCA connectors for analog audio connections. You can use an adaptor or a special cable to convert from the TRS or TS connectors used by 003 Rack to the RCA connectors on your home stereo.

Main Monitor Outputs L and R play the audio that is routed to analog outputs 1 and 2 within Pro Tools.

The Monitor Level knob (located on the top panel of 003, and on the front panel of 003 Rack and 003 Rack+) adjusts the volume level of the Monitor Outputs.

You can also connect a sound system to any of the Analog Outputs 1–8, although you will not have Monitor section controls available.

**Mirroring the Outputs on S/PDIF Out**

When using your 003 family interface with Pro Tools, you can send any pair of outputs (such as outputs 1–2) to the S/PDIF digital outputs at the same time by assigning the stereo mix to multiple output destinations. This is commonly known as mirroring the outputs.

Output mirroring is useful for recording to multiple media, creating separate monitoring mixes, or for output to digital effects processors.

For information on S/PDIF connections, see “Connecting Equipment with Digital Ins and Outs” on page 86

**To mirror 003 family interface Outputs 1–2 on the S/PDIF outputs:**

1. Open the Pro Tools session whose channel outputs you want to mirror.

2. In the Mix window, click the Output selector of any audio or Auxiliary Input track to select the main output destination, for example, Analog 1–2.

3. Control-click (Mac) or Start-click (Windows) the same Output selector and select an additional output pair from the same pop-up menu.

The newly selected destination is indicated by an additional check mark in the output pop-up menu, and a plus sign in the Output selector.

If you plan on connecting Analog Outputs 1–8 to –10 dBV gear, you may want to place a transformer-based line level attenuator between your 003 family interface’s output and the input of the destination device to compensate for level differences.
Connecting Audio Inputs

003 family inputs support microphones, guitars, keyboards, and other types of instruments.

003 family interfaces have eight analog inputs. On the 003 and 003 Rack, one set of inputs is labeled Mic Inputs 1–4 and DI Inputs 1–4, and the other four are labeled Analog 5–8.

On the 003 Rack+, XLR mic inputs are labeled 1-8, and the combination Line/DI 1/4-inch inputs are labeled 1-8.

For stereo inputs, use an odd/even pair of inputs (for example, Input 5 for the left input, and Input 6 for the right input.

You cannot use both a mic input and DI input with the same input number at the same time.

For information about connecting specific audio sources, see “Connecting a Microphone” on page 80, and “Connecting Instruments to 003 Family Interfaces” on page 83.
Connecting a Microphone

There are several ways to use your 003 family interface with a microphone, depending on the type of microphone and cables you use.

Mic Cables and Connectors

Some microphone cables use an XLR connector to attach a microphone to an input (such as those on 003 family interfaces). Other microphones use a 1/4-inch connector. If you have a choice, use an XLR connector to connect the microphone to your 003 family interface to yield better results.

Phantom Power

Some microphones require power to operate. This power, called phantom power, is supplied either by a battery in the microphone, or through an audio interface (such as your 003 family interface) that can supply power through the microphone cable.

Most condenser microphones (such as an AKG C3000) require phantom power to operate. Dynamic microphones (such as a Shure SM57) do not require phantom power to operate, but are not harmed by it.

Although phantom power can be used safely with most microphones, ribbon microphones can be damaged by it. Always turn off phantom power and wait at least 30 seconds before connecting a ribbon microphone.

003 family interfaces can only supply power through a microphone cable with XLR connectors.

If you are not sure about the phantom power requirements for your microphone, see your microphone’s documentation or contact the manufacturer.

Using a Mic with an XLR Connector

To use a microphone that has an XLR connector:

1. On the back of your 003 family interface, plug your microphone cable into one of the XLR mic inputs. The inputs are numbered left to right, so Mic Input 1 is the leftmost input.
2 Depending on your device, do one of the following:
   • If using the 003 or 003 Rack, press the Mic/DI switch (located on the top panel of the 003, and on the front panel of the 003 Rack) for the corresponding input so that it is in the Mic (unlit) position.
   – or –
   • If using the 003 Rack+, press the Input Channel Select switch (located on the front panel) for the corresponding input and make sure the Line-DI switch is not enabled (unlit).

3 If your microphone requires phantom power, make sure the microphone is connected and do one of the following depending on your device:
   • If using the 003 or 003 Rack, press the Phantom Power switch (labeled 48V) on the back of the device for the corresponding input pair. Each Phantom Power switch sends 48V to its corresponding input pair.
   – or –
   • If using the 003 Rack+, press the Input Channel Select switch (located on the front panel) for the corresponding input and press the 48V switch so that it is lit (red).

4 When Pro Tools is launched and the input is routed to a Pro Tools track, you can adjust the input level with the Input Gain Control knobs (located on the top panel of the 003, and the front panel of the 003 Rack and 003 Rack+).
Using a Mic with a 1/4-Inch Connector

To use a microphone that has a 1/4-inch connector with your 003 family interface:

1. Do one of the following, depending on your device:
   - If using the 003 or 003 Rack, on the back of your device plug the 1/4-inch connector from your microphone into one of the DI inputs. From the back, the inputs are numbered left to right, so DI Input 1 is the left-most input.
   - or –
   - If using the 003 Rack+, plug your mic’s 1/4-inch connector into the DI 1 1/4-inch input on the front panel (or into a rear-panel 1/4-inch Line/DI input).

2. Do one of the following, depending on your device:
   - If using the 003 or 003 Rack, press the Mic/DI switch (located on the top panel of the 003, and on the front panel of the 003 Rack) for the corresponding input so that it is lit (yellow).
   - or –
   - If using the 003 Rack+, press the Input Channel Select switch (located on the front panel) for the corresponding input and press the Line-DI switch so that it is lit (orange).

   \[\text{If you are using a microphone with a 1/4-inch connector, do not choose the “Mic” input source because the 003 family interface will not register any signal.}\]

3. When Pro Tools is launched and the input is routed to a Pro Tools track, you can adjust the input level with the Input Gain Control knob.
Connecting Instruments to 003 Family Interfaces

The 1/4-inch inputs on 003 family interfaces support both higher output “line-level” devices and low-output instruments (such as electric or acoustic guitars). This section contains examples for connecting both types to your 003 family interface.

Instruments such as electric guitar or electric bass usually have a lower level of output than instruments and electronic audio sources such as mixers, samplers, keyboards, turntables, and synthesizers.

The higher level of output is commonly called “line-level” and the instruments that produce these higher levels are called line-level devices.

On 003 and 003 Rack, DI Inputs 1–4 support low-level instruments and line-level instruments. Analog Inputs 5–8 support line-level instruments only.

On the 003 Rack+, Line/DI inputs 1-8 (as well as the front panel DI 1 input) support low-level instruments and line-level instruments.

To use a guitar with the 003 family interface:

1. Do one of the following, depending on your device:
   - On the back of the 003 or 003 Rack, plug your guitar cable into one of the DI inputs. From the back, the inputs are numbered left to right, so DI Input 1 is the leftmost input.
   - If using the 003 Rack+, plug your guitar cable into the front panel DI 1 1/4-inch input (or into a rear-panel 1/4-inch Line/DI input).
2 Do one of the following, depending on your device:

- If using the 003 or 003 Rack, press the Mic/DI switch (located on the top panel of the 003, and on the front panel of the 003 Rack) for the corresponding input so that it is lit (yellow).

- or -

- If using the 003 Rack+, press the Input Channel Select switch (located on the front panel) for the corresponding input, and press the Line-DI switch so that it is lit (orange).

003 and 003 Rack Mic/DI switches

3 When Pro Tools is launched and the input is routed to a Pro Tools track, you can adjust the input level with the Input Gain Control knob.

To use a keyboard or mixer with 003 or 003 Rack:

1 On the back of the 003 or 003 Rack, plug your keyboard, mixer, or other audio source into any of the DI inputs or Analog Inputs by doing one of the following:

- Use Analog Inputs 5–8 if you need to select –10 dBV or +4 dBu operating level for your keyboard.

- or -

- Use DI Inputs 1–4 if Analog Inputs 5–8 are unavailable, or if you do not need to set the operating level. DI Inputs 1–4 are available even if a mic is connected to Mic Inputs 1–4 (although both cannot be active at the same time).

For stereo inputs, (such as a stereo keyboard or the stereo output from a mixer), use an odd/even pair of inputs. For example, connect the left channel to DI Input 1, and right channel to DI Input 2.

From the back, the inputs are numbered left to right, so DI Input 1 is the leftmost input.
If you are using any DI inputs, press the Mic/DI switch (located on the top panel of the 003, and on the front panel of the 003 Rack) for the corresponding input so that it is in the DI (lit) position.

2 If you are using any of the Inputs 5–8, set either a –10 dBV or +4 dBu operating level for the corresponding input using the Operating Level switch (located on the back panel). For information on the appropriate operating level for your input device, see the manufacturer’s specifications.

Set your instrument’s volume to its optimal level. For example, the optimal level for most keyboards is between 80% and 100% of maximum volume.

5 When Pro Tools is launched and the input is routed to a Pro Tools track, if you are using the DI Inputs you can adjust the input level with the Input Gain Control knob.

To use a keyboard or mixer with 003 Rack+:

1 On the back of the 003 Rack+, plug your keyboard, mixer, or other audio source into any of the Line/ DI inputs.

For line-level devices, the Input Gain Control knob should be turned down all the way.
For stereo inputs, (such as a stereo keyboard or the stereo output from a mixer), use an odd/even pair of inputs. For example, connect the left channel to Line/DI Input 1, and right channel to Line/DI Input 2.

2 On the front panel, press the Input Channel Select switch (located on the front panel) for each corresponding input, making sure the Line-DI switch is enabled (lit) for each channel.

3 Set your instrument’s volume to its optimal level. For example, the optimal level for most keyboards is between 80% and 100% of maximum volume.

4 When Pro Tools is launched and the input is routed to a Pro Tools track, you can adjust the input level with the Input Gain Control knob.

For line-level devices, the Input Gain Control knobs should be turned down all the way.

Connecting Equipment with Digital Ins and Outs

Each 003 family interface provide up to ten digital inputs and outputs, including:

- Eight channels of ADAT Optical input and output, or two channels of Optical S/PDIF input. Avid recommends high-quality audio grade optical cable for all optical connections.
- Two channels of S/PDIF digital input and output (RCA connectors).

Up to 18 channels of I/O can be achieved by using the S/PDIF RCA I/O, Optical (ADAT) I/O, and analog I/O at the same time.

⚠️ Only one S/PDIF input pair can be used at a time. For example, if you use the optical input for S/PDIF data, you cannot use the RCA inputs. For more information on configuring Digital I/O, see “Configuring Pro Tools LE Software” on page 22.

For more information on each I/O type, see “Digital I/O” on page 64

For information on connecting digital effects devices, see “Using External Effects Devices” on page 88.

For information on recording from a Digital I/O, see “Recording from a Digital Device” on page 90.
To connect your 003 family interface to a S/PDIF digital device using RCA cables:

1. Using RCA (coaxial) cables, connect the 003 family interface S/PDIF In to the S/PDIF output of the external device.
2. Connect the 003 family interface S/PDIF Out to the S/PDIF input of the external device.

To connect your 003 family interface to a S/PDIF device using Optical (ADAT) cables:

1. Using an optical cable, connect the Optical output on the Optical device to the Optical In port on the 003 family interface.
2. Connect the Optical input on the Optical device to the Optical Out port on the 003 family interface. (When the 003 or 003 Rack is on, its Optical Out port emits a red light.)

To connect your 003 family interface to an ADAT device using Optical (ADAT) cables:

1. Using an optical cable, connect the Optical output on the ADAT device to the Optical In port on your 003 family interface.
2. Connect the Optical input on the ADAT device to the Optical Out port on the 003 family interface. (When your 003 family interface is on, its Optical Out port emits a red light.)

**Word Clock**

003 family interfaces provide Word Clock In and Out connectors on the back panel that let you synchronize, or “clock” Pro Tools LE and the 003 family interface to industry standard Word clock. Word clock is used to synchronize a wide range of devices such as non-linear video systems and other types of equipment typically found in professional audio facilities.

With both Word clock input and output, your Pro Tools LE system can act as Word clock “slave” or “master.”

Do not confuse Word clock and other forms of “clock reference” with time code and other forms of “positional reference.” For an overview of synchronization terms and concepts, see the Sync & Surround Concepts Guide.

To connect your 003 family interface to Word clock:

- Using high-quality, 75 Ohm BNC cables (not included), connect the 003 family interface Word Clock In and Out connectors to the appropriate ports on the other Word clock-capable devices in your studio.

**Using Word Clock with Pro Tools LE**

Pro Tools LE with 003 family interfaces can act as Word clock master, or as a slave to Word clock supplied by an external device.

**Pro Tools LE as Word Clock Master**

003 family interface Word clock output is always active, letting Pro Tools supply Word clock to any connected devices that support standard Word clock.

To use Pro Tools LE as Word clock master:

1. Make sure all connections are correct between the 003 family interface and your external devices.
2. Configure all external devices to slave to the Word clock coming from the 003 family interface. (Be sure to match the sample rate setting of the Pro Tools session, and verify the termination requirements and other internal settings for the device; see the manufacturer’s documentation for the requirements for your other equipment.)
Launch Pro Tools.

Choose Hardware > Setup.

Click the Clock Source pop-up menu and select Internal.

Click OK.

**Pro Tools LE as Word Clock Slave**

In order to slave Pro Tools to an external Word clock source, you must configure Word clock as the Pro Tools Clock source, as follows:

To configure Pro Tools LE with the 003 family interface as a Word clock slave:

1. Make sure all Word clock and audio connections are correct as described earlier in this section.

2. Make sure the external Word clock source is powered on, and configured to output 1x Word clock. (Be sure to verify any required termination; see the manufacturer’s documentation for the particular requirements for your device.)

Launch Pro Tools.

Choose Hardware > Setup.

Click the Clock Source pop-up menu and select Word Clock.

Click the Sample Rate pop-up menu and match the sample rate of the external Word clock source.

Click OK.

---

**Using External Effects Devices**

003 family interfaces can make dedicated connections to external analog or digital devices. You can send and return signals to analog devices using the analog inputs and outputs on 003 family interfaces. You can also send and return a digital signal to an external device that supports digital I/O (such as a reverb unit), and monitor the return by connecting its analog outputs to available inputs on 003 family interfaces.

When you use the digital inputs and outputs on your Pro Tools LE system as effects sends and returns to a digital effects device, Pro Tools LE should be the clock master in most cases. Set your digital effects device to accept an external digital clock so that it synchronizes to Pro Tools LE.

To connect an external analog device to your system:

1. Connect each input of the external signal processor to an available analog output on the 003 family interface.

2. Connect each output of the external signal processor to an available analog input on the 003 family interface.

*If you plan to use the external device as an Insert in Pro Tools, connect it to inputs and outputs of the same number (for example, Input 5 and Output 5) of the 003 family interface.*
To set up a send to an external digital effects device (digital sends/returns only):

1. Connect the digital inputs and outputs of the external signal processor to the appropriate digital connectors (the S/PDIF RCA connectors or the Optical ports) on 003 family interface.

2. In Pro Tools, choose Setup > Hardware.

3. Under Optical Format, do one of the following:
   - If the external effects device is a S/PDIF device and connected to the S/PDIF RCA jacks, select ADAT (if the selected sample rate is 44.1 or 48 kHz) or None (if the selected sample rate is 88.2 or 96 kHz). The RCA jack is only active when Optical S/PDIF is not enabled.
   - If the external effects device is a S/PDIF device and connected to the Optical ports, select S/PDIF.
   - If the external effects device is an ADAT Optical compatible device, select ADAT.

4. Click the Clock Source pop-up menu and select Internal.

5. Click the Sample Rate pop-up menu and select a sample rate. The sample rate of the Pro Tools session and external digital device must match. If necessary, change the sample rate of the digital device.

6. Click OK.

You can use the I/O Setup dialog (Setup > I/O) to label the inputs and outputs you are using in Pro Tools LE and identify them as inserts or sends when working in a session. See the Pro Tools Reference Guide for details.

---

**Monitoring and Recording from Alternate Sources**

003 family interfaces provide a pair of additional inputs for monitoring and recording from an external sound source such as a CD player or tape deck. This alternate input is equipped with 1/4-inch TRS connectors and is designed for input signals with a nominal operating level of +4 dBu.

![Aux In for alternate sound sources](image)

*To monitor an external device through the Alternate Source Inputs, the 003 family interface must be powered on.*

**To monitor an alternate sound source through the Monitor Outputs of your 003 family interface:**

1. Connect the outputs of the external device to the left and right Aux In connectors on the back panel of the 003 family interface.

2. Route the signal to the Monitor Output by pressing the Aux In switch (located on the top panel of 003, and on the front panel of 003 Rack and the 003 Rack+) so that it is enabled (lit).

3. If you want to monitor the signal through the Alternate Monitor Outputs, press the Alt CR switch. Any tracks within Pro Tools that are sent to the Monitor Outputs will not be heard.

4. Adjust Monitor Output or Headphone Output levels to audition the input.
To record an alternate sound source directly into Pro Tools:

1. Connect the outputs of the external device to the left and right Aux In connectors on the back panel of the 003 family interface.

2. Route the signal directly to Inputs 7–8 in Pro Tools by pressing the Aux In to 7–8 switch (located on the top panel of 003, and on the front panel of 003 Rack and the 003 Rack+) so that it is enabled (lit).

When the Aux In to 7–8 switch is enabled, Inputs 7 and 8 on the back panel are inactive. Also, because the signal can be monitored from Pro Tools, it no longer passes directly to the Monitor Outputs.

Recording from a Digital Device

If you are recording from an optical or S/PDIF device, you will need to select a Clock Source. In most cases, you will synchronize the Pro Tools clock to the external device.

If you are using an optical device for recording, you also need to set the Optical Format.

To configure Pro Tools LE for a digital source:

1. Connect an ADAT or Optical S/PDIF format device to the Optical In connector, or an RCA S/PDIF format device to the S/PDIF In connector on the back of the 003 family interface.

2. Choose Setup > Hardware.

3. Under Optical Format, do one of the following:
   - If the external digital device is a S/PDIF device and connected to the S/PDIF RCA jacks, select ADAT (if the selected sample rate is 44.1 or 48 kHz) or None (if the selected sample rate is 88.2 or 96 kHz). The RCA jack is only active when Optical S/PDIF is not enabled.
   - If the external digital device is a S/PDIF device and connected to the Optical ports, select S/PDIF.
   - If the external digital device is an ADAT Optical compatible device, select ADAT.

   ! You can use only one pair of S/PDIF inputs (either RCA or Optical) at a time.

4. From the Clock Source pop-up menu, do one of the following:
   - If you are synchronizing the Pro Tools clock to the external device, select ADAT, RCA (S/PDIF), or Optical (S/PDIF), depending on where you connected your digital device.

   ! Your digital input device must be connected and powered on. If your input device is not powered on, leave the Clock Source set to Internal.

   – or –
   - Select Internal if you are synchronizing the external device to the 003 family interface.

   ! You can use the I/O Setup dialog (Setup > I/O) to label the inputs and outputs you are using in Pro Tools LE and identify them as inserts or sends when working in a session. See the Pro Tools Reference Guide for details.
5 Click the Sample Rate pop-up menu and select a sample rate. The sample rate of the Pro Tools session and external digital device must match. If necessary, change the sample rate of the digital device.

6 Click OK.

Connecting a Recorder for Mixdowns

After you record and mix your sessions using your 003 family interface, you may want to mix them down to a DAT, or other stereo 2-track recording device.

Connecting an Analog Deck

- Connect your recorder’s inputs to the Alt Monitor Outputs (or any other output pair) on the back of the family interface. These outputs are 1/4-inch jacks. You may need adapter cables if your mixdown deck has RCA inputs.

Connecting a Digital Deck

- If you have a DAT or other digital device that can receive S/PDIF digital audio data, connect it to the S/PDIF In and S/PDIF Out RCA jacks on the back of the 003 family interface.

Connecting a Lightpipe-Compatible Device (ADAT)

To connect a Lightpipe-compatible device (ADAT) to your 003 family interface:

1. Connect the Optical output on the ADAT to the Optical In port on the 003 family interface.

2. Connect the Optical input on the ADAT to the Optical Out port on the 003 family interface.

MIDI Connections

The MIDI ports on 003 family interfaces let you take advantage of all the MIDI features of Pro Tools LE, including recording and editing MIDI tracks.

If you need additional MIDI ports you can add a compatible MIDI interface (such as a MIDI I/O).

To connect your MIDI device to your 003 family interface:

1. Connect a standard 5-pin MIDI cable from the MIDI Out port of your device to the MIDI In port on the back panel of the 003 family interface.

2. Connect another MIDI cable from the MIDI In port of your device to one of the MIDI Out ports on the back panel of the 003 family interface.

💡 The MIDI Out port can be selected in Pro Tools or a supported third-party application.
Monitoring MIDI Instruments with 003 Family Interfaces

If you have a MIDI instrument that has analog outputs, you can connect it to your 003 family interface to monitor its output.

To connect your MIDI instrument for monitoring in Pro Tools:

1. Connect the MIDI instrument’s audio output to a Line/DI (003 Rack+) input, or to a DI or Analog Input on the back panel of the 003 or 003 Rack.

Using a Footswitch

The footswitch connector on your 003 family interface lets you use a footswitch pedal to control either playback start/stop or recording punch in/out. Both QuickPunch audio punch-in and punch-out and MIDI punch-in and punch-out recording are supported.

The footswitch connector is designed specifically for instantaneous (momentary) on/off pedals with a 1/4-inch TS connector. Continuous on/continuous off pedals can also be used, but may result in unexpected behavior.

To use a footswitch control:

1. Connect a footswitch to the footswitch connector on the back panel of the 003 family interface.
2. Launch Pro Tools.
3. Choose Setup > Hardware.
4. Select Record Punch In/Out or Playback Start/Stop.
5. Click OK.
chapter 11

Pro Tools Mode with 003

In Pro Tools mode, the 003 can be used as a control surface for your Pro Tools sessions.

003 is in this mode when the 003 unit is connected to a computer and Pro Tools LE software is running.

If Pro Tools is running and no Pro Tools session is open, the unit normally displays “Open or create a new session.” When a session is being launched, the display changes to “Loading a session.”

If no session is open and a Workspace browser is open and being used to audition an audio file, the unit displays “Working.”

When a Pro Tools session is open, the unit mirrors the on-screen controls. 003 faders, transport switches, rotary knobs, and switches control the corresponding elements in Pro Tools. You can also use 003 MIDI ports as you would those on a standard MIDI interface.

In Pro Tools mode, the Monitor section and MIDI I/O ports are available with a session open or closed.

To put 003 in Pro Tools mode:

1. Make sure the 003 unit is properly connected to the computer and powered on.
2. If Mute is disabled (unlit), enable Mute by pressing the Monitor Mute switch so that it is lit.
3. Launch Pro Tools LE and open or create a Pro Tools session.

Saving a Session

You can invoke the Save Session command from 003.

To save the current session:

1. Press the Save switch. The switch flashes to indicate that another press will result in a Save.
2. Do one of the following:
   • To save the session, press the Save switch a second time.
   – or –
   • To cancel the save, press the ESC switch.
## Working in Console View

Console View provides a global view of a given control type across the 003 (such as send A for the current bank of channels).

003 is in Console View when any of the Console View switches (Pan, Send, or Insert) is lit in the Console View section.

When you first open a Pro Tools session, the top row of the 003 is in Console View with the Pan switch enabled (lit). This default view is sometimes called the Home View.

In Console View, the touch-sensitive faders on 003 mirror the volume faders in Pro Tools. Fader assignments are shown on-screen in Pro Tools by blue outlines around the track names.

In Console View, the LED rings surrounding the rotary encoders indicate either the pan position, the send level, or the insert control level for each channel, depending on which Console View switch is enabled (lit).

There are three Console Views, based on their corresponding switch name: Pan View, Send View, and Insert View.

---

### Pan View Workflows

When the Pan switch is enabled (lit), 003 is in Pan View. This is the default View when you first open a Pro Tools session. In this view, you can use the rotary encoders to adjust pan on the current bank of tracks, select and rename tracks, and assign inputs or outputs in Assign mode.

For information on assigning inputs and outputs in Assign mode, see “Assigning Pro Tools Paths (Input, Output, Sends, Inserts)” on page 104.

To adjust a track’s panning controls:

1. Press the Pan switch to put 003 in Pan View.
2. Do one of the following:
   - If the track is a stereo track, toggle the Meter switch to Left or Right.
   - or –
   - If the track is a mono track, toggle the Meter switch to Left.
3. Adjust a channel’s panning by turning its rotary encoder.

### Selecting Tracks

To select a track:

1. Press the Pan switch to put 003 in Pan View.
2. Press a Channel Select switch that is unlit to select the track.

To select a range of tracks:

1. Press the Pan switch to put 003 in Pan View.
2. Press a Channel Select switch that is unlit to select the track.
3 Hold Shift (Add) and press the Channel Select switch for an unselected (unlit) track.

All tracks between the first track selected and the additional track will also be selected.

To remove subsequent tracks in range of selected tracks:
1 Press the Pan switch to put 003 in Pan View.
2 Hold Shift (Add) and press the Channel Select switch for a selected (lit) track in the middle (or beginning) of a range.

All tracks following the selected track will be deselected.

To select all tracks:
1 Press the Pan switch to put 003 in Pan View.
2 Hold Opt/Alt All and press the Channel Select switch for any unselected (unlit) track.

To deselect all tracks:
1 Press the Pan switch to put 003 in Pan View.
2 Hold Opt/Alt All and press the Channel Select switch for any selected (lit) track.

To select or deselect noncontiguous tracks:
1 Press the Pan switch to put 003 in Pan View.
2 Do one of the following:
   • In Pan View, hold Command/Ctrl and press the Channel Select switch for an unselected (unlit) tracks to select them.
   – or –
   • In Pan View, hold Command/Ctrl and press the Channel Select switch for any selected (lit) tracks to deselect them.

Renaming Tracks

To rename a track:
1 Press the Pan switch to put 003 in Pan View.
2 Double-press the Channel Select switch for the track you want to rename.
3 Enter the new name in the Track Name/Comments dialog.
4 Click Enter.

Send View Workflows

When the Send switch is enabled (lit), 003 is in Send View. In this view, you can adjust send level with the rotary encoders, toggle pre- and post-fader operation of sends, and assign sends in Assign mode.

For information on assigning sends in Assign mode, see “Assigning Pro Tools Paths (Input, Output, Sends, Inserts)” on page 104.

To display a Send position (A–J):
1 Press the Send switch to put 003 in Send View.
2 Press the Insert/Send Position switch that corresponds to the send position that you want to adjust. The five Console View switches are dual-function (A/F, B/G, C/H, D/I, E/J). Press the switch to toggle from the current send to the corresponding one (such as Send A to F or Send F to A).

To adjust send levels:
1 Press the Send switch to put 003 in Send View.
2 Press the Insert/Send Position switch (A/F, B/G, C/H, D/I, E/J) that corresponds to the send position that you want to adjust.
3 Adjust a channel's send level by turning its rotary encoder.
To toggle a send between pre- and post-fader operation:

1. Press the Send switch to put 003 in Send View.
2. Press the Channel Select switch under a send name to toggle its pre- and post-fader setting.

Insert View Workflows

When the Insert switch is enabled (lit), 003 is in Insert View. In this view, the LCD shows the names of currently-assigned inserts (hardware inserts or plug-ins) across all channel strips for a given insert position (Inserts A–J in Pro Tools).

If a hardware insert or plug-in is selected in Pro Tools, its name flashes in the LCD.

In this view, you can display inserts, plug-in controls, bypass plug-ins, and assign inserts in Assign mode.

For information on assigning inserts in Assign mode, see “Assigning Pro Tools Paths (Input, Output, Sends, Inserts)” on page 104.

Working with Inserts

To display the inserts on an Insert position (A–J):

1. Press the Insert switch (Console View section) to put 003 in Insert View.
2. Press the Insert/Send Position switch that corresponds to the insert position that you want to view. The five Console View switches are dual-function (A/F, B/G, C/H, D/I, E/J). Press the switch to toggle from the current insert to the corresponding one (such as Insert A to F or Insert F to A).

The names of inserts on that insert position are displayed in the LCD. (While the names of hardware I/O inserts are displayed, they have no editable parameters, so the Channel Select switches and the rotary encoders have no effect on them.)

To display the controls for a plug-in:

1. Press the Insert switch (Console View section) to put 003 in Insert View.
2. Press the Insert/Send Position switch that corresponds to the insert position that you want to view. The five Console View switches are dual-function (A/F, B/G, C/H, D/I, E/J). Press the switch to toggle from the current insert to the corresponding one (such as Insert A to F or Insert F to A).
3. Press the Channel Select switch under a plug-in name.

003 displays the plug-in’s controls across all channel strips. Controls are assigned to the rotary encoders. Switched controls (such as Master Bypass or Phase Invert) are controlled by Channel Select switches.

4. To display any additional pages of plug-in controls, press the Left and Right Page switches.

The Left or Right Page switch flashes when an additional page is available.

To bypass a plug-in:

1. Press the Insert switch (Console View section) to put 003 in Insert View.
2. Hold Command/Ctrl and press the Channel Select switch under the plug-in name.

The LCD screen displays the name of bypassed plug-ins in all capital letters.
Working in Channel View

Channel View provides a way to temporarily focus on all the plug-ins, inserts or sends on a single channel.

003 is in Channel View when any of the first four Channel View Select switches (EQ, Dynamics, Insert, or Pan/Send) is lit in the Channel View section.

- In Channel View, controls are displayed horizontally across the LCD and can be adjusted with the channel rotary encoders and switches. From this view, you can view and edit parameters for all the sends on a single track, or all the parameters of a single plug-in.

- In Channel View, the touch-sensitive faders on 003 mirror the volume faders in Pro Tools.

- In Channel View, the LED rings above the rotary encoders indicate values for the selected control, such as plug-in parameters, insert levels, or pan values and send levels, depending on which Channel View switch is lit.

EQ Plug-In Workflows in Channel View

When the EQ switch is enabled (lit), 003 identifies channels with equalizer plug-ins assigned to them by illuminating their Channel Select switches. If no EQ plug-ins are present for the current bank of channels, no Channel Select switches will be lit.

In this view, you can display the controls for EQ plug-ins across all channel strips.

To display all EQ plug-ins on a track:
- Press the EQ switch to put 003 in Channel View.

Dynamics Plug-In Workflows in Channel View

When the Dynamics switch is enabled (lit), 003 identifies channels with dynamics plug-ins (such as compressors or limiters) assigned to them by illuminating their Channel Select switches. If no dynamics plug-ins are present for the current bank of channels, no Channel Select switches will be lit.

In this view, you can display the controls for dynamics plug-ins across all channel strips.

To display all Dynamics plug-ins on a track:
- Press the Dynamics switch to put 003 in Channel View.

To display the controls for an EQ plug-in:
1. Press the EQ switch to put 003 in Channel View.
2. Press a lit Channel Select switch.

Controls for the first EQ plug-in on that track are assigned to the rotary encoders and displayed in the LCD. Switched controls (such as Master Bypass or Phase Invert) are controlled by Channel Select switches.

3. To display any additional pages of plug-in controls, press the Left and Right Page switches.

💡 The Left or Right Page switch flashes when an additional page is available.

To cycle through all the EQ plug-ins on a channel:
1. Press the EQ switch to put 003 in Channel View.
2. Hold the EQ switch and repeatedly press the track’s Channel Select switch.

If a plug-in window is open on-screen, it will update to reflect the plug-in selected on 003.
To display the controls for a Dynamics plug-in:

1. Press the Dynamics switch to put 003 in Channel View.

2. Press a lit Channel Select switch.

Controls for the first Dynamics plug-in on that track are assigned to the rotary encoders and displayed in the LCD. Switched controls (such as Master Bypass or Phase Invert) are controlled by Channel Select switches.

3. To display any additional pages of plug-in controls, press the Left and Right Page switches.

The Left or Right Page switch flashes when an additional page is available.

To cycle through all the Dynamics plug-ins on a channel:

1. Press the Dynamics switch to put 003 in Channel View.

2. Hold the Dynamics switch and repeatedly press the track’s Channel Select switch.

If a plug-in window is open on-screen, it will update to reflect the plug-in selected on the 003.

Insert Workflows in Channel View

When the Insert switch is enabled (lit), 003 identifies channels with any kind of insert assigned to them (software plug-ins or hardware I/O inserts) by illuminating their Channel Select switches. If no inserts are present for the current bank of channels, no Channel Select switches will be lit.

In this view, you can display inserts or plug-in controls, bypass plug-ins, and assign inserts in Assign mode.

For information on assigning inserts in Assign mode, see “Assigning Pro Tools Paths (Input, Output, Sends, Inserts)” on page 104.

To display the inserts on a track:

1. Press the Insert switch (Channel View section) to put 003 in Channel View.

2. Press a lit Channel Select switch.

3. Do one of the following:
   - To display Inserts A–E, press the Page Left switch.
   - or –
   - To display Inserts F–J, press the Page Right switch.

The names of the inserts are displayed in the LCD. (While the names of hardware I/O inserts are displayed, they have no editable parameters, so the Channel Select switches and the rotary encoders have no effect on them.)

To display the controls for a plug-in:

1. Press the Insert switch (Channel View section) to put 003 in Channel View.

2. Press a lit Channel Select switch to display the inserts for the corresponding track.

3. Do one of the following:
   - To display Inserts A–E, press the Page Left switch.
   - or –
   - To display Inserts F–J, press the Page Right switch.

4. Press the Channel Select switch under a plug-in name.
003 displays the plug-in controls across all channel strips. Controls are assigned to the rotary encoders. Switched controls (such as Master Bypass or Phase Invert) are controlled by Channel Select switches.

5 To display any additional pages of plug-in controls, press the Left and Right Page switches.

The Left or Right Page switch flashes when an additional page is available.

To cycle through all the inserts on a channel:
- Hold the Insert switch and repeatedly press the track’s Channel Select switch.

To bypass a single plug-in:
1 Press the Insert switch (Channel View section) to put 003 in Channel View.
2 Press a lit Channel Select switch to display the inserts for the corresponding track.
3 Do one of the following:
   - To display Inserts A–E, press the Page Left switch.
   - or –
   - To display Inserts F–J, press the Page Right switch.
4 Press the Channel Select switch under a plug-in name.
5 Press the Plug-In Master Bypass switch.

To bypass all plug-ins on a channel:
1 Press the Insert switch (Channel View section) to put 003 in Channel View.
2 Press a lit Channel Select switch to display the inserts for the corresponding track.
3 Press the Plug-In Master Bypass switch.

In mixed mode situations, where some plug-ins are bypassed and some are not, pressing the Master Bypass switch changes all plug-ins to bypassed. Press Master Bypass again to take all plug-ins out of bypass.

Hardware I/O inserts cannot be bypassed in Pro Tools, so the Plug-In Master Bypass switch has no effect on them.

Pan/Send Workflows in Channel View

When the Pan/Send switch is enabled (lit), 003 identifies channels with sends assigned to them by illuminating their Channel Select switches. If no sends are present for the current bank of channels, no Channel Select switches will be lit.

In this view, you can display sends, adjust send levels, and toggle pre- and post-fader operation.

To display the sends on a track:
1 Press the Pan/Send switch to put 003 in Channel View.
2 Press a lit Channel Select switch.
3 Do one of the following:
   - To display Sends A–E, press the Left Page switch.
   - or –
   - To display Sends F–J, press the Right Page switch.
4 Press the Channel Select switch under a plug-in name.
5 Press the Plug-In Master Bypass switch.

The LCD display for the first channel strip shows track pan position for that track. (If the track is a stereo track, you can toggle between left and right pan by pressing the Meter switch immediately to the right of the rotary encoders.)

The LCD display for channels 3–7 shows the send names. Their rotary encoders control the levels for the corresponding send.
The Channel Select switches on channels 3–7 toggle pre- and post-fader metering for the corresponding send.

**To adjust send levels for any of the sends on a single track:**

1. Press the Pan/Send switch in the Channel View switch section.
2. Press the Channel Select switch for the track with sends you want to view.
3. Adjust a channel's send level by turning its rotary encoder.

**To adjust pan levels on a track that has sends:**

1. Press the Pan/Send switch in the Channel View switch section.
2. Press the Channel Select switch for the track with sends that has panning you want to adjust.
3. Do one of the following:
   - If the track is a stereo track, toggle the Meter switch to Left or Right.
   - or –
   - If the track is a mono track, toggle the Meter switch to Left.
4. Adjust the track's panning by turning the rotary encoder in the first fader strip.

**To toggle a send between pre- and post-fader operation:**

1. Press the Pan/Send switch to put 003 in Channel View.
2. Press a lit Channel Select switch to display the sends for the corresponding track.
3. Press the Channel Select switch under a send name to toggle its pre- and post-fader setting.

---

### Display Options in Console and Channel View

#### Displaying Full Names of Tracks, Insert Parameters, and Other Elements

Track names and other parameters displayed on the lower row of the LCD are abbreviated to six characters. Full names can be temporarily displayed on the top row of the LCD.

**To display full names of tracks and insert parameters, do one of the following:**

- In Pan View, hold Display and press the Channel Select switch for the track whose name you want to see displayed fully. The name displays on the left side of the top row of the LCD display.
  - or –
- In Insert View, when editing plug-in parameters, hold Display and press the Channel Select switch for the parameter whose name you want to see displayed fully. The name displays on the far right side of the top row of the LCD display.

#### Displaying Settings Instead of Track or Control Names

The lower row of the LCD shows track or control names by default. The display can be changed to temporarily show settings, or be reset to always show settings. The Display Mode switch flashes during a temporary display or when the LCD default has been reset to always show settings.
Depending on the current Console or Channel View, you can display insert, plug-in, or pan/send settings.

See “Working in Console View” on page 94 and “Working in Channel View” on page 97 for information on the different Console and Channel Views.

In most temporary display views, faders and rotary encoders can be used to change settings as you are temporarily viewing them.

To reset the LCD display to show settings for all views instead of track or control names:

- Hold Command/Ctrl and press Display.

To return the LCD display to its default state (showing track or control names in all views):

- Press the flashing Display Mode switch.

To temporarily display fader level in the LCD (Console Pan View):

1. Press the Pan switch to put 003 in Pan View.
2. Hold the Display Mode switch. The lower row of the LCD shows fader levels for the current bank of channels (such as Channels 1–8).

   Fader levels can be adjusted with faders while the Display mode switch is pressed.

To temporarily display send level in the LCD (Console Send View):

1. Press the Send switch to put 003 in Send View.
2. Hold the Display Mode switch. The lower row of the LCD shows send level for the current bank of sends (such as Send A for Channels 1–8).

   Send levels can be adjusted with rotary encoders (or with faders in Flip mode) while the Display mode switch is pressed.

To temporarily display insert or plug-in parameters in the LCD (Console or Channel View):

1. Do one of the following:
   - Make sure the Insert switch is lit in the Console View section.
   - Make sure the EQ, Dynamics, Insert, or switch is lit in the Channel View section

2. Press Channel Select for the an insert or plug-in that you want to display.

3. Hold the Display Mode switch. The lower row of the LCD shows the insert or plug-in settings.

   Parameters with ranges can be adjusted with rotary encoders (or with faders in Flip mode) while the Display mode switch is pressed. Controls such as On/Off cannot be changed when the Display mode switch is pressed.

To temporarily display the channel pan setting and send levels in the LCD (Channel View):

1. Press the Pan/Send switch to put 003 in Channel View.
2. Press Channel Select for the channel with the pan and sends you want to display.
3. Hold the Display Mode switch. The lower row of the LCD shows the channel pan setting in the first fader strip and send levels for the currently-selected channel in fader strips 3–8.

   Pan settings and fader levels can be adjusted with rotary encoder while the Display mode switch is pressed.
Creating Custom Plug-In Maps

You can customize the arrangement of plug-in parameters on 003 and save them in customized plug-in maps.

Plug-In maps can be saved as presets and exported for use across different sessions and systems.

For complete information on creating and managing plug-in maps, see the Pro Tools Reference Guide.

Putting a Plug-In into Learn Mode

When you first put a plug-in into Learn mode, a new plug-in map is created (with the default name “Custom Map”), and the plug-in is focused on the control surface, but with a blank page of controls, ready for mapping.

Only one plug-in can be in Learn mode at a time.

To put a plug-in into Learn mode, do one of the following:

- Click the Learn button in the plug-in window.

- or –

- From the Map Options pop-up menu, choose New Map.

To take a plug-in out of Learn mode, do one of the following:

- Click the active Learn button in the plug-in window.

- Close the plug-in window.

- Click the Learn button in a different plug-in window.

Creating and Editing Plug-In Maps

To create a custom map of plug-in parameters:

1. Open the plug-in whose mapping you want to customize.

2. Put the plug-in into Learn mode. 003 displays a blank page of plug-in controls across all channel strips, ready for mapping.

3. In the plug-in window, click the plug-in parameter you want to map. The parameter name appears in the plug-in window Parameter menu.

4. If necessary, press the Page switches to reveal additional pages of controls on 003.

5. On 003, do one of the following:

   - Turn the encoder or press the channel Select switch where you want to map the parameter.

   - or –

   - If 003 is in Flip mode, touch the fader or press the channel Select switch where you want to map the parameter.

6. Repeat steps 3-5 for each parameter you want to map.

7. Take the plug-in out of Learn mode.

To change parameter mapping in a plug-in map:

1. Open the plug-in whose custom map you want to change.

2. Choose the map you want to change from the plug-in window Map Preset pop-up menu.

3. Put the plug-in into Learn mode. 003 displays the plug-in controls.

If you move a plug-in to a different insert position, or make it inactive, it is automatically taken out of Learn mode.
4 Do the following for each parameter mapping you want to change:
   • In the plug-in window, click the new plug-in parameter. The parameter name appears in the plug-in window Parameter menu.
   • On the control surface, page to the encoder or Select switch (or in Flip mode, fader) where you want to change the mapping, and turn the encoder, press the switch, or touch the fader.

5 Take the plug-in out of Learn mode.

To remove parameter mapping from a plug-in map:
1 Open the plug-in whose custom map you want to change.
2 Choose the map you want to change from the plug-in window Map Preset pop-up menu.
3 Put the plug-in into Learn mode. 003 displays the plug-in controls
4 Do the following for each parameter mapping you want to remove:
   • Make sure the Parameter menu displays No Control.
   • On the control surface, page to the encoder or Select switch (or in Flip mode, fader) where you want to remove the mapping, and turn the encoder, press the switch, or touch the fader.
5 Take the plug-in out of Learn mode.

Navigating and Editing Values in Entry Fields
You can navigate and edit numerical values in Pro Tools windows (such as Selection Start, End, and Length, or Pre- and Post-Roll in the Edit or Transport windows) with the Arrow keys.

To navigate between fields in the Edit window, Transport window, or a plug-in window:
  • Press the Left or Right Arrow key.

To change a value in a selected field:
  • Press the Up or Down Arrow key.

Working with Tracks
Navigating the New Track Dialog when Creating a New Track
You can navigate the New Tracks dialog with the Arrow keys.

To increase or decrease the number of tracks:
  • Press the Up or Down Arrow key.

To scroll through the track types:
  • Hold Command/Ctrl and press the Up or Down Arrow key.

To scroll through the track formats:
  • Hold Command/Ctrl and press the Left or Right Arrow keys.
Naming Tracks of Adding Track Comments

To open the Track Name/Comments dialog (to change a track’s name or comments):

- In Pan View, double-click the track’s Channel Select switch.

To close the Track Name/Comments dialog:

- In the Channel View section, press the ESC switch.

Navigating Track Name Field in the Track Name Dialog

You can move the cursor when you are naming tracks in the Track Name dialog.

To move the cursor while naming a track, do any of the following:

- Press the Left or Right Arrow key to move the cursor backward or forward through the name field.
- Press the Up or Down Arrow key to move the cursor to the beginning or end of the field.
- Hold Command/Ctrl and press the Up (or Left) or Down (or Right) Arrow key to move to the previous or next track name field.

Assigning Pro Tools Paths (Input, Output, Sends, Inserts)

Channel inputs, outputs, inserts, and sends can be assigned directly from the 003 in Assign mode.

Inputs and outputs are assigned in Pan View, sends are assigned in Send View, and inserts are assigned in Insert View.

Inputs and Outputs

To assign an input or output:

1. Press the Pan switch in the Console View section.

2. On the channel where you want to make the assignment, do one of the following:
   - To assign the output of a track, press its Channel Select switch for 2 seconds.
   - or –
   - To assign the input of a track, hold Shift and press the track’s Channel Select switch for 2 seconds.

The LCD changes to display the selected path and the Channel Select switch flashes.

3. If you are assigning a different input or output path type than the current type displayed on the LCD (such as a bus instead of an interface), do the following to select a new path type:
   - Hold Command/Ctrl and press the Channel Select switch to display the name of the current path type in the main menu. The main menu includes a dash (“–”) for no assignment, intrfc (interface), bus, and plug-in (inputs only).
   - Use the rotary encoder to scroll through the list of path types.
   - Press the flashing Channel Select switch to select the path type.

4. Use the rotary encoder to navigate through the available input or output paths in the submenu.
5 Do one of the following:
   • When the desired path is displayed, press the flashing Channel Select to confirm the assignment.

   **If you have multiple assignments in progress, hold Opt/Alt All and press any flashing Channel Select to save all assignments at once.**

   • Hold Command/Ctrl and press the Channel Select switch if you need to return to the previous menu level.
   • Press the flashing ESC switch to cancel the assignment.

**To remove an input or output:**

1 On the channel where you want to remove the assignment, do one of the following:
   • To remove the input of a track, hold Shift and press the track’s Channel Select switch for 2 seconds.
   – or –
   • To remove the output of a track, press its Channel Select switch for 2 seconds.

2 For the assignment you want to remove, hold Command/Ctrl and press the Channel Select switch the amount of times necessary to return to the main menu for assigning inputs or outputs. This menu includes a dash (“–”) for no assignment, intrfc (interface), and bus.

3 Turn the rotary encoder counter-clockwise until the dash (“–”) for no assignment is visible.

4 Do one of the following:
   • Press the flashing Channel Select switch to confirm the removal.
   – or –
   • Press the flashing ESC switch to cancel the removal and restore the assignment.

**Sends**

**To assign a send:**

1 Press the Send switch in the Console View section.

2 On the channel where you want to make the assignment, press its Channel Select switch for 2 seconds.

   The LCD changes to display the bus or output currently assigned to the selected send, and the Channel Select switch flashes.

3 If you are assigning a different send path type than the current type displayed on the LCD (such as a bus instead of an interface), do the following to select a new path type:
   • Hold Command/Ctrl and press the Channel Select switch to display the name of the current path type in the main menu. The main menu includes a dash (“–”) for no assignment, intrfc (interface), and bus.
   • Use the rotary encoder to navigate through the list of path types.
   • Press the flashing Channel Select switch to select the path type.

4 Use the rotary encoder to navigate through the available send paths in the submenu.

5 Do one of the following:
   • Press the flashing Channel Select to confirm the assignment.

   **If you have multiple assignments in progress, hold Opt/Alt All and press any flashing Channel Select to save all assignments at once.**

   • Hold Command/Ctrl and press the Channel Select switch if you need to return to the previous menu level.
   • Press the flashing ESC switch to cancel the assignment.
To remove a send:

1. On the channel where you want to remove the assignment, press its Channel Select switch for 2 seconds.

2. For the assignment you want to remove, hold Command/Ctrl and press the Channel Select switch the amount of times necessary to return to the main menu for assigning sends. This menu includes a dash ("–") for no assignment, intrfc (interface), and bus.

3. Turn the rotary encoder counter-clockwise until the dash ("–") for no assignment is visible.

4. Do one of the following:
   - Press the flashing Channel Select switch to confirm the removal.
   - or –
   - Press the flashing ESC switch to cancel the removal and restore the assignment.

Inserts

To assign an insert:

1. Press the Insert switch in the Console View section.

2. On the channel where you want to make the assignment, press its Channel Select switch for 2 seconds.

The LCD changes to display the plug-in or output currently assigned to the selected insert, and the Channel Select switch flashes.

3. If you are assigning a different insert path type than the current type displayed on the LCD, do the following to select a new path type:
   - Hold Command/Ctrl and press the Channel Select switch to display the name of the current path type in the main menu. The main menu includes a dash ("–") for no assignment, plugin (plug-in), and I/O.
   - Use the rotary encoder to navigate through the list of path types.
   - Press the flashing Channel Select switch to select the path type.

4. If you are assigning a plug-in insert, navigate down through the submenu levels as necessary.
   - Use the rotary encoder to navigate through the list of plug-in submenus.
   - Press the flashing Channel Select switch to select the submenu.
   - Repeat these steps if necessary, to navigate through additional plug-in submenu levels.

You can hold Command/Ctrl and press the Channel Select switch if you need to return to the previous menu level.

The types of plug-in submenus is determined by the Organize Plug-In Menus preference in Pro Tools. See the Pro Tools Reference Guide for more information.

5. When the desired submenu path is displayed, use the rotary encoder to navigate through the available insert paths in the menu.
6 Do one of the following:
- Press the flashing Channel Select to confirm the assignment.

If you have multiple assignments in progress, hold Opt/Alt All and press any flashing Channel Select to save all assignments at once.

- Hold Command/Ctrl and press the Channel Select switch if you need to return to the previous menu level.
- Press the flashing ESC switch to cancel the assignment.

To remove an insert:
1 On the channel where you want to remove the assignment, press its Channel Select switch for 2 seconds.
2 For the assignment you want to remove, hold Command/Ctrl and press the Channel Select switch the amount of times necessary to return to the main menu for assigning inserts. This menu includes a dash ("–") for no assignment, plugin (plug-in), and I/O.
3 Turn the rotary encoder counter-clockwise until the dash ("–") for no assignment is visible.
4 Do one of the following:
   - Press the flashing Channel Select switch to confirm the removal.
   - or –
   - Press the flashing ESC switch to cancel the removal and restore the assignment.

Working with Output Windows

Output windows for tracks and sends can be opened or closed, and the track output can be made active or inactive.

Track Output Windows

To open (or close) a track Output window:
1 Press the Pan switch to put 003 in Pan View.
2 Hold the Ctrl/Win switch and press the Channel Select switch for a track to open (or close) its Output window.

To open (or close) multiple track Output windows:
- In Pan View, hold Shift (Add)+Ctrl/Win and press the Channel Select switch for each track whose window you want to open (or close).

To make a track’s output inactive:
- In Pan View, hold Command/Ctrl+Ctrl/Win and press the Channel Select switch for a track to make it output inactive.

Send Output Windows

To toggle a send’s pre- and post-fader operation:
1 Press the Send switch to put 003 in Send View.
2 Press a Channel Select switch for the send whose pre- and post-fader setting you want to change. When you release the Channel Select switch, the LCD shows the new setting.

To mute or unmute a send:
1 Press the Send switch to put 003 in Send View.
2 Hold Command/Ctrl and press the Channel Select switch for a send on a track to mute or unmute it. When the send is muted, its name appears in all caps in the LCD.
To open (or close) a send's Output window:

1. Press the Send switch to put 003 in Send View.
2. Hold Ctrl/Win and press the Channel Select switch for a track to open (or close) its Output window.

To open (or close) multiple send Output windows:

1. Press the Send switch to put 003 in Send View.
2. Hold Shift (Add) and Ctrl/Win and press the Channel Select switch for each track whose window you want to open (or close).

**Navigating in the Edit Window**

**Zooming in the Edit Window**

You can zoom in or out in the Edit window, in order to increase or decrease the waveform or MIDI resolution.

To zoom in horizontally for all tracks:

1. Press the Zoom switch.
2. Press the Right Arrow key.

To zoom out horizontally for all tracks:

1. Press the Zoom switch.
2. Press the Left Arrow key.

To zoom in vertically for all tracks:

1. Press the Zoom switch.
2. Press the Up Arrow key.

To zoom out vertically for all tracks:

1. Press the Zoom switch.
2. Press the Down Arrow key.

To continuously zoom in or out horizontally for all tracks:

- Hold the Nudge switch and rotate the inner Jog wheel clockwise or counter-clockwise.

To continuously zoom in or out vertically for all tracks:

- Hold Shift (Add)+Opt/Alt (All)+Nudge and rotate the inner Jog wheel clockwise or counter-clockwise.

---

**Recording**

To enable or disable tracks for recording:

1. Press the Rec Arm switch so that it is enabled (flashing). When the Record Arm function is enabled, “Record Arm” is displayed in the top row of the LCD display.
2. Do one of the following:
   - To enable a track for recording, press the Channel Select switch for the track you want to enable for recording. When a track is armed for recording, its Channel Select switch flashes. During recording, its Channel Select switch is lit continuously.
   - or –
   - To disable a track for recording, press the Channel Select switch for the track you want to disable for recording.
3. To deactivate the Record Arm function, press the Record Arm switch a second time (or press the ESC switch).

Tracks that are armed for recording will remain armed after Rec Arming mode is disabled.
Navigating with the Shuttle/Jog Wheel

**Shuttle Mode**

To play forwards at a variable rate:
- Rotate the outer Shuttle ring clockwise.

To play backwards at a variable rate:
- Rotate the outer Shuttle ring counter-clockwise.

**Jog Mode**

To move the Transport (or cursor) forwards:
- Rotate the inner Jog wheel clockwise.

To move the Transport (or cursor) backwards:
- Rotate the inner Jog wheel counter-clockwise.

**Page Scrolling the Edit Window**

To scroll the Edit window one page at a time:

1. Press the Bank, Nudge, or Zoom switch.
2. Hold Command/Ctrl and press the Left or Right Arrow key.

**Moving the Cursor and Making Selections**

To move the cursor or Edit selection up or down one track:

1. Press the Bank or Nudge switch.
2. Press the Up or Down Arrow key.

To extend an Edit selection up or down one track:

1. Press the Bank or Nudge switch.
2. Hold Shift and press the Up or Down Arrow key.

**Setting Selection Start and End Points**

You can make a selection in the Edit window: during playback with the Arrow keys.

To make a selection while playing:

1. Make sure to select Options > Link Timeline and Edit Selection.
2. Click in the track near where you want to make the selection.
3. Start playback.
4. Press the Down Arrow key at the point where you want the selection to begin.
5. Press the Up Arrow key at the point where you want the selection to end.

**General Editing**

**Setting Track Controls to Defaults**

The Default switch is used to reset a fader (or fader-mapped plug-in parameter) to its default setting.

To set a channel’s fader or plug-in parameter to its default setting:
- Hold the Default switch and press the Channel Select switch on a track.

To set all channel faders or plug-in parameters to their default settings:
- Hold the Default and Opt/Alt (All) switches and press the Channel Select switch on a track.
Undoing Pro Tools Operations

You can undo Pro Tools operations from 003. (See the Pro Tools Reference Guide for details on multiple undo capabilities.)

To undo an action:
- Press the Undo switch.

To redo an action:
- Hold Shift (Add) and Command/Ctrl and press the Undo switch.

Working With Memory Locations

Pro Tools Memory Locations (Markers) can be created directly from 003 during playback or while the Transport is stopped.

To create a Memory Location:
1. Cue Pro Tools to the desired location, or begin playback.
2. At the desired location, press Enter (located among the switches above and to the left of the Navigation keys).
3. Use the mouse to configure the Memory Location dialog on-screen.
4. Press Enter again to save, or press Undo to cancel.

To open (or close) the Memory Location window:
- Hold Shift (Add) and press the Mem Loc switch.

To display Memory Locations:
1. Press the Mem Loc switch.

When the switch is enabled (flashing), the LCD shows the first eight Memory Locations in the bottom row of the LCD display.

2. To display any additional pages of Memory Locations, press the Left and Right Page switches.

   The Left or Right Page switch flashes when an additional page is available.

To recall a Memory Location:
1. Press the Mem Loc switch to display Memory Locations in the LCD display.
2. To display any additional pages of Memory Locations, press the Left and Right Page switches.
3. Do one of the following:
   - Press the Channel Select switch that corresponds to the Memory Location.
   - Or –
   - To return to the previous view without selecting a Memory Location, press Mem Loc again, or any of the Console or Channel View switches.

Controlling Track Display on the Control Surface

Using Flip Mode

In Flip mode, control assignments are transferred from the rotary encoders to the corresponding channel faders.

To transfer controls from the rotary encoders to the touch-sensitive faders:
- Press the Flip switch. This switch flashes when Flip mode is activated.
To exit Flip mode (and transfer controls from faders back to the rotary encoders):

- While in Flip mode, press the Flip switch.

**Flip Mode Views**

There are several types of Flip mode, depending on the view.

**Send Flip Mode** When you are in Console Send View, the Flip switch moves the send level controls to the channel faders, and the send pan controls to the rotary encoders. The LCD shows the selected send (A–E, or F–J) for each channel.

In addition, the Mute switch controls Send mute, whereas the Solo switch continues to control the track’s output muting and the Select switch continues to control Send Pre/Post status.

For mono tracks with stereo sends, only the left pan indicator shows a pan position; the right pan indicator is inactive.

For stereo tracks with stereo sends, you can control either the left or right send pan from the rotary encoder.

**To assign a stereo send channel to a rotary encoder:**

- While in Send Flip mode, press the Meter switch immediately to the right of the rotary encoders and select Left or Right.

Both the LCD and the Meter Mode LEDs indicate whether the left or right pan position is displayed. The rotary encoder LEDs show pan positioning.

**Plug-In Flip Mode** When you are in Channel View (or Console Insert View) and working with a plug-in insert, the Flip switch moves any plug-in control assignments from the rotary encoders to the faders, allowing you to use the touch-sensitive faders to edit and automate plug-in control values. The types of plug-in controls depend on the particular plug-in you are using.

See “Working in Channel View” on page 97 for more details on working with pan controls and sends in Channel View.

**Pan/Send Flip Mode** When you are in Channel View and working with the pan and send assignments on a channel, the Flip switch moves the send level controls to channel faders 3–7, and the send pan controls to rotary encoders 3–7. (The first Channel’s LCD display and rotary encoder continue to show track pan position for that track.)

In this mode, the Channel Select switches toggle pre- and post-fader metering for the corresponding send.

For stereo tracks with stereo sends, you can control either the left or right send pan from the rotary encoder. See “Send Flip Mode” on page 111.

**Banking Channels on 003**

**To move the display of tracks on 003 forward or backward eight channels at a time:**

1. Press the Bank switch.
2. Press the Left or Right Arrow key.

**To move the display of tracks on 003 forward or backward one channel at a time:**

1. Press the Nudge switch.
2. Press the Left or Right Arrow key.

**To scroll the display of tracks on 003 forwards**

- Hold the Nudge switch and rotate the inner Jog wheel clockwise to scroll tracks to subsequent faders.
To scroll the display of tracks on 003 backwards:

- Hold the Nudge switch and rotate the inner Jog wheel counter-clockwise to scroll tracks to previous faders.

**Banking Master Faders**

To bank all Master Fader tracks in the current session to the right-hand side of the control surface:

- Press the Mstr Fader switch so that its LED is flashing.

To return the control surface to the previous view:

- Press the Mstr Fader switch so that its LED is unlit.

**Muting Fader Movement**

Because 003 faders are motorized, they move to follow automation when playing back and recording (when the track is set to an automation read or write mode, and not Off). During critical listening passes, the sound of the fader motors and their automated movements may be distracting. You can temporarily shut off (or mute) motorized fader movement using the Fader Mute switch.

To mute fader movement:

- Press the Fader Mute switch so that its LED is flashing.

To unmute fader movement:

- Press the Fader Mute switch so that its LED is unlit.

---

**Working with Automation**

The Automation mode can be set from 003 for a single track, all selected tracks, or all tracks in the session. You can also suspend automation globally.

To set the Automation Mode for a single track:

- Hold an Automation Mode switch and press the Channel Select switch on a track.

To set the Automation Mode for all tracks

- Hold the Option/Alt All and press an Automation Mode switch.

To set the Automation Mode for all selected tracks

- Hold the Option/Alt (All)+Shift (Add) and press an Automation Mode switch.

To suspend automation for all tracks:

- Press the Suspend switch.

To return all tracks to their previous Automation modes, press the Suspend switch again.
# 003 Top Panel Shortcuts

003 provides shortcuts for many common 003 tasks in Pro Tools mode.

## Display Options

### Display Options Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display full name of a track in top LCD row (Pan mode)</td>
<td>Hold Display and press Channel Select switch for a track</td>
</tr>
<tr>
<td>Display full name of insert parameter (Insert View, Plug-In Edit mode)</td>
<td>Hold Display and press Channel Select switch for an insert</td>
</tr>
<tr>
<td>Reset lower row of LCD display to show fader values (Pan View), send gain levels (Send View), and pan and send levels (Pan/Send Channel View)</td>
<td>Command/Ctrl+Display</td>
</tr>
</tbody>
</table>

## Track Shortcuts

### Track Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select or deselect contiguous tracks (Home View or Pan View)</td>
<td>Hold Shift (Add) and press Channel Select switch for each track</td>
</tr>
<tr>
<td>Select or deselect all tracks (Home View or Pan View)</td>
<td>Hold Alt and press Channel Select switch for any track</td>
</tr>
<tr>
<td>Select or deselect noncontiguous tracks (Pan View)</td>
<td>Hold Command/Ctrl and press Channel Select switch for each track</td>
</tr>
<tr>
<td>Open track’s Track Name/Comments dialog (Home View or Pan View)</td>
<td>Double-click track’s Channel Select switch</td>
</tr>
<tr>
<td>Scroll track types in New Track dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Up or Down Arrow key</td>
</tr>
<tr>
<td>Scroll track formats in New Track dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Left or Right Arrow key</td>
</tr>
<tr>
<td>Move to previous track in Track Name/Comments dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Up or Left Arrow key</td>
</tr>
</tbody>
</table>
### Track Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to next track in Track Name/Comments dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Down or Right Arrow key</td>
</tr>
<tr>
<td>Scroll Timebase formats in New Track dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Ctrl/Win+Opt/Alt All+Up or Down Arrow key</td>
</tr>
<tr>
<td>Add or Remove entries in New Track dialog (Bank, Nudge, or Zoom mode)</td>
<td>Command/Ctrl+Shift (Add)+Up or Down Arrow key</td>
</tr>
<tr>
<td>Make track’s output inactive or active (Pan View)</td>
<td>Hold Command/Ctrl+Ctrl/Win and press Channel Select switch for a track</td>
</tr>
<tr>
<td>Mute or unmute send (Send View)</td>
<td>Hold Command/Ctrl and press Channel Select switch for a track send</td>
</tr>
<tr>
<td>Make send output inactive or active (Pan View)</td>
<td>Hold Command/Ctrl+Ctrl/Win and press Channel Select switch for a track send</td>
</tr>
</tbody>
</table>

### Input Assign Mode Shortcuts

**Input Assign Mode Shortcuts**

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Input Assign mode</td>
<td>Hold Shift and press Channel Select switch of a track for two seconds</td>
</tr>
<tr>
<td>Display all input, output, send, or insert menus (Assign mode)</td>
<td>Hold Command/Ctrl and press Channel Select switch for a track</td>
</tr>
<tr>
<td>Remove an insert (Console or Channel Insert View, and if applicable, EQ or Dynamics View)</td>
<td>Hold Default and press Channel Select switch for an insert</td>
</tr>
</tbody>
</table>

### Output Window Shortcuts

**Output Window Shortcuts**

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open or close track Output window (Pan View)</td>
<td>Hold Ctrl/Win and press Channel Select switch for a track</td>
</tr>
<tr>
<td>Open or close multiple track Output windows (Pan View)</td>
<td>Hold Ctrl/Win+Shift (Add) and press Channel Select switch for each track</td>
</tr>
</tbody>
</table>
### Output Window Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open or close send Output window (Send View)</td>
<td>Hold Ctrl/Win and press Channel Select switch for a track send</td>
</tr>
<tr>
<td>Open or close multiple send Output windows</td>
<td>Hold Ctrl/Win+Shift (Add) and press Channel Select switch for each track send</td>
</tr>
<tr>
<td>(Pan View)</td>
<td></td>
</tr>
</tbody>
</table>

### Plug-In Shortcuts

**Plug-In Shortcuts**

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open or close a plug-in window (Console or</td>
<td>Hold Ctrl/Win and press Channel Select switch for a plug-in</td>
</tr>
<tr>
<td>Channel Insert View)</td>
<td></td>
</tr>
<tr>
<td>Inactivate or activate a plug-in (Console or</td>
<td>Hold Command/Ctrl and press Channel Select switch for a plug-in</td>
</tr>
<tr>
<td>Channel Insert View)</td>
<td></td>
</tr>
<tr>
<td>Bypass or unbypass plug-in (Console or Channel</td>
<td>Hold Command/Ctrl and press Channel Select switch for a track plug-in</td>
</tr>
<tr>
<td>Insert View, and if applicable, EQ or Dynamics</td>
<td></td>
</tr>
<tr>
<td>View)</td>
<td></td>
</tr>
</tbody>
</table>

### Navigation Shortcuts

**Navigation Shortcuts**

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll Edit window one pane at a time (Bank,</td>
<td>Command/Ctrl+ Left or Right Arrow key</td>
</tr>
<tr>
<td>Nudge, or Zoom mode)</td>
<td></td>
</tr>
</tbody>
</table>

### Editing Shortcuts

**Editing Shortcuts**

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extend cursor or selection (Bank or Nudge mode)</td>
<td>Shift (Add)+Up or Down Arrow key</td>
</tr>
<tr>
<td>Reset fader to is default setting</td>
<td>Hold Default and press Channel Select switch for a track</td>
</tr>
</tbody>
</table>
### Editing Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset all faders or plug-in parameters to their factory default settings (Plug-In Edit mode)</td>
<td>Hold Default+Opt/Alt All and press Channel Select switch for a track or plug-in</td>
</tr>
<tr>
<td>Redo an edit (Edit &gt; Redo in Pro Tools)</td>
<td>Command/Ctrl+Shift (Add)+Undo</td>
</tr>
</tbody>
</table>

### Memory Location Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose a Marker Memory Location</td>
<td>Hold Mem Loc switch and press Channel Select for a Memory Location</td>
</tr>
<tr>
<td>Open or close the Marker Memory Location dialog</td>
<td>Shift+Mem Loc</td>
</tr>
</tbody>
</table>

### Automation Shortcuts

<table>
<thead>
<tr>
<th>Task</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Automation mode for a track</td>
<td>Hold Automation switch (Write, Touch, Latch, Read, or Off) and press Channel Select track</td>
</tr>
<tr>
<td>Set Automation mode for all tracks</td>
<td>Hold Option/Alt All and press Automation switch (Write, Touch, Latch, Read, or Off)</td>
</tr>
<tr>
<td>Set Automation mode for all selected tracks</td>
<td>Hold Option/Alt All+Shift (Add) and press Automation switch (Write, Touch, Latch, Read, or Off)</td>
</tr>
</tbody>
</table>
Overview of MIDI Mode

In MIDI mode, 003 can control hardware MIDI devices and software other than Pro Tools. Each of 003’s faders, rotary encoders, and 45 of its switches and the footswitch can be custom programmed to send control data on any continuous controller (0–127) and MIDI channel (1–16). 003 switches can also send MIDI Machine Control (MMC) transport control messages (RW, FF, ST, PL, and RC).

Two banks (A and B), each with four presets (1–4), are provided so that you can recall up to eight unique MIDI maps. Each preset can save custom maps of two pages of supported controls. 003 provides the following default preset maps:

- Standard MIDI Map (MIDI Map A and B, preset 1)
- 003 Map (MIDI Map A and B, preset 2)
- Strike Map (MIDI Map A and B, preset 3)
- Uninitialized Preset (MIDI Map A and B, preset 4)

MIDI mode can be used in different ways, depending on which other 003 operating mode is active when MIDI mode is enabled, as follows:

Pro Tools Mode Use MIDI mode to control a ReWire application (such as Propellerhead’s Reason), stand-alone software instrument, or external MIDI device.

Third-Party Software Mode Use MIDI mode to control your third-party audio application (using a driver such as the Avid CoreAudio Driver on Mac).

When using MIDI mode with a third-party application, route the third-party application’s output to ASIO or CoreAudio and make any changes to the Pro Tools Playback Engine before enabling MIDI mode.

Standby Mode Use MIDI mode to control an external MIDI device.

⚠️ ReWire-client applications (such as Reason) on Windows will not recognize 003 as a MIDI device (port) while Pro Tools is running. Consequently, to use a ReWire client’s “learn” MIDI controller function, you must quit Pro Tools, launch the ReWire-client application as a stand-alone application, and then “learn” 003 controllers. The next time you launch the ReWire-client application with Pro Tools, you can successfully use 003 MIDI mode to control the “learned” parameters in the ReWire-client application.
Selecting MIDI Mode

To select MIDI mode, do one of the following:

- Press the unlit MIDI Map A switch for the MIDI Map A presets (A1–4).

  – or –

- Press the unlit MIDI Map B switch for the MIDI Map B presets (B1–4).

When in MIDI mode, the switch LED lights for the selected MIDI Map: A or B.

The last saved (or default) MIDI map is recalled.

To exit MIDI mode:

- Press the lit MIDI Map switch (A or B).

If you edited a MIDI Map preset without saving, you are prompted to save your changes (see “Saving MIDI Map Presets” on page 123).

About Preset Pages

Each 003 MIDI Map preset includes two pages of unique assignments for each mappable fader, rotary encoder, and switch.

For example, the channel 1 fader can be assigned to continuous controller 21 on MIDI channel 1 on page 1 and to continuous controller 37 on MIDI channel 10 on page 2 of the same preset. This lets you use the same controller for two completely different mappings within the same preset.

However, you will typically want to use the same control for related functions (such as using the faders to control volume on MIDI channels 1–8 on page 1 and on MIDI channels 9–16 on page 2).

To switch between pages of a preset:

- In MIDI mode, press the Bank switch. The Bank switch LED is lit when on page 2 and not lit when on page 1 of a preset.
Recalling MIDI Map Presets

To recall a MIDI Map preset (A1–4 or B1–4) from flash memory:

1. Press either the MIDI Map A switch or the MIDI Map B switch.

2. Press MIDI Recall. The MIDI Recall switch LED flashes.

The LCD display for the first two channel strips show the number and name of the current MIDI Map preset.

The LCD display for channels 6–8 show three MIDI mode commands: Recall, Save, and Cancel. The commands are selected by pressing the corresponding switches in the Channel View section.

3. Scroll through the available presets using the rotary encoder 1.

4. To select the displayed preset, select Recall by pressing the Page Right switch.

5. To recall the selected preset from Flash memory, select Flash by pressing the Dynamics switch.

6. Do one of the following:
   - To confirm and load the preset, select OK by pressing the Master Bypass switch (Master Bypass).
   - or –
   - To cancel without loading the preset, select Cancel by pressing the ESC switch.

   For information on editing preset MIDI maps, see “Editing MIDI Map Presets” on page 121.

   For information on naming and saving presets, see “Naming MIDI Map Presets” on page 123 and “Saving MIDI Map Presets” on page 123.

To exit MIDI Recall mode:

- Press the flashing MIDI Recall switch. 003 exits MIDI Recall mode and the switch LED stops flashing.
Mapping Controls

003 faders, rotary encoders, and switches can be assigned, or mapped, to MIDI continuous controllers (CC) and MIDI channels. As many as eight presets (A1–4 and B1–4) can store unique, custom MIDI maps, each with two pages of unique MIDI assignments for each control.

Assignable Controls in MIDI Mode

Faders

Each fader can be mapped to No Assign or any MIDI continuous controller (CC) and MIDI channel. Minimum and maximum MIDI values, as well as custom names, can be specified for each fader.

Rotary Encoders

Each rotary encoder can be mapped to No Assign or any MIDI continuous controller (CC) and MIDI channel. Minimum and maximum MIDI values, as well as custom names, can be specified for each rotary encoder.

Switches

Up to 45 switches and the footswitch on 003 can be mapped to No Assign or any MIDI continuous controller (CC) and MIDI channel. Switches can also be set to MMC transport control messages (Rewind, Fast Forward, Stop, Play, and Record). Custom names can be specified for each switch.

Switches can be set to Momentary or Latch mode (see “Momentary or Latch Mode” on page 122).

The following switches are assignable controls:
- Channel Mute switches
- Channel Solo switches
- Channel View switches

Channel View switches are also used to navigate, select, and save MIDI mode presets.

Assignable Controls in MIDI Mode

- Console View switches

- Record Arm switch
- Arrow keys

Transport controls are mapped to standard MIDI Machine Control (MMC) messages (RW, FF, ST, PL, and RC) by default, but can be re-assigned to any CC number.

- Footswitch
The following controls are not assignable in MIDI mode:

- Mic/DI Input controls
- Monitor section controls
- Miscellaneous controls
- Automation section switches
- Modifier section switches

💡 **Though the Mic/DI Input controls and the Monitor section controls are not assignable in MIDI mode, they continue to function for audio independently of MIDI mode.**

## Editing MIDI Map Presets

This section provides instructions for editing MIDI controller assignments (mapping) for 003 faders, rotary encoders, and switches.

💡 Custom mappings can be saved as presets. Presets can be created, named, and saved before editing controller mappings.

### To enter MIDI Edit mode:

1. Select the MIDI Map you want to edit (see “Recalling MIDI Map Presets” on page 119).
2. Press the MIDI Edit switch.

### MIDI Edit switch

The switch’s LED flashes, and the LCD display shows parameters similar to the following tables (which show default assignments for Fader 1 as an example):

#### MIDI Edit display, channels 1–4 (Fader 1 example)

<table>
<thead>
<tr>
<th>ch 1</th>
<th>ch 2</th>
<th>ch 3</th>
<th>ch 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td>ctrl</td>
<td>Chan</td>
<td>CC</td>
</tr>
<tr>
<td>Fader1</td>
<td>1</td>
<td>7</td>
<td></td>
</tr>
</tbody>
</table>

- The currently selected control (Fader 1 by default or the last edited control) is shown in the lower row of channel 1.
- Channel 3 shows the assigned MIDI Channel in the lower row.
- Channel 4 shows the assigned CC value in the lower row.

#### MIDI Edit display, channels 5–8 (Fader 1 example)

<table>
<thead>
<tr>
<th>ch 5</th>
<th>ch 6</th>
<th>ch 7</th>
<th>ch 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoVal</td>
<td>HiVal</td>
<td>Mode</td>
<td>Name</td>
</tr>
<tr>
<td>0</td>
<td>127</td>
<td></td>
<td>Fader1</td>
</tr>
</tbody>
</table>

- The upper row shows the available parameter names for (MIDI) LoVal, HiVal, Mode, and Name.
- The lower row shows the current value (1–127) for LoVal, HiVal, Mode (for switches only), and the current control name (for example, Fader1).

### To select a control for MIDI Mapping, do one of the following:

- To scroll through the list of available controls, turn the rotary encoder for channel 1.
  - or –
- Touch the fader or switch that you want to edit.

⚠️ **Rotary encoders can only be selected by turning the rotary encoder for channel 1.**
To set the MIDI channel:
- Turn the rotary encoder for channel 3 (Chan) until the channel you want is displayed (1–16).

To set the CC#:
- Turn the rotary encoder for channel 4 (CC#) until the CC value you want is displayed (0–127).

Any control can be set to no assignment ("No Asgn") by turning the encoder below 0.

For switches, turn the rotary encoder past 127 to select MMC transport control messages: Rewind, Fast Forward, Stop, Play, and Record (RW, FF, ST, PL, and RC).

To set the High and Low MIDI values (controller range):
1. Turn the rotary encoder for channel 5 to set a Minimum MIDI Value (0–127).
2. Turn the rotary encoder for channel 6 to set a Maximum MIDI Value (0–127).

To name a control:
1. Select the control you want to name.
2. Turn the rotary encoder for channel 8 (Name). This displays the Name parameters in the LCD.
3. Turn the rotary encoder for channel 2 to scroll and select lower-case, upper-case, or numerics for the first character of the custom name.
4. When the desired character is displayed, turn the rotary encoder for channel 1 to move to the next character. The cursor flashes for the selected character.
5. Repeat steps 3–4 for the remaining characters of the control name.

6. When you are done, do one of the following:
   - To confirm the new control name, select OK by pressing the Master Bypass switch.
   - or –
   - To cancel without renaming the control, select Cancel by pressing the ESC switch.

To exit MIDI Edit mode:
- Press the flashing MIDI Edit switch. The MIDI Edit switch LED stops flashing.

You must manually save changes to MIDI Map presets. If you do not, your changes will be lost when you recall a different MIDI Map preset or power off 003. For information on saving presets, see “Saving MIDI Map Presets” on page 123.

Momentary or Latch Mode

Switches can be set to Momentary or Latch mode.

**Momentary Mode** The specified High MIDI Value (HiVal) is transmitted when the switch is pressed, and the specified Low MIDI Value (LoVal) is transmitted when the switch is released.

**Latch Mode** The output of the switch toggles between the specified High and Low MIDI values when pressed.

To program a switch for Momentary or Latch mode:
1. Enter MIDI Edit mode.
2. Select the switch you want to edit.
3. Turn the rotary encoder for channel 7 (Mode) to select Latch or Momnt (momentary).
**Naming MIDI Map Presets**

MIDI Map presets can have custom names of up to 28 characters. This makes it easier to manage multiple presets for different devices.

**To name a MIDI Map preset:**

1. Press the MIDI Map preset switch.
2. Select the MIDI Map preset you want to name.
3. Select the Preset Name by pressing the Dynamics switch.
4. Turn the rotary encoder for channel 2 to scroll and select lower-case, upper-case, or numerics for the first character of the custom name.
5. When the desired character is displayed, turn the rotary encoder for channel 1 to move to the next character (its cursor flashes).
6. Repeat steps 4–5 for the remaining characters of the preset name.
7. When you are done, do one of the following:
   - To confirm the new preset name, select OK by pressing the Master Bypass switch.
   - To cancel without naming the preset, select Cancel by pressing the ESC switch.
8. Save the MIDI Map preset.

**Saving MIDI Map Presets**

Presets are snapshots of MIDI mapping assignments that can be saved and recalled. You can store up to eight presets (A1–4 and B1–4) to save custom CC mapping and MIDI channel assignment for a variety of devices, with custom names. Presets can be recalled at any time to switch to a different MIDI mapping.

Every preset contains two pages: one active and one inactive. When you save a preset, changes made to either page are saved.

003 presets can be saved to flash memory to save custom mapping of programmable controls, custom names, and all other parameters associated with MIDI Map presets.

*Edited presets must be manually saved to flash memory to be able to be recalled later. 003 warns you to save any changed presets before you exit MIDI mode, but it does not automatically save presets as you edit them.*

**To save presets:**

1. Press the MIDI Recall switch. The MIDI Recall switch LED flashes.
2. Do one of the following:
   - Select Save by pressing the Master Bypass switch. If a preset has been edited, the LCD displays asterisks (**) before and after “SAVE.”
   - To cancel, select Cancel by pressing the ESC switch.

---

Chapter 12: Using MIDI Mode with 003  123
3 Do one of the following:
   • To confirm and save the preset, select OK by pressing the Master Bypass switch.
   – or –
   • To cancel without saving the preset, select Cancel by pressing the ESC switch.

Factory Default

003 lets you reset any preset to its factory default setting (see “Factory Presets” on page 124).

Recalling the default preset overwrites the preset stored in flash memory. To be able to recall the preset currently stored in flash memory, you must save it to a different preset than the one you for which you want to recall the default. For example, if you want to recall the default preset for A1, save the currently loaded preset to A4 first.

To reset a MIDI Map preset to its factory default setting:

1 Enter MIDI mode.
2 Press the MIDI Recall switch. The MIDI Recall switch LED flashes.
3 Select the MIDI Map preset you want to reset.
4 Select Recall by pressing the Page Right switch.
5 Select Default by pressing the flashing Insert switch. The Insert switch lights solid.
6 Do one of the following:
   • Select OK by pressing the Master Bypass switch. The selected MIDI Map preset is overwritten by its default preset.
   – or –
   • To cancel without overwriting flash memory and the selected preset with its factory default preset, select Cancel by pressing the ESC switch.

Factory Presets

003 comes with factory presets saved in flash memory. Presets A1–4 and B1–4 provide factory preset MIDI Maps for the following:

Standard MIDI Map Use this preset for standard MIDI controller mappings (for example, with a third-party application). See Table 13 on page 125.

003 Map Use this preset to control a ReWire client (such as Reason). See Table 14 on page 131.

Strike Map Use this preset to control Avid’s Strike plug-in. See Table 15 on page 137.

Uninitialized Preset Use this preset as a starting point for your own custom mappings. All mappable 003 controls are unassigned.
### Standard MIDI Map Preset

*Table 13. Default Standard MIDI Map, presets A1 and B1*

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQ1</td>
<td>1</td>
<td>122</td>
<td>Latch</td>
<td>Local</td>
<td>0–127</td>
</tr>
<tr>
<td>Dynmcs1</td>
<td>1</td>
<td>123</td>
<td>Latch</td>
<td>AllOff</td>
<td>0–127</td>
</tr>
<tr>
<td>Insert1</td>
<td>1</td>
<td>124</td>
<td>Latch</td>
<td>OmniOn</td>
<td>0–127</td>
</tr>
<tr>
<td>PanSnd1</td>
<td>1</td>
<td>125</td>
<td>Latch</td>
<td>OmniOff</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &lt;1</td>
<td>1</td>
<td>126</td>
<td>Latch</td>
<td>MonoOn</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &gt;1</td>
<td>1</td>
<td>127</td>
<td>Latch</td>
<td>PolyOn</td>
<td>0–127</td>
</tr>
<tr>
<td>MstByp1</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>MstByp</td>
<td>N/A</td>
</tr>
<tr>
<td>Esc1</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Esc</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct 1</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 1</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct 2</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 2</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct 3</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 3</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct 4</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 4</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct 5</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 5</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct 6</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 6</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct 7</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 7</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct 8</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 8</td>
<td>N/A</td>
</tr>
<tr>
<td>Solo 1</td>
<td>1</td>
<td>15</td>
<td>Latch</td>
<td>Solo 1</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 2</td>
<td>2</td>
<td>15</td>
<td>Latch</td>
<td>Solo 2</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 3</td>
<td>3</td>
<td>15</td>
<td>Latch</td>
<td>Solo 3</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 4</td>
<td>4</td>
<td>15</td>
<td>Latch</td>
<td>Solo 4</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 5</td>
<td>5</td>
<td>15</td>
<td>Latch</td>
<td>Solo 5</td>
<td>0–127</td>
</tr>
</tbody>
</table>
Table 13. Default Standard MIDI Map, presets A1 and B1

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solo 6</td>
<td>6</td>
<td>15</td>
<td>Latch</td>
<td>Solo 6</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 7</td>
<td>7</td>
<td>15</td>
<td>Latch</td>
<td>Solo 7</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 8</td>
<td>8</td>
<td>15</td>
<td>Latch</td>
<td>Solo 8</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 1</td>
<td>1</td>
<td>14</td>
<td>Latch</td>
<td>Mute 1</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 2</td>
<td>2</td>
<td>14</td>
<td>Latch</td>
<td>Mute 2</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 3</td>
<td>3</td>
<td>14</td>
<td>Latch</td>
<td>Mute 3</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 4</td>
<td>4</td>
<td>14</td>
<td>Latch</td>
<td>Mute 4</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 5</td>
<td>5</td>
<td>14</td>
<td>Latch</td>
<td>Mute 5</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 6</td>
<td>6</td>
<td>14</td>
<td>Latch</td>
<td>Mute 6</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 7</td>
<td>7</td>
<td>14</td>
<td>Latch</td>
<td>Mute 7</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 8</td>
<td>8</td>
<td>14</td>
<td>Latch</td>
<td>Mute 8</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr1</td>
<td>1</td>
<td>10</td>
<td>N/A</td>
<td>Encdr1</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr2</td>
<td>2</td>
<td>10</td>
<td>N/A</td>
<td>Encdr2</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr3</td>
<td>3</td>
<td>10</td>
<td>N/A</td>
<td>Encdr3</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr4</td>
<td>4</td>
<td>10</td>
<td>N/A</td>
<td>Encdr4</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr5</td>
<td>5</td>
<td>10</td>
<td>N/A</td>
<td>Encdr5</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr6</td>
<td>6</td>
<td>10</td>
<td>N/A</td>
<td>Encdr6</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr7</td>
<td>7</td>
<td>10</td>
<td>N/A</td>
<td>Encdr7</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr8</td>
<td>8</td>
<td>10</td>
<td>N/A</td>
<td>Encdr8</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader1</td>
<td>1</td>
<td>7</td>
<td>N/A</td>
<td>Fader1</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader2</td>
<td>2</td>
<td>7</td>
<td>N/A</td>
<td>Fader2</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader3</td>
<td>3</td>
<td>7</td>
<td>N/A</td>
<td>Fader3</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader4</td>
<td>4</td>
<td>7</td>
<td>N/A</td>
<td>Fader4</td>
<td>0–127</td>
</tr>
</tbody>
</table>
Table 13. Default Standard MIDI Map, presets A1 and B1

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fader5</td>
<td>5</td>
<td>7</td>
<td>N/A</td>
<td>Fader5</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader6</td>
<td>6</td>
<td>7</td>
<td>N/A</td>
<td>Fader6</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader7</td>
<td>7</td>
<td>7</td>
<td>N/A</td>
<td>Fader7</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader8</td>
<td>8</td>
<td>7</td>
<td>N/A</td>
<td>Fader8</td>
<td>0–127</td>
</tr>
<tr>
<td>REW1</td>
<td>—</td>
<td>MMC RW</td>
<td>Moment</td>
<td>REW</td>
<td>N/A</td>
</tr>
<tr>
<td>FF1</td>
<td>—</td>
<td>MMC FF</td>
<td>Moment</td>
<td>FF</td>
<td>N/A</td>
</tr>
<tr>
<td>STOP1</td>
<td>—</td>
<td>MMC ST</td>
<td>Moment</td>
<td>STOP</td>
<td>N/A</td>
</tr>
<tr>
<td>PLAY1</td>
<td>—</td>
<td>MMC PL</td>
<td>Moment</td>
<td>PLAY</td>
<td>N/A</td>
</tr>
<tr>
<td>RECORD1</td>
<td>—</td>
<td>MMC RC</td>
<td>Moment</td>
<td>RECORD</td>
<td>N/A</td>
</tr>
<tr>
<td>RTZ1</td>
<td>—</td>
<td>NoAsgn</td>
<td>Moment</td>
<td>RTZ</td>
<td>N/A</td>
</tr>
<tr>
<td>Nav Up1</td>
<td>1</td>
<td>102</td>
<td>Moment</td>
<td>Nav Up</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Down1</td>
<td>1</td>
<td>103</td>
<td>Moment</td>
<td>Nav Dn</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Left1</td>
<td>1</td>
<td>104</td>
<td>Moment</td>
<td>Nav L</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Right1</td>
<td>1</td>
<td>105</td>
<td>Moment</td>
<td>Nav R</td>
<td>0–127</td>
</tr>
<tr>
<td>Rec Arm1</td>
<td>1</td>
<td>106</td>
<td>Latch</td>
<td>RecArm</td>
<td>0–127</td>
</tr>
<tr>
<td>PanMd1</td>
<td>1</td>
<td>107</td>
<td>Latch</td>
<td>Pans</td>
<td>0–127</td>
</tr>
<tr>
<td>SndMd1</td>
<td>1</td>
<td>108</td>
<td>Latch</td>
<td>Sends</td>
<td>0–127</td>
</tr>
<tr>
<td>InsMd1</td>
<td>1</td>
<td>109</td>
<td>Latch</td>
<td>Insert</td>
<td>0–127</td>
</tr>
<tr>
<td>A/F1</td>
<td>1</td>
<td>110</td>
<td>Latch</td>
<td>A/F</td>
<td>0–127</td>
</tr>
<tr>
<td>B/G1</td>
<td>1</td>
<td>111</td>
<td>Latch</td>
<td>B/G</td>
<td>0–127</td>
</tr>
<tr>
<td>C/H1</td>
<td>1</td>
<td>112</td>
<td>Latch</td>
<td>C/H</td>
<td>0–127</td>
</tr>
<tr>
<td>D/I1</td>
<td>1</td>
<td>113</td>
<td>Latch</td>
<td>D/I</td>
<td>0–127</td>
</tr>
<tr>
<td>E/J1</td>
<td>1</td>
<td>114</td>
<td>Latch</td>
<td>F/J</td>
<td>0–127</td>
</tr>
</tbody>
</table>
Table 13. Default Standard MIDI Map, presets A1 and B1

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Footswitch1</td>
<td>8</td>
<td>11</td>
<td>Moment</td>
<td>Footsw</td>
<td>0–127</td>
</tr>
<tr>
<td>EQ2</td>
<td>1</td>
<td>122</td>
<td>Latch</td>
<td>Local</td>
<td>0–127</td>
</tr>
<tr>
<td>Dynmcs2</td>
<td>1</td>
<td>123</td>
<td>Latch</td>
<td>AllOff</td>
<td>0–127</td>
</tr>
<tr>
<td>Insert2</td>
<td>1</td>
<td>124</td>
<td>Latch</td>
<td>OmniOn</td>
<td>0–127</td>
</tr>
<tr>
<td>PanSnd2</td>
<td>1</td>
<td>125</td>
<td>Latch</td>
<td>OmniOff</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &lt;2</td>
<td>1</td>
<td>126</td>
<td>Latch</td>
<td>MonoOn</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &gt;2</td>
<td>1</td>
<td>127</td>
<td>Latch</td>
<td>PolyOn</td>
<td>0–127</td>
</tr>
<tr>
<td>MstByp2</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>MstByp</td>
<td>N/A</td>
</tr>
<tr>
<td>Esc2</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Esc</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct 9</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 9</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct10</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 10</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct11</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 11</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct12</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 12</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct13</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 13</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct14</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 14</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct15</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 15</td>
<td>N/A</td>
</tr>
<tr>
<td>Slct16</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 16</td>
<td>N/A</td>
</tr>
<tr>
<td>Solo 9</td>
<td>1</td>
<td>15</td>
<td>Latch</td>
<td>Solo 9</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo10</td>
<td>2</td>
<td>15</td>
<td>Latch</td>
<td>Solo 10</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo11</td>
<td>3</td>
<td>15</td>
<td>Latch</td>
<td>Solo 11</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo12</td>
<td>4</td>
<td>15</td>
<td>Latch</td>
<td>Solo 12</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo13</td>
<td>5</td>
<td>15</td>
<td>Latch</td>
<td>Solo 13</td>
<td>0–127</td>
</tr>
</tbody>
</table>
Table 13. Default Standard MIDI Map, presets A1 and B1

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solo14</td>
<td>6</td>
<td>15</td>
<td>Latch</td>
<td>Solo 14</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo15</td>
<td>7</td>
<td>15</td>
<td>Latch</td>
<td>Solo 15</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo16</td>
<td>8</td>
<td>15</td>
<td>Latch</td>
<td>Solo 16</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 9</td>
<td>1</td>
<td>14</td>
<td>Latch</td>
<td>Mute 9</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute10</td>
<td>2</td>
<td>14</td>
<td>Latch</td>
<td>Mute 10</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute11</td>
<td>3</td>
<td>14</td>
<td>Latch</td>
<td>Mute 11</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute12</td>
<td>4</td>
<td>14</td>
<td>Latch</td>
<td>Mute 12</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute13</td>
<td>5</td>
<td>14</td>
<td>Latch</td>
<td>Mute 13</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute14</td>
<td>6</td>
<td>14</td>
<td>Latch</td>
<td>Mute 14</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute15</td>
<td>7</td>
<td>14</td>
<td>Latch</td>
<td>Mute 15</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute16</td>
<td>8</td>
<td>14</td>
<td>Latch</td>
<td>Mute 16</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr9</td>
<td>1</td>
<td>10</td>
<td>N/A</td>
<td>Encdr9</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr10</td>
<td>2</td>
<td>10</td>
<td>N/A</td>
<td>Encdr10</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr11</td>
<td>3</td>
<td>10</td>
<td>N/A</td>
<td>Encdr11</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr12</td>
<td>4</td>
<td>10</td>
<td>N/A</td>
<td>Encdr12</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr13</td>
<td>5</td>
<td>10</td>
<td>N/A</td>
<td>Encdr13</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr14</td>
<td>6</td>
<td>10</td>
<td>N/A</td>
<td>Encdr14</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr15</td>
<td>7</td>
<td>10</td>
<td>N/A</td>
<td>Encdr15</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr16</td>
<td>8</td>
<td>10</td>
<td>N/A</td>
<td>Encdr16</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader9</td>
<td>1</td>
<td>7</td>
<td>N/A</td>
<td>Fader9</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader10</td>
<td>2</td>
<td>7</td>
<td>N/A</td>
<td>Fader10</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader11</td>
<td>3</td>
<td>7</td>
<td>N/A</td>
<td>Fader11</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader12</td>
<td>4</td>
<td>7</td>
<td>N/A</td>
<td>Fader12</td>
<td>0–127</td>
</tr>
</tbody>
</table>
### Table 13. Default Standard MIDI Map, presets A1 and B1

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fader13</td>
<td>5</td>
<td>7</td>
<td>N/A</td>
<td>Fader13</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader14</td>
<td>6</td>
<td>7</td>
<td>N/A</td>
<td>Fader14</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader15</td>
<td>7</td>
<td>7</td>
<td>N/A</td>
<td>Fader15</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader16</td>
<td>8</td>
<td>7</td>
<td>N/A</td>
<td>Fader16</td>
<td>0–127</td>
</tr>
<tr>
<td>REW2</td>
<td>—</td>
<td>MMC RW</td>
<td>Moment</td>
<td>REW</td>
<td>N/A</td>
</tr>
<tr>
<td>FF2</td>
<td>—</td>
<td>MMC FF</td>
<td>Moment</td>
<td>FF</td>
<td>N/A</td>
</tr>
<tr>
<td>STOP2</td>
<td>—</td>
<td>MMC ST</td>
<td>Moment</td>
<td>STOP</td>
<td>N/A</td>
</tr>
<tr>
<td>PLAY2</td>
<td>—</td>
<td>MMC PL</td>
<td>Moment</td>
<td>PLAY</td>
<td>N/A</td>
</tr>
<tr>
<td>RECORD2</td>
<td>—</td>
<td>MMC RC</td>
<td>Moment</td>
<td>RECORD</td>
<td>N/A</td>
</tr>
<tr>
<td>RTZ2</td>
<td>—</td>
<td>NoAsgn</td>
<td>Moment</td>
<td>RTZ</td>
<td>N/A</td>
</tr>
<tr>
<td>Nav Up2</td>
<td>1</td>
<td>102</td>
<td>Moment</td>
<td>Nav Up</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Down2</td>
<td>1</td>
<td>103</td>
<td>Moment</td>
<td>Nav Dn</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Left2</td>
<td>1</td>
<td>104</td>
<td>Moment</td>
<td>Nav L</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Right2</td>
<td>1</td>
<td>105</td>
<td>Moment</td>
<td>Nav R</td>
<td>0–127</td>
</tr>
<tr>
<td>Rec Arm2</td>
<td>1</td>
<td>106</td>
<td>Latch</td>
<td>RecArm</td>
<td>0–127</td>
</tr>
<tr>
<td>PanMd2</td>
<td>1</td>
<td>107</td>
<td>Latch</td>
<td>Pans</td>
<td>0–127</td>
</tr>
<tr>
<td>SndMd2</td>
<td>1</td>
<td>108</td>
<td>Latch</td>
<td>Sends</td>
<td>0–127</td>
</tr>
<tr>
<td>InsMd2</td>
<td>1</td>
<td>109</td>
<td>Latch</td>
<td>Insert</td>
<td>0–127</td>
</tr>
<tr>
<td>A/F2</td>
<td>1</td>
<td>110</td>
<td>Latch</td>
<td>A/F</td>
<td>0–127</td>
</tr>
<tr>
<td>B/G2</td>
<td>1</td>
<td>111</td>
<td>Latch</td>
<td>B/G</td>
<td>0–127</td>
</tr>
<tr>
<td>C/H2</td>
<td>1</td>
<td>112</td>
<td>Latch</td>
<td>C/H</td>
<td>0–127</td>
</tr>
<tr>
<td>D/I2</td>
<td>1</td>
<td>113</td>
<td>Latch</td>
<td>D/I</td>
<td>0–127</td>
</tr>
</tbody>
</table>
### Table 13. Default Standard MIDI Map, presets A1 and B1

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>E/J2</td>
<td>1</td>
<td>114</td>
<td>Latch</td>
<td>F/J</td>
<td>0–127</td>
</tr>
<tr>
<td>Footswitch2</td>
<td>8</td>
<td>11</td>
<td>Moment</td>
<td>Footsw</td>
<td>0–127</td>
</tr>
</tbody>
</table>

### 003 Map Preset

### Table 14. Default 003 Map, presets A2 and B2

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAGE 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EQ1</td>
<td>1</td>
<td>122</td>
<td>Latch</td>
<td>Local</td>
<td>0–127</td>
</tr>
<tr>
<td>Dynmcs1</td>
<td>1</td>
<td>123</td>
<td>Latch</td>
<td>AllOff</td>
<td>0–127</td>
</tr>
<tr>
<td>Insert1</td>
<td>1</td>
<td>124</td>
<td>Latch</td>
<td>OmniOn</td>
<td>0–127</td>
</tr>
<tr>
<td>PanSnd1</td>
<td>1</td>
<td>125</td>
<td>Latch</td>
<td>OmniOff</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &lt;1</td>
<td>1</td>
<td>126</td>
<td>Latch</td>
<td>MonoOn</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &gt;1</td>
<td>1</td>
<td>127</td>
<td>Latch</td>
<td>PolyOn</td>
<td>0–127</td>
</tr>
<tr>
<td>MstByp1</td>
<td>1</td>
<td>118</td>
<td>Latch</td>
<td>custom</td>
<td>0–127</td>
</tr>
<tr>
<td>Esc1</td>
<td>1</td>
<td>119</td>
<td>Latch</td>
<td>custom</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 1</td>
<td>1</td>
<td>0</td>
<td>Latch</td>
<td>Slct 1</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 2</td>
<td>1</td>
<td>1</td>
<td>Latch</td>
<td>Slct 2</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 3</td>
<td>1</td>
<td>2</td>
<td>Latch</td>
<td>Slct 3</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 4</td>
<td>1</td>
<td>3</td>
<td>Latch</td>
<td>Slct 4</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 5</td>
<td>1</td>
<td>4</td>
<td>Latch</td>
<td>Slct 5</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 6</td>
<td>1</td>
<td>5</td>
<td>Latch</td>
<td>Slct 6</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 7</td>
<td>1</td>
<td>6</td>
<td>Latch</td>
<td>Slct 7</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 8</td>
<td>1</td>
<td>NoAsgn</td>
<td>N/A</td>
<td>Slct 8</td>
<td>N/A</td>
</tr>
</tbody>
</table>
### Table 14. Default 003 Map, presets A2 and B2

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solo 1</td>
<td>1</td>
<td>62</td>
<td>Latch</td>
<td>Solo 1</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 2</td>
<td>1</td>
<td>63</td>
<td>Latch</td>
<td>Solo 2</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 3</td>
<td>1</td>
<td>64</td>
<td>Latch</td>
<td>Solo 3</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 4</td>
<td>1</td>
<td>65</td>
<td>Latch</td>
<td>Solo 4</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 5</td>
<td>1</td>
<td>66</td>
<td>Latch</td>
<td>Solo 5</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 6</td>
<td>1</td>
<td>67</td>
<td>Latch</td>
<td>Solo 6</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 7</td>
<td>1</td>
<td>68</td>
<td>Latch</td>
<td>Solo 7</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 8</td>
<td>1</td>
<td>69</td>
<td>Latch</td>
<td>Solo 8</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 1</td>
<td>1</td>
<td>78</td>
<td>Latch</td>
<td>Mute 1</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 2</td>
<td>1</td>
<td>79</td>
<td>Latch</td>
<td>Mute 2</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 3</td>
<td>1</td>
<td>80</td>
<td>Latch</td>
<td>Mute 3</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 4</td>
<td>1</td>
<td>81</td>
<td>Latch</td>
<td>Mute 4</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 5</td>
<td>1</td>
<td>82</td>
<td>Latch</td>
<td>Mute 5</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 6</td>
<td>1</td>
<td>83</td>
<td>Latch</td>
<td>Mute 6</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 7</td>
<td>1</td>
<td>84</td>
<td>Latch</td>
<td>Mute 7</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 8</td>
<td>1</td>
<td>85</td>
<td>Latch</td>
<td>Mute 8</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr1</td>
<td>1</td>
<td>46</td>
<td>N/A</td>
<td>Encdr1</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr2</td>
<td>1</td>
<td>47</td>
<td>N/A</td>
<td>Encdr2</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr3</td>
<td>1</td>
<td>48</td>
<td>N/A</td>
<td>Encdr3</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr4</td>
<td>1</td>
<td>49</td>
<td>N/A</td>
<td>Encdr4</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr5</td>
<td>1</td>
<td>50</td>
<td>N/A</td>
<td>Encdr5</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr6</td>
<td>1</td>
<td>51</td>
<td>N/A</td>
<td>Encdr6</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr7</td>
<td>1</td>
<td>52</td>
<td>N/A</td>
<td>Encdr7</td>
<td>0–127</td>
</tr>
<tr>
<td>Controller</td>
<td>MIDI Channel</td>
<td>CC#</td>
<td>Mode</td>
<td>Name</td>
<td>LoVal/HiVal</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td>-----</td>
<td>------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Encdr8</td>
<td>1</td>
<td>53</td>
<td>N/A</td>
<td>Encdr8</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader1</td>
<td>1</td>
<td>16</td>
<td>N/A</td>
<td>Fader1</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader2</td>
<td>1</td>
<td>17</td>
<td>N/A</td>
<td>Fader2</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader3</td>
<td>1</td>
<td>18</td>
<td>N/A</td>
<td>Fader3</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader4</td>
<td>1</td>
<td>19</td>
<td>N/A</td>
<td>Fader4</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader5</td>
<td>1</td>
<td>20</td>
<td>N/A</td>
<td>Fader5</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader6</td>
<td>1</td>
<td>21</td>
<td>N/A</td>
<td>Fader6</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader7</td>
<td>1</td>
<td>22</td>
<td>N/A</td>
<td>Fader7</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader8</td>
<td>1</td>
<td>23</td>
<td>N/A</td>
<td>Fader8</td>
<td>0–127</td>
</tr>
<tr>
<td>REW1</td>
<td>—</td>
<td></td>
<td>MMC RW</td>
<td>Moment</td>
<td>REW</td>
</tr>
<tr>
<td>FF1</td>
<td>—</td>
<td></td>
<td>MMC FF</td>
<td>Moment</td>
<td>FF</td>
</tr>
<tr>
<td>STOP1</td>
<td>—</td>
<td></td>
<td>MMC ST</td>
<td>Moment</td>
<td>STOP</td>
</tr>
<tr>
<td>PLAY1</td>
<td>—</td>
<td></td>
<td>MMC PL</td>
<td>Moment</td>
<td>PLAY</td>
</tr>
<tr>
<td>RECORD1</td>
<td>—</td>
<td></td>
<td>MMC RC</td>
<td>Moment</td>
<td>RECORD</td>
</tr>
<tr>
<td>RTZ1</td>
<td>—</td>
<td>115</td>
<td>Moment</td>
<td>RTZ</td>
<td>N/A</td>
</tr>
<tr>
<td>Nav Up1</td>
<td>1</td>
<td>102</td>
<td>Moment</td>
<td>Nav Up</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Down1</td>
<td>1</td>
<td>103</td>
<td>Moment</td>
<td>Nav Dn</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Left1</td>
<td>1</td>
<td>104</td>
<td>Moment</td>
<td>Nav L</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Right1</td>
<td>1</td>
<td>105</td>
<td>Moment</td>
<td>Nav R</td>
<td>0–127</td>
</tr>
<tr>
<td>Rec Arm1</td>
<td>1</td>
<td>106</td>
<td>Latch</td>
<td>RecArm</td>
<td>0–127</td>
</tr>
<tr>
<td>PanMd1</td>
<td>1</td>
<td>107</td>
<td>Latch</td>
<td>Pans</td>
<td>0–127</td>
</tr>
<tr>
<td>SndMd1</td>
<td>1</td>
<td>108</td>
<td>Latch</td>
<td>Sends</td>
<td>0–127</td>
</tr>
<tr>
<td>InsMd1</td>
<td>1</td>
<td>109</td>
<td>Latch</td>
<td>Insert</td>
<td>0–127</td>
</tr>
</tbody>
</table>
### Table 14. Default 003 Map, presets A2 and B2

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/F1</td>
<td>1</td>
<td>110</td>
<td>Latch</td>
<td>A/F</td>
<td>0–127</td>
</tr>
<tr>
<td>B/G1</td>
<td>1</td>
<td>111</td>
<td>Latch</td>
<td>B/G</td>
<td>0–127</td>
</tr>
<tr>
<td>C/H1</td>
<td>1</td>
<td>112</td>
<td>Latch</td>
<td>C/H</td>
<td>0–127</td>
</tr>
<tr>
<td>D/I1</td>
<td>1</td>
<td>113</td>
<td>Latch</td>
<td>D/I</td>
<td>0–127</td>
</tr>
<tr>
<td>E/J1</td>
<td>1</td>
<td>114</td>
<td>Latch</td>
<td>F/J</td>
<td>0–127</td>
</tr>
<tr>
<td>Footswitch1</td>
<td>1</td>
<td>94</td>
<td>Moment</td>
<td>Footsw</td>
<td>0–127</td>
</tr>
<tr>
<td>EQ2</td>
<td>1</td>
<td>122</td>
<td>Latch</td>
<td>Local</td>
<td>0–127</td>
</tr>
<tr>
<td>Dynmcs2</td>
<td>1</td>
<td>123</td>
<td>Latch</td>
<td>AllOff</td>
<td>0–127</td>
</tr>
<tr>
<td>Insert2</td>
<td>1</td>
<td>124</td>
<td>Latch</td>
<td>OmniOn</td>
<td>0–127</td>
</tr>
<tr>
<td>PanSnd2</td>
<td>1</td>
<td>125</td>
<td>Latch</td>
<td>OmniOff</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &lt;2</td>
<td>1</td>
<td>126</td>
<td>Latch</td>
<td>MonoOn</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &gt;2</td>
<td>1</td>
<td>127</td>
<td>Latch</td>
<td>PolyOn</td>
<td>0–127</td>
</tr>
<tr>
<td>MstByp2</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>MstByp</td>
<td>0–127</td>
</tr>
<tr>
<td>Esc2</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Esc</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 9</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 9</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct10</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 10</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct11</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 11</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct12</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 12</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct13</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 13</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct14</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 14</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct15</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 15</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct16</td>
<td>1</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>Slct 16</td>
<td>0–127</td>
</tr>
</tbody>
</table>
Table 14. Default 003 Map, presets A2 and B2

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solo 9</td>
<td>1</td>
<td>15</td>
<td>Latch</td>
<td>Solo 9</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 10</td>
<td>2</td>
<td>15</td>
<td>Latch</td>
<td>Solo 10</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 11</td>
<td>3</td>
<td>15</td>
<td>Latch</td>
<td>Solo 11</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 12</td>
<td>4</td>
<td>15</td>
<td>Latch</td>
<td>Solo 12</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 13</td>
<td>5</td>
<td>15</td>
<td>Latch</td>
<td>Solo 13</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 14</td>
<td>6</td>
<td>15</td>
<td>Latch</td>
<td>Solo 14</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 15</td>
<td>7</td>
<td>15</td>
<td>Latch</td>
<td>Solo 15</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 16</td>
<td>8</td>
<td>15</td>
<td>Latch</td>
<td>Solo 16</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 9</td>
<td>1</td>
<td>14</td>
<td>Latch</td>
<td>Mute 9</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 10</td>
<td>2</td>
<td>14</td>
<td>Latch</td>
<td>Mute 10</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 11</td>
<td>3</td>
<td>14</td>
<td>Latch</td>
<td>Mute 11</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 12</td>
<td>4</td>
<td>14</td>
<td>Latch</td>
<td>Mute 12</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 13</td>
<td>5</td>
<td>14</td>
<td>Latch</td>
<td>Mute 13</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 14</td>
<td>6</td>
<td>14</td>
<td>Latch</td>
<td>Mute 14</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 15</td>
<td>7</td>
<td>14</td>
<td>Latch</td>
<td>Mute 15</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 16</td>
<td>8</td>
<td>14</td>
<td>Latch</td>
<td>Mute 16</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr 9</td>
<td>1</td>
<td>10</td>
<td>N/A</td>
<td>Encdr 9</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr 10</td>
<td>2</td>
<td>10</td>
<td>N/A</td>
<td>Encdr 10</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr 11</td>
<td>3</td>
<td>10</td>
<td>N/A</td>
<td>Encdr 11</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr 12</td>
<td>4</td>
<td>10</td>
<td>N/A</td>
<td>Encdr 12</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr 13</td>
<td>5</td>
<td>10</td>
<td>N/A</td>
<td>Encdr 13</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr 14</td>
<td>6</td>
<td>10</td>
<td>N/A</td>
<td>Encdr 14</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr 15</td>
<td>7</td>
<td>10</td>
<td>N/A</td>
<td>Encdr 15</td>
<td>0–127</td>
</tr>
</tbody>
</table>
Table 14. Default 003 Map, presets A2 and B2

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encdr16</td>
<td>8</td>
<td>10</td>
<td>N/A</td>
<td>Encdr16</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader9</td>
<td>1</td>
<td>7</td>
<td>N/A</td>
<td>Fader9</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader10</td>
<td>2</td>
<td>7</td>
<td>N/A</td>
<td>Fader10</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader11</td>
<td>3</td>
<td>7</td>
<td>N/A</td>
<td>Fader11</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader12</td>
<td>4</td>
<td>7</td>
<td>N/A</td>
<td>Fader12</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader13</td>
<td>5</td>
<td>7</td>
<td>N/A</td>
<td>Fader13</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader14</td>
<td>6</td>
<td>7</td>
<td>N/A</td>
<td>Fader14</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader15</td>
<td>7</td>
<td>7</td>
<td>N/A</td>
<td>Fader15</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader16</td>
<td>8</td>
<td>7</td>
<td>N/A</td>
<td>Fader16</td>
<td>0–127</td>
</tr>
<tr>
<td>REW2</td>
<td>—</td>
<td>MMC RW</td>
<td>Moment</td>
<td>REW</td>
<td>N/A</td>
</tr>
<tr>
<td>FF2</td>
<td>—</td>
<td>MMC FF</td>
<td>Moment</td>
<td>FF</td>
<td>N/A</td>
</tr>
<tr>
<td>STOP2</td>
<td>—</td>
<td>MMC ST</td>
<td>Moment</td>
<td>STOP</td>
<td>N/A</td>
</tr>
<tr>
<td>PLAY2</td>
<td>—</td>
<td>MMC PL</td>
<td>Moment</td>
<td>PLAY</td>
<td>N/A</td>
</tr>
<tr>
<td>RECORD2</td>
<td>—</td>
<td>MMC RC</td>
<td>Moment</td>
<td>RECORD</td>
<td>N/A</td>
</tr>
<tr>
<td>RTZ2</td>
<td>1</td>
<td>NoAsgn</td>
<td>Moment</td>
<td>RTZ</td>
<td>N/A</td>
</tr>
<tr>
<td>Nav Up2</td>
<td>1</td>
<td>102</td>
<td>Moment</td>
<td>Nav Up</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Down2</td>
<td>1</td>
<td>103</td>
<td>Moment</td>
<td>Nav Dn</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Left2</td>
<td>1</td>
<td>104</td>
<td>Moment</td>
<td>Nav L</td>
<td>0–127</td>
</tr>
<tr>
<td>Nav Right2</td>
<td>1</td>
<td>105</td>
<td>Moment</td>
<td>Nav R</td>
<td>0–127</td>
</tr>
<tr>
<td>Rec Arm2</td>
<td>1</td>
<td>106</td>
<td>Latch</td>
<td>RecArm</td>
<td>0–127</td>
</tr>
<tr>
<td>PanMd2</td>
<td>1</td>
<td>107</td>
<td>Latch</td>
<td>Pans</td>
<td>0–127</td>
</tr>
<tr>
<td>SndMd2</td>
<td>1</td>
<td>108</td>
<td>Latch</td>
<td>Sends</td>
<td>0–127</td>
</tr>
<tr>
<td>InsMd2</td>
<td>1</td>
<td>109</td>
<td>Latch</td>
<td>Insert</td>
<td>0–127</td>
</tr>
</tbody>
</table>
### Table 14. Default 003 Map, presets A2 and B2

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/F2</td>
<td>1</td>
<td>110</td>
<td>Latch</td>
<td>A/F</td>
<td>0–127</td>
</tr>
<tr>
<td>B/G2</td>
<td>1</td>
<td>111</td>
<td>Latch</td>
<td>B/G</td>
<td>0–127</td>
</tr>
<tr>
<td>C/H2</td>
<td>1</td>
<td>112</td>
<td>Latch</td>
<td>C/H</td>
<td>0–127</td>
</tr>
<tr>
<td>D/I2</td>
<td>1</td>
<td>113</td>
<td>Latch</td>
<td>D/I</td>
<td>0–127</td>
</tr>
<tr>
<td>E/J2</td>
<td>1</td>
<td>114</td>
<td>Latch</td>
<td>F/J</td>
<td>0–127</td>
</tr>
<tr>
<td>Footswitch2</td>
<td>8</td>
<td>11</td>
<td>Moment</td>
<td>Footsw</td>
<td>0–127</td>
</tr>
</tbody>
</table>

### Strike Map Preset

### Table 15. Default Strike Map, presets A3 and B3

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQ1</td>
<td>2</td>
<td>80</td>
<td>Latch</td>
<td>MstrEQ</td>
<td>0–127</td>
</tr>
<tr>
<td>Dynmcs1</td>
<td>2</td>
<td>81</td>
<td>Latch</td>
<td>MstrDyn</td>
<td>0–127</td>
</tr>
<tr>
<td>Insert1</td>
<td>2</td>
<td>82</td>
<td>Latch</td>
<td>Jam</td>
<td>0–127</td>
</tr>
<tr>
<td>PanSnd1</td>
<td>2</td>
<td>83</td>
<td>Latch</td>
<td>Surrnd</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &lt;1</td>
<td>2</td>
<td>100</td>
<td>Moment</td>
<td>Scrol&lt;</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &gt;1</td>
<td>2</td>
<td>101</td>
<td>Moment</td>
<td>Scrol&gt;</td>
<td>0–127</td>
</tr>
<tr>
<td>MstByp1</td>
<td>2</td>
<td>79</td>
<td>Latch</td>
<td>MstFdr</td>
<td>0–127</td>
</tr>
<tr>
<td>Esc1</td>
<td>2</td>
<td>64</td>
<td>Latch</td>
<td>Latch</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 1</td>
<td>2</td>
<td>20</td>
<td>Latch</td>
<td>Ins 1</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 2</td>
<td>2</td>
<td>21</td>
<td>Latch</td>
<td>Ins 2</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 3</td>
<td>2</td>
<td>22</td>
<td>Latch</td>
<td>Ins 3</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 4</td>
<td>2</td>
<td>23</td>
<td>Latch</td>
<td>Ins 4</td>
<td>0–127</td>
</tr>
</tbody>
</table>
Table 15. Default Strike Map, presets A3 and B3

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sict 5</td>
<td>2</td>
<td>24</td>
<td>Latch</td>
<td>Ins 5</td>
<td>0–127</td>
</tr>
<tr>
<td>Sict 6</td>
<td>2</td>
<td>25</td>
<td>Latch</td>
<td>Ins 6</td>
<td>0–127</td>
</tr>
<tr>
<td>Sict 7</td>
<td>2</td>
<td>26</td>
<td>Latch</td>
<td>Ins 7</td>
<td>0–127</td>
</tr>
<tr>
<td>Sict 8</td>
<td>2</td>
<td>27</td>
<td>Latch</td>
<td>Ins 8</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 1</td>
<td>2</td>
<td>48</td>
<td>Latch</td>
<td>Solo 1</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 2</td>
<td>2</td>
<td>49</td>
<td>Latch</td>
<td>Solo 2</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 3</td>
<td>2</td>
<td>50</td>
<td>Latch</td>
<td>Solo 3</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 4</td>
<td>2</td>
<td>51</td>
<td>Latch</td>
<td>Solo 4</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 5</td>
<td>2</td>
<td>52</td>
<td>Latch</td>
<td>Solo 5</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 6</td>
<td>2</td>
<td>53</td>
<td>Latch</td>
<td>Solo 6</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 7</td>
<td>2</td>
<td>54</td>
<td>Latch</td>
<td>Solo 7</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 8</td>
<td>2</td>
<td>55</td>
<td>Latch</td>
<td>Solo 8</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 1</td>
<td>2</td>
<td>63</td>
<td>Latch</td>
<td>Mute 1</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 2</td>
<td>2</td>
<td>85</td>
<td>Latch</td>
<td>Mute 2</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 3</td>
<td>2</td>
<td>86</td>
<td>Latch</td>
<td>Mute 3</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 4</td>
<td>2</td>
<td>87</td>
<td>Latch</td>
<td>Mute 4</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 5</td>
<td>2</td>
<td>88</td>
<td>Latch</td>
<td>Mute 5</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 6</td>
<td>2</td>
<td>89</td>
<td>Latch</td>
<td>Mute 6</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 7</td>
<td>2</td>
<td>90</td>
<td>Latch</td>
<td>Mute 7</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute 8</td>
<td>2</td>
<td>91</td>
<td>Latch</td>
<td>Mute 8</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr1</td>
<td>2</td>
<td>110</td>
<td>N/A</td>
<td>Pan 1</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr2</td>
<td>2</td>
<td>111</td>
<td>N/A</td>
<td>Pan 2</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr3</td>
<td>2</td>
<td>112</td>
<td>N/A</td>
<td>Pan 3</td>
<td>0–127</td>
</tr>
</tbody>
</table>
Table 15. Default Strike Map, presets A3 and B3

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encdr4</td>
<td>2</td>
<td>113</td>
<td>N/A</td>
<td>Pan 4</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr5</td>
<td>2</td>
<td>114</td>
<td>N/A</td>
<td>Pan 5</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr6</td>
<td>2</td>
<td>115</td>
<td>N/A</td>
<td>Pan 6</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr7</td>
<td>2</td>
<td>116</td>
<td>N/A</td>
<td>Pan 7</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr8</td>
<td>2</td>
<td>117</td>
<td>N/A</td>
<td>Pan 8</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader1</td>
<td>2</td>
<td>74</td>
<td>N/A</td>
<td>Vol 1</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader2</td>
<td>2</td>
<td>71</td>
<td>N/A</td>
<td>Vol 2</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader3</td>
<td>2</td>
<td>91</td>
<td>N/A</td>
<td>Vol 3</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader4</td>
<td>2</td>
<td>93</td>
<td>N/A</td>
<td>Vol 4</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader5</td>
<td>2</td>
<td>73</td>
<td>N/A</td>
<td>Vol 5</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader6</td>
<td>2</td>
<td>72</td>
<td>N/A</td>
<td>Vol 6</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader7</td>
<td>2</td>
<td>5</td>
<td>N/A</td>
<td>Vol 7</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader8</td>
<td>2</td>
<td>84</td>
<td>N/A</td>
<td>Vol 8</td>
<td>0–127</td>
</tr>
<tr>
<td>REW1</td>
<td>—</td>
<td>—</td>
<td>MMC RW</td>
<td>Moment</td>
<td>REW</td>
</tr>
<tr>
<td>FF1</td>
<td>—</td>
<td>—</td>
<td>MMC FF</td>
<td>Moment</td>
<td>FF</td>
</tr>
<tr>
<td>STOP1</td>
<td>—</td>
<td>—</td>
<td>MMC ST</td>
<td>Moment</td>
<td>STOP</td>
</tr>
<tr>
<td>PLAY1</td>
<td>—</td>
<td>—</td>
<td>MMC PL</td>
<td>Moment</td>
<td>PLAY</td>
</tr>
<tr>
<td>RECORD1</td>
<td>—</td>
<td>—</td>
<td>MMC RC</td>
<td>Moment</td>
<td>RECORD</td>
</tr>
<tr>
<td>RTZ1</td>
<td>—</td>
<td>—</td>
<td>NoAsgn</td>
<td>Moment</td>
<td>NoAsgn</td>
</tr>
<tr>
<td>Nav Up1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>Nav Down1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>Nav Left1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>Nav Right1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
</tbody>
</table>
### Table 15. Default Strike Map, presets A3 and B3

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rec Arm1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>PanMd1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>SndMd1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>InsMd1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>A/F1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>B/G1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>C/H1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>D/I1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>E/J1</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsgn</td>
<td>N/A</td>
</tr>
<tr>
<td>Footswitch1</td>
<td>2</td>
<td>94</td>
<td>Moment</td>
<td>Footsw</td>
<td>0–127</td>
</tr>
</tbody>
</table>

**PAGE 2**

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQ2</td>
<td>2</td>
<td>80</td>
<td>Latch</td>
<td>MstrEQ</td>
<td>0–127</td>
</tr>
<tr>
<td>Dynmcs2</td>
<td>2</td>
<td>81</td>
<td>Latch</td>
<td>MstDyn</td>
<td>0–127</td>
</tr>
<tr>
<td>Insert2</td>
<td>2</td>
<td>82</td>
<td>Latch</td>
<td>Jam</td>
<td>0–127</td>
</tr>
<tr>
<td>PanSnd2</td>
<td>2</td>
<td>83</td>
<td>Latch</td>
<td>Surrnd</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &lt;2</td>
<td>2</td>
<td>100</td>
<td>Moment</td>
<td>Scrol&lt;</td>
<td>0–127</td>
</tr>
<tr>
<td>Page &gt;2</td>
<td>2</td>
<td>101</td>
<td>Moment</td>
<td>Scrol&gt;</td>
<td>0–127</td>
</tr>
<tr>
<td>MstByp2</td>
<td>2</td>
<td>79</td>
<td>Latch</td>
<td>MstFdr</td>
<td>0–127</td>
</tr>
<tr>
<td>Esc2</td>
<td>2</td>
<td>64</td>
<td>Latch</td>
<td>Latch</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct 9</td>
<td>2</td>
<td>28</td>
<td>Latch</td>
<td>Ins 9</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct10</td>
<td>2</td>
<td>29</td>
<td>Latch</td>
<td>Ins 10</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct11</td>
<td>2</td>
<td>30</td>
<td>Latch</td>
<td>Ins 11</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct12</td>
<td>2</td>
<td>31</td>
<td>Latch</td>
<td>Ins 12</td>
<td>0–127</td>
</tr>
<tr>
<td>Controller</td>
<td>MIDI Channel</td>
<td>CC#</td>
<td>Mode</td>
<td>Name</td>
<td>LoVal/HiVal</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td>------</td>
<td>-------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Slct13</td>
<td>2</td>
<td>35</td>
<td>Latch</td>
<td>Ins OH</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct14</td>
<td>2</td>
<td>41</td>
<td>Latch</td>
<td>Ins Rm</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct15</td>
<td>2</td>
<td>46</td>
<td>Latch</td>
<td>Ins TB</td>
<td>0–127</td>
</tr>
<tr>
<td>Slct16</td>
<td>2</td>
<td>47</td>
<td>Latch</td>
<td>Ins Ms</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo 9</td>
<td>2</td>
<td>56</td>
<td>Latch</td>
<td>Solo 9</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo10</td>
<td>2</td>
<td>57</td>
<td>Latch</td>
<td>Solo10</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo11</td>
<td>2</td>
<td>58</td>
<td>Latch</td>
<td>Solo11</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo12</td>
<td>2</td>
<td>59</td>
<td>Latch</td>
<td>Solo12</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo13</td>
<td>2</td>
<td>60</td>
<td>Latch</td>
<td>SoloOH</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo14</td>
<td>2</td>
<td>61</td>
<td>Latch</td>
<td>SoloRm</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo15</td>
<td>2</td>
<td>62</td>
<td>Latch</td>
<td>SoloTB</td>
<td>0–127</td>
</tr>
<tr>
<td>Solo16</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>Mute 9</td>
<td>2</td>
<td>103</td>
<td>Latch</td>
<td>Mute 9</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute10</td>
<td>2</td>
<td>104</td>
<td>Latch</td>
<td>Mute10</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute11</td>
<td>2</td>
<td>105</td>
<td>Latch</td>
<td>Mute11</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute12</td>
<td>2</td>
<td>106</td>
<td>Latch</td>
<td>Mute12</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute13</td>
<td>2</td>
<td>107</td>
<td>Latch</td>
<td>MuteOH</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute14</td>
<td>2</td>
<td>108</td>
<td>Latch</td>
<td>MuteRm</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute15</td>
<td>2</td>
<td>109</td>
<td>Latch</td>
<td>MuteTB</td>
<td>0–127</td>
</tr>
<tr>
<td>Mute16</td>
<td>2</td>
<td>NoAssign</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>Encdr9</td>
<td>2</td>
<td>118</td>
<td>N/A</td>
<td>Pan 9</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr10</td>
<td>2</td>
<td>119</td>
<td>N/A</td>
<td>Pan 10</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr11</td>
<td>2</td>
<td>98</td>
<td>N/A</td>
<td>Pan 11</td>
<td>0–127</td>
</tr>
<tr>
<td>Controller</td>
<td>MIDI Channel</td>
<td>CC#</td>
<td>Mode</td>
<td>Name</td>
<td>LoVal/HiVal</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td>-----</td>
<td>------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Encdr12</td>
<td>2</td>
<td>99</td>
<td>N/A</td>
<td>Pan 12</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr13</td>
<td>2</td>
<td>9</td>
<td>N/A</td>
<td>OH Wid</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr14</td>
<td>2</td>
<td>14</td>
<td>N/A</td>
<td>Rm Wid</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr15</td>
<td>2</td>
<td>15</td>
<td>N/A</td>
<td>TB Drv</td>
<td>0–127</td>
</tr>
<tr>
<td>Encdr16</td>
<td>2</td>
<td>75</td>
<td>N/A</td>
<td>ClsMic</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader9</td>
<td>2</td>
<td>24</td>
<td>N/A</td>
<td>Vol 9</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader10</td>
<td>2</td>
<td>25</td>
<td>N/A</td>
<td>Vol 10</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader11</td>
<td>2</td>
<td>26</td>
<td>N/A</td>
<td>Vol 11</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader12</td>
<td>2</td>
<td>27</td>
<td>N/A</td>
<td>Vol 12</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader13</td>
<td>2</td>
<td>76</td>
<td>N/A</td>
<td>Overhd</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader14</td>
<td>2</td>
<td>92</td>
<td>N/A</td>
<td>Room</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader15</td>
<td>2</td>
<td>95</td>
<td>N/A</td>
<td>TkBack</td>
<td>0–127</td>
</tr>
<tr>
<td>Fader16</td>
<td>2</td>
<td>7</td>
<td>N/A</td>
<td>Master</td>
<td>0–127</td>
</tr>
<tr>
<td>REW2</td>
<td>—</td>
<td>MMC RW</td>
<td>Moment</td>
<td>REW</td>
<td>N/A</td>
</tr>
<tr>
<td>FF2</td>
<td>—</td>
<td>MMC FF</td>
<td>Moment</td>
<td>FF</td>
<td>N/A</td>
</tr>
<tr>
<td>STOP2</td>
<td>—</td>
<td>MMC ST</td>
<td>Moment</td>
<td>STOP</td>
<td>N/A</td>
</tr>
<tr>
<td>PLAY2</td>
<td>—</td>
<td>MMC PL</td>
<td>Moment</td>
<td>PLAY</td>
<td>N/A</td>
</tr>
<tr>
<td>RECORD2</td>
<td>—</td>
<td>MMC RC</td>
<td>Moment</td>
<td>RECORD</td>
<td>N/A</td>
</tr>
<tr>
<td>RTZ2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Moment</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>Nav Up2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>Nav Down2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>Nav Left2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>Nav Right2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
</tbody>
</table>
**Table 15. Default Strike Map, presets A3 and B3**

<table>
<thead>
<tr>
<th>Controller</th>
<th>MIDI Channel</th>
<th>CC#</th>
<th>Mode</th>
<th>Name</th>
<th>LoVal/HiVal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rec Arm2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>PanMd2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>SndMd2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>InsMd2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>A/F2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>B/G2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>C/H2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>D/I2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>E/J2</td>
<td>2</td>
<td>NoAsgn</td>
<td>Latch</td>
<td>NoAsn</td>
<td>N/A</td>
</tr>
<tr>
<td>Footswitch2</td>
<td>2</td>
<td>94</td>
<td>Moment</td>
<td>Footsw</td>
<td>N/A</td>
</tr>
</tbody>
</table>
appendix a

Utility Mode (003 Only)

003 is in this mode when the Utility switch is enabled (flashing). In Utility mode, you can run pre-programmed diagnostic tests of the 003 unit. The Utility switch is unavailable in Pro Tools mode.

Utility functions include the following:
- Software and firmware version display
- Tests for the LCD display, LEDs, switches, rotary encoders, faders, MIDI, and audio.
- Return MIDI Maps to factory default settings. See Chapter 12, “Using MIDI Mode with 003.”

⚠️ Utility mode is not available in Pro Tools mode. Pro Tools must be closed to enable Utility mode.

Navigating Utility Mode

When running a Utility mode test, you can return to the previous Utility page or exit the test at anytime.

To return to the previous Utility page:
- Press the flashing Display Mode switch.

To exit a test:
- Press the flashing ESC switch or Display Mode switch.

Exiting Utility Mode

To exit Utility mode:
1. If a test is running, press ESC or Display Mode to exit the test.
2. Press the flashing Utility mode switch.

Accessing Utility Mode

To enter Utility mode:
1. If Pro Tools is running, choose Pro Tools > Quit (Mac) or File > Exit (Windows).
2. Press the Utility switch.

The Utility switch flashes when it is enabled.

The LCD shows the top level Utility functions across the lower row: Version and Test. The corresponding Channel View switches flash for each available Utility option.
Viewing Firmware Version Data

This Utility function lets you check the current firmware version and other statistics useful when upgrading, or when contacting technical support.

To display firmware version data:
1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select Version by pressing the flashing EQ switch.

The LCD shows version information about various components of the unit.
3. To exit and return to the previous Utility mode display, press the flashing Display Mode switch.

LCD Display Test

Use this test to assess the performance of the LCD.

To test the LCD:
1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.
3. Select the LCD test by pressing the flashing Dynamics switch.

The 003 automatically scrolls all of its character sets across the LCD display.

4. To stop scrolling and quickly tell if any area of the display is damaged, press and hold any switch except for the Display Mode switch.

5. Do one of the following:
   - To return to the previous Utility page, press the flashing Display Mode switch.
   - or –
   - To exit the test at anytime, press the flashing ESC switch or Display Mode switch.

LED Tests

Use this test to display all LEDs simultaneously or cycle through the LEDs.

To test LEDs:
1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.
3. Select the LED menu by pressing the flashing Insert switch.

4. Do one of the following
   - To display all LEDs, press the flashing Dynamics switch.
   - or –
   - To cycle through all the LEDs, press the flashing Insert switch.

5. To exit the test at anytime, press any switch.
Switch Test

Use this test to evaluate the performance of switches.

To test switches:

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch. The LCD shows the first page of Utility tests.
3. Select the Switch test display by pressing the flashing Pan/Send switch.
4. Press any top panel switch to test it. The LCD shows the name, region and number for each switch as you test it.
5. To exit the test at anytime, press the Display Mode switch.

Encoder Test

Use this test to evaluate the performance of the rotary encoders or the Jog/Shuttle wheel.

To test the encoders:

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch.
   The LCD shows the first page of Utility tests.
3. Enter the Encoder test by pressing the flashing Page Left switch.
4. Rotate any encoder (or the Jog/Shuttle wheel) to test it. Encoder value is displayed in the LCD while testing.
5. To exit the test at anytime, press the Display Mode switch.

Fader Tests

Utility mode provides tests for fader and group performance. You can use these routines to troubleshoot the mechanical elements of the faders.

Automated Fader Tests

These automated fader tests check fader performance. You can use these routines to troubleshoot the mechanical elements of the faders.

To test fader resolution:

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch. The LCD shows the first page of Utility tests.
3. Select the Fader menu by pressing the flashing Page Right switch.
4. Select one of the basic automated fader tests: Triang, Sine, or Step.
   The faders will automatically move in a triangular, sine, or step pattern, as selected.
5. To exit the test at anytime, press any switch.

⚠️ Do not touch the faders during a Fader test.

The faders will automatically move in a triangular, sine, or step pattern, as selected.
**Fader Group Test**

**To test fader group resolution:**

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

3. Select the Fader menu by pressing the flashing Page Right switch.
4. Enter the Group test by select the flashing Page Left switch.
5. One by one, touch and move each fader. The other seven faders follow, and the LCD shows the resolution for each fader as they move through their range so you can compare fader performance as both a group master and slave.
6. To exit the test at anytime, press the flashing Display Mode switch.

**Touch Test**

This test lets you test the touch sensitivity of each fader. The LCD display shows when a fader is touched and what frequency the fader is currently recognizing. The fader frequency value is updated in real time.

**To test the touch sensitivity of the faders:**

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

3. Select the Fader menu by pressing the flashing Page Right switch.
4. Enter the Touch test by select the flashing Page Right switch.
5. One by one, touch and move each fader. The LCD shows the resolution for each fader as they move through their range.
6. To exit the test at anytime, press the flashing Display Mode switch.

---

**Vegas Mode**

**Vegas Mode**

Vegas mode randomly lights every switch, meter, and display on the unit, and runs the faders in sine wave mode.

**To enter Vegas mode:**

1. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.
2. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

3. Start “Vegas” mode by pressing the flashing Page Right switch.
4. To exit the test at anytime, press any switch.
MIDI Test

003 includes a MIDI loopback test to check MIDI input and output connections. A standard 5-pin MIDI cable is required.

To test MIDI input and output connections:

1. On the back of the 003, connect a standard 5-pin MIDI cable from the MIDI In port to the MIDI Out 1.

2. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.

3. Select the Test menu by pressing the flashing Insert switch.

   The LCD shows the first page of Utility tests.

4. Press the ESC switch to toggle to the second page of Utility tests.

5. Start the “MIDI” test by pressing the flashing Dynamics switch.

6. Press the EQ switch to begin testing MIDI Out 1.

   If data is received on the MIDI jack, the LCD shows “Pass.” If DATA is not received, the LCD shows “Fail.”

7. Connect a standard 5-pin MIDI cable from the MIDI In port to the MIDI Out 2 and repeat the test to check MIDI Out 2.

8. When finished, press the flashing Display switch.

Audio Test

003 includes audio loopback tests (see “Routing Path for Audio Tests” on page 150) to check various audio connections. For each test, a valid audio source and external sound system must be set up for the specific inputs or outputs being tested. See “Making Studio Connections” on page 77 for information on connecting devices.

Cables corresponding to each connector type are required. See “003 and 003 Rack Back Panels” on page 61 for cabling requirements for each connector.

When testing a digital input, the digital source must be connected to one of the 003 digital outputs and the source must be configured to clock to the 003 digital output.

All tests run at 44.1 kHz.
### Routing Path for Audio Tests

<table>
<thead>
<tr>
<th>Audio Test</th>
<th>Routing Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intl</td>
<td>Internal loopback of all analog and digital I/O channels (Analog Input 1 to Analog Output 1, Analog Input 2 to Analog Output 2, and so on).</td>
</tr>
<tr>
<td>Sgnl</td>
<td>003 generates a 440 Hz sine wave on all analog and digital outputs. Level is adjustable from 0 dB to –42 dB with the rotary encoder in the second fader strip.</td>
</tr>
<tr>
<td>SpIn 1/2</td>
<td>S/PDIF (RCA) Inputs to Analog Outputs 1–2.</td>
</tr>
<tr>
<td>SpIn 3/4</td>
<td>S/PDIF (RCA) Inputs to Analog Outputs 3–4.</td>
</tr>
<tr>
<td>SpIn 5/6</td>
<td>S/PDIF (RCA) Inputs to Analog Outputs 5–6.</td>
</tr>
<tr>
<td>SpIn 7/8</td>
<td>S/PDIF (RCA) Inputs to Analog Outputs 7–8.</td>
</tr>
<tr>
<td>SpIn All</td>
<td>S/PDIF (RCA) Inputs to all Analog Output pairs.</td>
</tr>
<tr>
<td>SpOt 1/2</td>
<td>Analog Inputs 1–2 to S/PDIF (RCA) Outputs.</td>
</tr>
<tr>
<td>SpOt 5/6</td>
<td>Analog Inputs 5–6 to S/PDIF (RCA) Outputs.</td>
</tr>
<tr>
<td>SpOt 7/8</td>
<td>Analog Inputs 7–8 to S/PDIF (RCA) Outputs.</td>
</tr>
<tr>
<td>SpOt All</td>
<td>All Analog input pairs to S/PDIF (RCA) Outputs.</td>
</tr>
<tr>
<td>SpAg</td>
<td>Simultaneous routing of S/PDIF (RCA) Inputs to Analog Outputs 1–2 and Analog Inputs 1–2 to S/PDIF (RCA) Outputs.</td>
</tr>
<tr>
<td>Adat</td>
<td>Simultaneous routing of ADAT Optical Inputs to Analog Outputs 1–8 and Analog Inputs 1–8 to ADAT Optical Outputs.</td>
</tr>
</tbody>
</table>

### Testing Audio Connections

To test audio connections:

1. Make the necessary connection for the input and output you are testing. See “Routing Path for Audio Tests” on page 150.

2. Enter Utility mode. If the Utility switch is not enabled (flashing), press it.

3. Select the Test menu by pressing the flashing Insert switch.

The LCD shows the first page of Utility tests.

4. Press the ESC switch to toggle to the second page of Utility tests.

5. Enter “Audio” test mode by pressing the flashing Inserts (Channel View) switch.

6. Begin an Audio test by pressing the Channel View switch that corresponds to the test you want to run.

7. For the S/PDIF In and Out tests, press the Dynamics or Insert switch repeated times to toggle through the different test, or to test all of the S/PDIF routing paths.

8. When finished, press the flashing Display switch.
Appendix B

Configuring AMS (Mac OS X Only)

Audio MIDI Setup

Pro Tools recognizes the ports on your MIDI interface as generic ports. With Mac OS X, you use Apple’s Audio MIDI Setup (AMS) utility to identify external MIDI devices connected to your MIDI interface and configure your MIDI studio for use with Pro Tools.

To configure your MIDI studio in AMS:

1. Do one of the following:
   - Launch Audio MIDI Setup (located in Applications/Utilities). Click Window > Show Window to view MIDI studio.
   - or –

2. Click the MIDI Devices tab. AMS scans your system for connected MIDI interfaces. If your MIDI interface is properly connected, it appears in the window with each of its ports numbered.

3. For any MIDI devices connected to the MIDI interface, click Add Device. A new external device icon with the default MIDI keyboard image will appear.

4. Drag the new device icon to a convenient location within the window.
5 Connect the MIDI device to the MIDI interface by clicking the arrow for the appropriate output port of the device and dragging a connection or “cable” to the input arrow of the corresponding port of the MIDI interface.

6 Click the arrow for the appropriate input port of the device and drag a cable to the output arrow of the corresponding port of the MIDI interface.

7 Repeat steps 3–6 for each MIDI device in your MIDI setup.

To configure an external MIDI device:

1 Select the external device icon and click Show Info (or double-click the new device icon).

2 Select a manufacturer and model for the new device from the corresponding pop-up menus. (If the Manufacturer and Model pop-up menus do not provide a name for your particular device, you can type a name.)

For Manufacturer and Model names, AMS refers to one or more files with the suffix “.middev” in the directory Root/Library/Audio/MIDI Devices. Pro Tools installs a file that contains information for many commercially available MIDI devices, named “Digidesign Device List.middev.” If the Manufacturer or Model names for any of your external MIDI devices is not available in the AMS Manufacturer and Model pop-up menus, you can add them by editing the .middev file in any text editor (such as TextEdit).
3 Click the More Information arrow to expand the dialog, then enable the appropriate MIDI channels (1–16) for the Transmits and Receives options. (These determine which channels the device will use to send and receive MIDI.)

![Enabling MIDI channels](image1)

4 Click the device image. The window expands to show images for various MIDI devices (such as keyboards, modules, interfaces, and mixers). Select an icon for your device.

![Selecting a device icon](image2)

💡 To use your own custom icons, you can place TIFF image files in `/Library/Audio/MIDI Devices/Generic/Images`, and they will appear as choices in the AMS device window.

5 Click OK.

The device names you enter appear as MIDI input and output choices in Pro Tools.
Patch Name Support

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for your external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in /Library/Audio/MIDI Patch Names/Digidesign.

To import MIDI patch names into Pro Tools:

1. Verify the MIDI Device name in the Audio MIDI Setup window (see “Audio MIDI Setup” on page 151).
2. Verify the Instrument or MIDI track output is correctly assigned to the MIDI device.
3. Click the Instrument or MIDI track Patch Select button.
4. In the Patch Select dialog, click Change.
5. In the Open dialog, navigate to /Library/Audio/MIDI Patch Names/Digidesign/<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.
6. Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.

To clear patch names:

- In the Patch Select dialog, click Clear, and click Done.

MIDI patch name files (.midnam) can be edited in any text editor, or you can use third-party patch librarian and editor software to create your own custom patch names.
Configuring MIDI Studio Setup (Windows Only)

MIDI Studio Setup

MIDI Studio Setup (MSS) lets you configure the MIDI controllers and sound modules that are connected to your system, and control the routing of MIDI data between your MIDI equipment and Pro Tools.

MSS automatically finds MIDI interfaces, and lets you specify a custom name for each of the MIDI ports within the MIDI Studio Setup document.

MSS also supports XML-based patch file names for storing and importing patch names for your external MIDI devices.

Entire MIDI Studio Setup configurations created within MSS can be imported and exported.

MIDI Studio Setup Window

The MIDI Studio Setup window is organized into three sections. Interface controls are at the top of the window. All the currently defined instruments are displayed in the Instrument Name list on the left side of the window. A detailed view of MIDI parameters is shown in the Properties section on the right.
**Interface Controls**

**Create** Adds a new instrument to the Instrument Name list.

**Delete** Deletes the instrument or instruments selected in the Instrument Name list.

**Import** Imports an existing MIDI Studio Setup file.

**Export** Exports the current MIDI Studio Setup file.

**Show Duplicate Emulated Ports** When this option is selected and you are using a MIDI interface that supports timestamping (such as MIDI I/O), in addition to the MIDI ports on your 003 Family interface, the MIDI Studio setup window shows both the DirectMusic time-stamped output ports, and non-stamped duplicate emulated output ports.

⚠️ Some MIDI Interfaces will not properly load or unload their drivers unless you quit and re-launch Pro Tools. Check the documentation that came with your MIDI interface for more information.

**Instrument List**

The Instrument list contains all the currently defined instruments. Selecting an instrument in the list displays that instrument’s properties in the Properties section of the window.

**Properties Section**

The Properties section lets you edit information for new instruments, or instrument currently selected in the Instrument list.

![MIDI Studio Setup Properties section](image)

When a previously defined instrument is selected in the Instrument list, the Properties section changes to reflect the properties of the selected instrument.

**To define an instrument with MIDI Studio Setup:**

1. Choose Setup > MIDI > MIDI Studio.
2. Click Create.
3. In the Instrument Name field, type the name of your instrument, and press Enter.

⚠️ If you do not enter an instrument name, the Instrument Name field will automatically inherit information from the Manufacturer and Model pop-up menu.

4. Set a manufacturer and model for the new device from the corresponding pop-up menus. If the Manufacturer and Model pop-up menus do not provide a name for your particular device, select None.
5. From the Input pop-up menu, select the input port on your MIDI interface that is connected to the MIDI Out of your instrument.
6 From the Output pop-up menu, select the output port on your MIDI interface that is connected to the MIDI In of your instrument.

7 Enable the appropriate MIDI channels (1–16) for the Send Channels and Receive Channels options (These determine which channels send and receive MIDI.)

**Instrument Name**

The Instrument Name field shows the user-definable instrument name for the currently selected instrument.

**Manufacturer**

The Manufacturer pop-up menu provides a list of MIDI equipment manufacturers. This list is derived from the XML-based MIDI device files.

*For more information, see “MIDI Patch Name Support” on page 157.*

**Model**

The Model pop-up menu provides a list of MIDI devices, filtered by the manufacturer name. This list is derived from the XML-based MIDI device files provided with your Pro Tools installation.

*For more information, see “MIDI Patch Name Support” on page 157.*

**Input Port**

The Input Port pop-up menu displays a list of available MIDI interface input ports. Inputs will include 003 and any additional MIDI interfaces enabled on your system. The MIDI interface port that is set and displayed here is the port through which MIDI data is sent from the external MIDI device specified in the Instrument Name field into your MIDI interface.

⚠️ *If you set the input port to None, the defined instrument will not appear as a choice in a MIDI Input selector.*

**Output Port**

The Output Port pop-up menu displays a list of available MIDI interface output ports. The port set and displayed here is the port through which MIDI data is sent from your MIDI interface to the MIDI device specified in the Instrument Name field.

⚠️ *If you set the output port to None, the defined instrument will not appear as a choice in a MIDI Output selector.*

**Send Channels**

The Send Channels grid sets the send channels for the MIDI device specified in the Instrument Name field.

**Receive Channels**

The Receive Channels grid sets the receive channels for the MIDI device specified in the Instrument Name field.

**MIDI Patch Name Support**

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for your external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in C:\Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign.
**To import MIDI patch names into Pro Tools:**

1. Verify the MIDI Device name in the MIDI Studio Setup window (see “MIDI Studio Setup” on page 155).

2. Verify the Instrument or MIDI track output is correctly assigned to the MIDI device.

3. Click the Instrument or MIDI track Patch Select button.

4. In the Patch Select dialog, click **Change**.

5. In the Open dialog, navigate to C:\Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign\<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.

6. Click **Open**.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.

**To clear patch names:**

- In the Patch Select dialog, click **Clear** and then click **Done**.

*MIDI patch name files (.midnam) can be edited in any text editor, or you can use third-party patch librarian and editor software to create your own custom patch names.*
Appendix D: Hard Drive Configuration and Maintenance

It is recommended that you start with a newly formatted external or secondary internal audio drive. You should also periodically defragment your audio drive to ensure continued system performance.

⚠️ Always back up any important data on your drive before formatting it, as it will erase all data on the drive.

Supported Drive Formats and Drive Types

**Drive Formats**

**Mac** Mac systems should use drives formatted with HFS+ or HFS file system only.

⚠️ HFS drives are supported as Transfer drives only.

**Windows** Windows XP systems should use drives formatted as NTFS only.

⚠️ Windows systems can also support Mac drives formatted with HFS+ system (also commonly referred to as Mac OS Extended). Refer to the Pro Tools Reference Guide for more information (Help > Pro Tools Reference Guide).

Avoid Recording to the System Drive

Recording to your system drive is not recommended. Recording and playback on a system drive may result in lower track counts or fewer plug-ins.

Hard drive performance depends on factors including system configuration, number of tracks, session sample rate, density of edits, and the use of crossfades and other processes such as Beat Detective in a session.

For complete hard drive requirements, visit our website (www.avid.com).
SCSI Hard Drives

Avid recommends qualified SCSI hard drives and a qualified SCSI host bus adapter (HBA) card or (on Windows systems) a qualified built-in SCSI HBA connector on the motherboard.

For complete information on track count and the supported number and configuration of SCSI drives, visit our website (www.avid.com).

FireWire Hard Drives

Avid recommends qualified FireWire drives and (on Windows systems) a qualified FireWire host adapter.

For complete information on track count and the supported number and configuration of FireWire drives, visit our website (www.avid.com).

IDE/ATA/SATA Hard Drives

A qualified internal IDE/ATA/SATA drive may be used as a dedicated audio drive.

For complete information on track count with internal drives, visit our website (www.avid.com).

Formatting an Audio Drive

Formatting Mac Audio Drives

For optimum performance, audio drives should be formatted as Mac OS Extended (Journaled).

To format an audio drive:

1. Launch the Disk Utility application, located in Macintosh HD/Applications/Utilities.

2. Click the Erase tab.

3. Select the drive you want to initialize in the column on the left side of the window.

4. Choose the Mac OS Extended (Journaled) format.

⚠️ Do not choose the “Case-Sensitive” format option. Pro Tools will not operate properly with case-sensitive formatted drives.

5. Type a name for the new volume.

6. If you plan to connect the drive to a Mac OS 9 computer, select Install Mac OS 9 Drivers. (Mac OS 9 options only appear in 10.5 or below)

7. Click Erase.

The drive appears on the Desktop with the new volume name.
Format the Drive as NTFS

1. Right-click Computer (Windows 7, Windows Vista) or My Computer (Windows XP) and choose Manage.
2. Under Storage, choose Disk Management.
3. If the volume is “Healthy,” do the following:
   - In the Disk Management window, right-click the hard drive you will use for audio and choose Format.
   - In the Format window, name the volume.
   - Choose a file system. For optimum performance, audio drives should be formatted as NTFS.
   - Select Perform a quick format.
   - Make sure Enable file and folder compression is not selected.
   - Set the Allocation unit size to Default.
   - Click OK.

4. If the volume is “Unallocated,” do the following:
   - In the Disk Management window, right-click the hard drive you will use for audio and choose New Partition.
   - In the New Partition Wizard window, click Next.
   - When prompted, select the partition type.
   - Follow the on-screen instructions to select a partition size and other partition settings.
   - When prompted, choose a file system. For optimum performance, audio drives should be formatted as NTFS.
   - Select Perform a quick format.
   - Make sure Enable file and folder compression is not selected.
   - Set the Allocation unit size to Default.
   - Click OK.

Partitioning Drives

Partitioning creates a logical volume or volumes on a physical drive, almost as if you were creating virtual hard drives. Partitions can then be formatted with the appropriate file system (NTFS for Windows, HFS+ for Mac (also referred to as Mac OS Extended (Journaled))).

Windows XP allows drives formatted with the NTFS file system to be seen as whole volumes. Single Pro Tools audio files cannot exceed 2048 MB in size.
Seek Times on Partitioned Drives

Seek times are actually faster on partitioned drives (assuming that reads and writes are performed on a single partition), since the heads only have to seek within the partition boundaries, rather than the whole capacity of the drive.

Smaller partitions perform faster than larger partitions, but this comes at the expense of contiguous storage space. When you partition a drive, you will need to find the compromise that best suits your performance and storage requirements.

Avoid distributing audio files within a session over different partitions on the same drive since this will adversely affect drive performance.

Defragmenting an Audio Drive

Mac Systems

When working with larger files (such as video), you can limit fragmentation by backing up your important files to another disk, erasing the files from the original hard disk, then copying the files back, instead of doing a defragmentation.

Window Systems

Periodically defragment audio drives to maintain system performance.

For maximum recording and playback efficiency, data should be written to your hard drive in a contiguous fashion—minimizing the seek requirements to play back the data. Unfortunately, your computer can’t always store the sound files in this way and must write to disk wherever it can find space.

In multitrack recording, audio tracks are written in discrete files, spaced evenly across the disk. While fragmentation of individual files may be zero, the tracks may be far enough apart that playback will still be very seek-intensive. Also, the remaining free space on the disk will be discontiguous, increasing the likelihood of file fragmentation on subsequent record passes.

Increased fragmentation increases the chance of disk errors, which can interfere with playback of audio, and result in performance errors.

On Windows, to avoid fragmentation, format drives with higher cluster sizes (such as 32K).

Optimizing (Defragmenting) Drives

To prevent fragmentation, you can optimize your drive, which rearranges your files into a contiguous format. Most optimizing software lets you run a check on a drive to find out the percentage of fragmentation. If your drive shows moderate to heavy fragmentation, you should consider optimizing it.

If you use your system for intensive editing, or if you frequently delete audio or fade files from your hard drive, you may need to optimize your drives on a weekly basis, or even every few days, since it doesn’t take long for even a large hard drive to become fragmented.
Backing Up Data Before Optimizing

Since your files will be rewritten by the optimization process, always make a backup copy of the data on your hard drive before you optimize it. You should also use a hard drive utility to find and repair any problems before optimizing data or re-initializing your drives. If there is any damage to your hard drive's directories prior to optimizing, serious data loss may result.

Defragmenting Windows Audio Drives

To defragment an audio drive (Windows 7 and Windows Vista):

1. Click Start.

2. Type “disk defragmenter” in the search field at the bottom. “Disk Defragmenter” should appear at the top of the search results.

3. Click the Disk Defragmenter.

4. Click the Defragment disk button (Windows 7) or the Defragment now button (Windows Vista). Follow the on-screen instructions.

5. When defragmenting is complete, close the Disk Defragmenter window.

In Windows 7 you can Ctrl-Click on the drive names to select multiple drives to defragment, and once more than one drive is selected, the button changes to “Defragment disks.”

The “Defragment Now” (Vista only) command defragments all your hard drives. This can take a lot of time, especially on systems with multiple drives.

Advanced users can use the command line tool Defrag.exe to defragment individual drives. See your Windows Vista documentation for more information.

To defragment an audio drive (Windows XP):

1. Right-click My Computer and choose Manage.

2. Under Storage, choose Disk Defragmenter.

3. In the Disk Defragmenter window, choose the drive you want to defragment.

4. Click the Defragment button and follow the on-screen instructions.

When defragmenting is complete, close the Computer Management window.

Using Mac Drives on Windows Systems

Pro Tools for Windows lets you record and play back sessions directly from a Mac-formatted (HFS+) drive connected to a Windows system. This functionality requires that all Mac session and audio files be stored on Mac-formatted drives.

During Pro Tools installation, make sure to select the Mac HFS+ Disk Support option. This option lets your Pro Tools system read, write, record, and play back using Mac-formatted HFS+ disks.

For information on using the Mac HFS+ Disk Support option, see the HFS+ Disk Support Option Guide.

For information on sharing sessions between Mac and Windows systems, see the Pro Tools Reference Guide (Help > Pro Tools Reference Guide).

Formatting HFS+ Drives

To format and partition any drives as HFS+, connect the drives to a Mac computer and use the Apple OS X Disk Utility to format the drives as Mac OS Extended (Journaled).
Hard Disk Storage Space

Mono audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 5 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 7.5 MB per minute.

Stereo audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 10 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 15 MB per minute.

Table 5 lists the required disk space for certain track numbers and track lengths at 44.1 and 48 kHz, to help you estimate your hard disk usage.

Table 5. Required hard drive space for audio tracks (44.1 kHz and 48 kHz sessions shown)

<table>
<thead>
<tr>
<th>Number of tracks and length</th>
<th>16-bit at 44.1 kHz</th>
<th>16-bit at 48 kHz</th>
<th>24-bit at 44.1 kHz</th>
<th>24-bit at 48 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 mono track, 1 minute</td>
<td>5 MB</td>
<td>5.5 MB</td>
<td>7.5 MB</td>
<td>8.2 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 5 minutes</td>
<td>50 MB</td>
<td>55 MB</td>
<td>75 MB</td>
<td>83 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 60 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 5 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 60 minutes</td>
<td>7 GB</td>
<td>7.8 GB</td>
<td>10.5 GB</td>
<td>11.6 GB</td>
</tr>
<tr>
<td>32 mono tracks, 5 minutes</td>
<td>800 MB</td>
<td>883 MB</td>
<td>1.2 GB</td>
<td>1.3 GB</td>
</tr>
<tr>
<td>32 mono tracks, 60 minutes</td>
<td>9.4 GB</td>
<td>10.4 GB</td>
<td>14 GB</td>
<td>15.4 GB</td>
</tr>
</tbody>
</table>
Mono audio tracks recorded with 24-bit resolution at 96 kHz require approximately 16.5 MB of hard disk space per minute (a little more than twice as much as at 44.1 kHz).

Stereo audio tracks recorded with 24-bit resolution at 96 kHz require about 33 MB per minute.

Table 6 lists the required disk space for certain track numbers and track lengths at 88.1 and 96 kHz, to help you estimate your hard disk usage.

---

**Table 6. Required hard drive space for audio tracks (88.2 kHz and 96 kHz sessions shown)**

<table>
<thead>
<tr>
<th>Number of tracks and length</th>
<th>16-bit at 88.2 kHz</th>
<th>16-bit at 96 kHz</th>
<th>24-bit at 88.2 kHz</th>
<th>24-bit at 96 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 mono track, 1 minute</td>
<td>10 MB</td>
<td>11 MB</td>
<td>15 MB</td>
<td>16.4 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 5 minutes</td>
<td>100 MB</td>
<td>110 MB</td>
<td>150 MB</td>
<td>166 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 60 minutes</td>
<td>1200 MB</td>
<td>1324 MB</td>
<td>1800 MB</td>
<td>1982 MB</td>
</tr>
<tr>
<td>24 mono tracks, 5 minutes</td>
<td>1200 MB</td>
<td>1324 MB</td>
<td>1800 MB</td>
<td>1982 MB</td>
</tr>
<tr>
<td>24 mono tracks, 60 minutes</td>
<td>14 GB</td>
<td>15.6 GB</td>
<td>21 GB</td>
<td>23.2 GB</td>
</tr>
<tr>
<td>32 mono tracks, 5 minutes</td>
<td>1600 MB</td>
<td>1766 MB</td>
<td>2.4 GB</td>
<td>2.6 GB</td>
</tr>
<tr>
<td>32 mono tracks, 60 minutes</td>
<td>18.8 GB</td>
<td>20.8 GB</td>
<td>28 GB</td>
<td>30.8 GB</td>
</tr>
</tbody>
</table>
Appendix E: Troubleshooting

Backing Up Your Work

It is highly recommended that you back up your work on a regular basis, and especially before making changes to your system configuration.

Backing Up Your Session Data

Back up your session and audio data frequently. There are a variety of media that are suited to back up projects of various sizes, from automated tape backup systems to high-capacity optical drives, or to CD burners.

The best way to back up an entire session is to use the Save Copy In command. This command lets you save the session file and all of its associated files to a new location.

💡 The Auto Save Backup feature (in the Operation Preferences page) sets Pro Tools to automatically save backups of the session file while you work.

Backing Up Your System Configuration

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Norton Ghost (Windows) or Bombich Carbon Copy Cloner (Mac). By doing this, you can quickly restore your system configuration and settings if you encounter any problems.

Common Issues

Pro Tools Won’t Launch

Problem

When you double-click the Pro Tools application or a Pro Tools session file, Pro Tools doesn’t launch, or displays an error message.

Possible Solutions

- Check to be sure your computer has the required amount of RAM to launch Pro Tools. Visit www.avid.com/compatibility.
- Try a complete restart. Turn off your audio interfaces, computer peripherals and your computer, and then turn them on again in the proper sequence.
If you tried to launch Pro Tools by double-clicking a Pro Tools session file, do the following:

- Close any error message.
- Double-click the Pro Tools application.
- In Pro Tools, choose File > Open Session to open the session.
- Reinstall the Pro Tools application, using the Pro Tools Installer disc.

Audio Interface Is Not Recognized

Problem

When you launch Pro Tools it does not recognize an audio interface, or a connected audio interface is not available.

Possible Solutions

- Turn off your computer and check to be sure your cables are properly and securely connected to your computer and to your audio interface.
- Verify that your Hardware Setup dialog settings are correct.

Performance Factors

There are several conditions that may adversely affect the performance of Pro Tools. These include:

Network Connections Close any network connections unless you are using them for network interchange of audio data.

Background Applications Any software utilities that run in the background or generate disk activity, such as virus protection, disk optimization, or file savers, should be turned off or removed.

Screen Savers Screen saver software should be completely disabled on your computer before running Pro Tools.

Power Saver Features Some automatic power saver features, such as those that spin down the system hard drive, can affect Pro Tools performance. These features should be turned off.
Before You Call Avid Support

Register Your System

Register your purchase by following the instructions on the Registration Information Card included with your system. By registering, you become eligible to receive the following:

- Technical support information
- Software update and upgrade notices
- Hardware warranty information

Gather Important Information

Avid wants to help you resolve problems as quickly and efficiently as possible. If you collect the following information before you contact Avid Support, it will make the diagnosis of your problem easier.

System Information

Computer

- Make, model, processor speed
- Amount of system RAM
- Operating system (version of Windows or Mac OS)
- Any Drivers, Disk Utilities, or other system-related applications you may have installed

Pro Tools Hardware

- Type of cards (if any), interfaces, or peripherals

Hard Drives

- Make, Model
- Drive size (GB)
- Drive speed (RPM)
- Drive type (SCSI, FireWire, IDE/ATA)
- Utility used to format the drive
- Number and size of partitions on the drive

Pro Tools Software

- Pro Tools software version
- Plug-In versions
- Other Pro Tools software options or components
- Additional plug-ins from Avid Development Partners

Other Hardware

Refer to the manufacturer’s documentation for operational details.

The most common hardware additions include:

- 1394 (FireWire) cards for Windows systems (manufacturer, model)
- Video Capture cards (manufacturer, model)

To verify that your hardware is qualified for use with your Pro Tools system, visit:

www.avid.com/compatibility

Other Software

If you are using other audio or video applications, refer to the manufacturer’s documentation for operational details.

Make note of any other software that was running when a problem occurred.

Diagnostic Information

Note any DAE errors or other error codes you encounter. Also, note the ability to reproduce the problem under different conditions, for example, with another session, or after changing settings (such as the Hardware Buffer Size).
Whether you are new to Pro Tools or just starting out with your new system, we encourage you to read and utilize the many guides that Pro Tools provides. There are also useful online resources available, giving you everything from Pro Tools tips to Pro Tools answers.

**About the Pro Tools Guides**

In addition to any printed guides included with your system, PDF versions of the printed guides and many additional Pro Tools guides and Read Mes are installed automatically during Pro Tools installation (see “Documentation Installed Automatically with Pro Tools” on page 172).

printed copies of the Pro Tools Reference Guide and other guides in the Pro Tools guide set can be purchased separately from the Avid Online Store (http://shop.avid.com).

**Printed Setup Guide**

This printed Setup Guide for your system gives you detailed instructions for setting up and configuring software and hardware for optimum performance.

**Printed Intro to Pro Tools Guide**

The printed Intro to Pro Tools has tutorials on using Pro Tools (such as recording in a Pro Tools session, importing audio from a CD, and creating an audio CD from a Pro Tools session).

**Guides Accessible in Pro Tools**

The main Pro Tools guides are accessible from the Pro Tools Help menu. (Choose Help, then select a guide.)

These include:

- **Pro Tools Shortcuts** provides a complete list of keyboard and Right-click shortcuts for Pro Tools.
- **Audio Plug-Ins Guide** describes the audio plug-ins included with Pro Tools for both real-time and file-based audio processing as well as many other paid plug-in option offered from Avid.
- **Pro Tools Menus Guide** covers all the Pro Tools on-screen menus.
- **Pro Tools Reference Guide** explains Pro Tools software in extensive detail.
Documentation Installed Automatically with Pro Tools

When you install Pro Tools, you get useful PDF versions of many Pro Tools guides and Read Mes. This documentation can be found in the following locations:

**Mac** Applications/Digidesign/Documentation

**Windows** C:\Program Files\Digidesign\Documentation

💡 To view or print PDF guides, you can use Adobe Reader (recommended) or Apple Preview (Mac only).

Read Me Files

These contain late-breaking information and known issues pertaining to Pro Tools software and hardware configurations. Read Me files are installed in Documentation folder when you install Pro Tools.

Helpful Online Resources

Once you get going, here are some helpful online resources:

- For questions about installation, visit our online Knowledge Base. Go to: http://www.avid.com/support

- Get useful information, help, and tips from the worldwide community of Pro Tools users at our User Conference. Go to: http://duc.avid.com

- If you can’t find your answer in the Knowledge Base or User Conference, contact email support. Go to: http://www.avid.com/support

About www.avid.com

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

**Product Registration** Register your purchase online.

**Support and Downloads** Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Knowledge Base or join the worldwide Pro Tools community on the User Conference.

**Training and Education** Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools training center.

**Products and Developers** Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

**News and Events** Get the latest news from Avid or sign up for a Pro Tools demo.
Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the product.

Proposition 65 Warning

⚠️ This product contains chemicals, including lead, known to the State of California to cause cancer and birth defects or other reproductive harm. Wash hands after handling.

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires the following disclosure statement: “Perchlorate Material – special handling may apply, See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

Appendix G: Compliance Information
EMC (Electromagnetic Compliance)

Avid declares that this product complies with the following standards regulating emissions and immunity:
- FCC Part 15 Class B
- EN55022 Class B
- EN55024 Class B
- AS/NZS 3548 Class B
- CISPR 22 Class B

FCC Compliance for United States

Radio and Television Interference

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules.

DECLARATION OF CONFORMITY

We, Avid, 2001 Junipero Serra Boulevard
Daly City, CA 94014-3886, USA
650-731-6300
declare under our sole responsibility that the product
003, 003 Rack, 003 Rack+i
complies with Part 15 of FCC Rules.
Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and
(2) this device must accept any interference received,
including interference that may cause undesired operation.

Communication Statement

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:
- Reorient or locate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
Any modifications to the unit, unless expressly approved by Avid, could void the user’s authority to operate the equipment.

Australian Compliance

Canadian Compliance

This Class B digital apparatus complies with Canadian ICES-003
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada

CE Compliance

(EMC and Safety)

Avid is authorized to apply the CE (Conformité Européenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 89/336/EEC and Low Voltage Directive 2006/95/EEC.
Safety Compliance

Safety Statement

This equipment has been tested to comply with USA and Canadian safety certification in accordance with the specifications of UL Standards: UL60065 7th / IEC 60065 7th and Canadian CAN/CSA C22.2 60065:03. Avid Inc., has been authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Warning

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this equipment near water.
6) Clean only with dry cloth.
7) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
8) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.
9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
10) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.
11) Only use attachments/accessories specified by the manufacturer.
12) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.
13) Unplug this equipment during lightning storms or when unused for long periods of time.
14) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has been dropped.
15) For products that are a Mains powered device: The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment.
16) For products containing a lithium battery: CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type.
17) For products with a power switch: The main power switch is located on the back panel of the 003, and on the front panel of the 003 Rack and 003 Rack+. It should remain accessible after installation.
18) The equipment shall be used at a maximum ambient temperature of 40° C.
Numerics
003
  1394 LED 41
  Display section 40
  Fader section 42
  Headphone jacks 56
  LCD display 40
  Monitor section 56
  Power switch 66
  Pro Tools mode 93
  top panel 39
  top panel shortcuts 113
  Transport section 50
  window show/hide switches 52
003 Rack 67
  1394 LED 59
  front panel 57
  Headphone jacks 57
  Monitor section 58
  Power switch 57
003 Rack+
  1394 LED 69
  front panel 67
  Headphone jacks 67
  Monitor section 68
  Power switch 67
1394
  LED (003 Rack) 59
  LED (003) 41
  port 65, 75
3/4-HP2 switch
  003 56
  003 Rack 58, 69
4-pin FireWire cable (Windows) 19

A
AC power connector 66, 76
ADAT
  connecting 87, 91
  LED (003 Rack) 59
  LED (003 Rack+) 69
  LED (003) 41
  Optical I/O 64, 74
additional software
  Mac 9
Alt CR switch
  003 56
  003 Rack 58
  003 Rack+ 69
Alt Monitor Outputs (003 and 003 Rack) 63
Alt Monitor Outputs (003 Rack+) 73
Analog Inputs 5–8 63
analog tape deck, connecting 91
Arrow keys 51
ASIO 17
Assign mode 104
assigning
  inputs and outputs 104
  inserts 106
  sends 105
audio drivers
  CoreAudio driver (Mac) 9
  Windows 17
Audio MIDI Setup (AMS) (Mac) 151
Audio tests 149
authorizing Pro Tools 8, 16
Auto (Automation) Channel Meter LED 45
Automation modes
  setting 112
  switch LEDs 54
  switches 54
Aux In (to Monitor) switch
003 56
003 Rack 58, 69
Aux In to 7/8 switch
003 56
003 Rack 58
003 Rack+ 69
Aux Ins (003 and 003 Rack) 64
Aux Ins (003 Rack+) 73
Avid
customer success 172
Avid Audio Drivers 17
Avid CoreAudio Driver 9

B
Bank switch 52
banking
Master Faders 112
banking channels
eight channels at a time 111
one channels at a time 111
scrolling 111
bypassing
all plug-ins 99
single plug-in 96, 99

C
cables, microphone 80
Cache Size 26
cancel 49
CC# (Stand-alone mode) 122
Chan (Stand-alone mode) 122
channel controls
Channel Select switches 43
faders 42
Mute switch 43
Rec Arm switch 45
rotary encoders 44
Solo switch 43
Channel Meter LEDs 44, 45
Auto (Automation) 45
Left 45
Right 45
Channel Select switches 43
Channel View 97
switches 48
switches in MIDI mode 120
Clean Uninstall (Mac) 11
Clock Source 28
compatibility 3
connecting
ADAT 87, 91
analog tape deck 91
digital devices 91
external effects devices 88
guitars 83
headphones 77
keyboards 84
microphones 80
microphones (1/4-inch connector) 82
microphones (XLR connector) 80
MIDI devices 91
mixdown recorder 91
mixers 84
S/PDIF Optical devices 87
S/PDIF RCA devices 87
connecting a sound system 77
Console View 94, 97
switches 47
switches in MIDI mode 120
CoreAudio driver (Mac) 9
CPU Usage Limit 23, 24
cursor
moving one frame at a time 109
moving up or down one track 109
cycling
Dynamics plug-ins 98
EQ plug-ins 97
inserts 99

D
DAE Playback Buffer Size 25
DAT recorder, connecting 91
default settings 109
Default switch 46
DI Inputs 1–4 (003 and 003 Rack) 62
digital devices, connecting 91
Direct Inject inputs 62
Direct Interface inputs (003 and 003 Rack) 62
Display Mode switch 41
Display section 40
Display switches 52
displaying
channel pan setting and send levels temporarily 101
Dynamics plug-in controls 98
Dynamics plug-ins on a track 97
EQ plug-in controls 97
EQ plug-ins on a track 97
fader level temporarily 101
full names of insert parameters 100
full names of tracks 100
insert settings temporarily 101
inserts on a track 98
Memory Locations 110
plug-in controls 96, 98
plug-in settings temporarily 101
send level temporarily 101
sends on a track 99
settings instead of control names 100
settings instead of track names 100
DMA option (Windows), enabling 32
drive formatting
Mac 160
Windows 161
drive maintenance 159
drive requirements 3
drivers
Mac 9
Windows 17
Dynamics plug-ins
cycling through 98
displaying all on a track 97
displaying controls 98
Dynamics switch 49

E
Edit selection
during playback 109
extending up or down a track 109
moving up or down one track 109
Edit switch 52
Edit window
Edit window
zooming 108
scrolling 109
encoders
MIDI mode 120
Energy Saver (Mac), turning off 30
Enter switch 53
entry fields, navigating 103
EQ
in Channel View 97
EQ plug-ins
cycling through 97
displaying all on a track 97
displaying controls 97
EQ switch 49
ESC switch 49
external effects devices, using 88
F
F1 Utility 145
Fader Flip switch 46
Fader Group test 148
Fader Mute switch 53
Fader section 42
faders 42
Flip mode 110
MIDI mode 120
testing and resetting 147
Fast Forward 50
FFW 50
FireWire
4-pin cable (Windows) 19
connecting drives 66, 75
connecting drives (Mac) 10
connecting drives (Windows) 18
connecting other devices 66, 76
connecting other devices (Mac) 10
connecting other devices (Windows) 19
connection status (003 Rack) 59
connection status (003) 41
port 65, 75
FireWire requirements 160
firmware
updating (Mac) 8
updating (Windows) 17
viewing firmware version 146
Flip mode 110
views 111
Focus switch 53
footswitch 92
footswitch (003 and 003 Rack) 65
footswitch (003 Rack+) 75
G
guitar, connecting 83

H
hard drives
  drive formats 159
  FireWire 66, 75
  FireWire (Mac) 10
  FireWire (Windows) 18
  FireWire requirements 160
  formatting 160, 161
  formatting (Mac) 160
  IDE/ATA requirements 160
  maintenance 159, 162
  optimizing 162
  partitioning 161
  requirements 3
  SCSI requirements 160
  space requirements 164, 165
Hardware Buffer Size 22
Hardware Setup dialog 27
headphones
  connecting 77
  jacks (003 Rack) 57
  jacks (003 Rack+) 67
  jacks (003) 56
  Level controls (003 Rack) 58, 68
  Level controls (003) 56
headroom 61, 71
high pass filter switches
  003 55
  003 Rack 58, 68
Host status LED 41, 59
HPF switches
  003 55
  003 Rack 58, 68

I
I/O Setup 29
IDE/ATA requirements 160
IEEE-1394
  port 65, 75
Ignore Errors During Playback/Record option 24
Input 1–4 Gain controls
  003 55
  003 Rack 57
Input 1-8 Gain controls (003 Rack+) 68
Input Channel Select switches (003 Rack+) 68
Input switch 46
inputs
  Analog Inputs 5–8 63
    assigning 104
  Aux In (003 and 003 Rack) 64
  Aux In (003 Rack+) 73
  controls (003 Rack) 57
  controls (003) 55
  DI Inputs 1–4 (003 and 003 Rack) 62
  Line/DI inputs 1-8 (003 Rack+) 72
  Mic Inputs 1–4 (003 and 003 Rack) 62
  Mic Inputs 1-8 (003 Rack+) 72
  MIDI 65, 75
  Optical 64, 74
  S/PDIF 64, 74
Insert switch
  Channel View 49
  Console View 48
Insert View (Console View) 96
Insert/Send Position switches 48
inserts 49
  assigning 106
  bypassing a plug-in 96
  cycling through 99
  displaying an Insert position 96
  displaying inserts on a track 98
  displaying plug-in controls 96
  in Channel View 49
  working with 96
installing
  Pro Tools (Mac) 5
  Pro Tools (Windows) 13
  QuickTime (Windows) 16

J
Jog mode 51
Jog/Shuttle wheel 51
  Jog mode 51
  Shuttle mode 51
journaling (Mac), enabling 32

K
Kensington Lock port 65
knobs (see rotary encoders)
Latch Automation
  LED 54
  switch 54
-latency
  Hardware Buffer Size 22
launching Pro Tools 8, 16
LCD
  display 40
  test 146
LEDs
  Automation modes 54
  test 146
Left Channel Meter LED 45
Lightpipe 65, 74
Link indicator 66, 76
Loop Play switch 52
Loop Rec switch 52

Main Analog Outputs 1–8 (003 and 003 Rack) 63
Main Analog Outputs 1–8 (003 Rack+) 73
Main Monitor Outputs 63
Main Monitor Outputs (003 Rack+) 73
Master Faders 46
Mem Loc switch 52
Memory Locations
  creating 110
  displaying 110
  recalling 110
  switch 52
  working with 110
Meter switch 45
meters
  channel LEDs 44
Mic Inputs 1–4 (003 and 003 Rack) 62
Mic Inputs 1–8 (003 Rack+) 72
Mic/DI
  controls (003 Rack) 57
  controls (003) 55
  switches (003 Rack) 58
  switches (003) 55
microphones
  1/4-inch connectors 82
  cables 80
  connecting 80
  inputs 62, 72
phantom power 80
XLR connectors 80
MIDI
  connections 91
  editing maps in MIDI mode 122
  monitoring 92
  requirements 3
  setup (Mac) 151
  setup (Windows) 155
  Stand-alone CC assign 122
  Stand-alone channel assign 122
  test 149
MIDI Data LEDs
  003 41
  003 Rack 59
  003 Rack+ 69
MIDI Edit 122
MIDI Edit switch 53
MIDI In (003 and 003 Rack) 65
MIDI In (003 Rack+) 75
MIDI Machine Control (see MMC)
MIDI Map preset
  editing 121
  naming 123
  recalling 119
  saving 123
MIDI Map switches 53
MIDI mode 38
  and MMC 120
  assigning controllers 121
  editing presets 121
  entering 118
  MIDI Edit mode 122
  naming presets 123
  programmable controls and defaults 120
  programming and editing 121
  recalling presets 119
  saving presets 123
  selecting 118
MIDI Out 1 65, 75
MIDI Out 2 65
MIDI Recall switch 53
MIDI Studio Setup (MSS) (Windows) 155
Minimize Additional I/O Latency option 25
mirroring outputs 78
Mix switch 52
mixdown and connecting a recorder 91
MMC 120
MME 17

modes
  Flip mode 46
  MIDI mode 38
  Pro Tools mode 37
  Standby mode 37
  Third-Party Software mode 38
  Utility mode 38, 145

modifier keys 55
  Command 54
  Control 54
  Option 54
  Shift 54

Monitor Level control
  003 56
  003 Rack 58, 69

Monitor Mute switch
  003 56
  003 Rack 58
  003 Rack+ 69

Monitor section
  003 56
  003 Rack 58
  003 Rack+ 69

Mstr Faders switch 46

Mute switch 43
muting fader movement 112

N
navigating 108
network cards (Windows), disabling 34
network connections 168
New Tracks dialog 103
Nudge switch 52

O
Off
  Automation LED 54
  Automation switch 54
OK switch 53
Operating Level switches 63
operating levels 61, 71
Optical format 29
Optical I/O 64, 74
optimizing hard drives 162
Output windows 107
outputs
  Alt Monitor (003 and 003 Rack) 63
  Alt Monitor (003 Rack+) 73
  assigning 104
digital 64, 74
  Main Analog Outputs 1–8 (003 and 003 Rack) 63
  Main Analog Outputs 1–8 (003 Rack+) 73
  Main Monitor 63
  Main Monitor (003 Rack+) 73
  MIDI 65, 75
  mirroring 78
  Optical 64, 74
  S/PDIF 64, 74

P
Page switches 49
Pan switches 48
Pan View 94
Pan/Send Flip mode 111
Pan/Send switch 49
panning
  adjusting on a track that has sends 100
  panning a track 94
partitioning hard drives 161
phantom power
  enabling on an input 81
  when to use 80
Phantom Power switches 62
Play 50
Playback Engine
  RTAS Processors setting 23
playing
  backwards at a variable rate 109
  forwards at a variable rate 109
Plug-In Flip mode 111
Plug-In Master Bypass switch 49
Plug-In Streaming Buffer 27
Plug-In Streaming Buffer Size 26
Plug-In switch 52
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plug-ins</td>
<td></td>
</tr>
</tbody>
</table>
  - bypassing all 99  
  - bypassing one 99  
  - displaying controls 96, 98  
  - multiprocessors 23  
  - RTAS Processors setting 23  
  - toggling views 53 |
| Power | 66, 76  
  - Power switch  
    003 66  
    003 Rack 57, 67 |
| Pro Tools |  
  - as Word clock master 87  
  - as Word clock slave 88  
  - authorizing 8, 16  
  - demo session 9, 18  
  - hardware settings 27  
  - installing (Mac) 5  
  - installing (Windows) 13  
  - launching 8, 16  
  - removing (Windows) 11, 19  
  - setting defaults 109 |
| Pro Tools LE |  
  - capabilities 2  
  - Pro Tools mode 93  
  - adding comments 104  
  - Assign mode 104  
  - assigning inputs and outputs 104  
  - assigning inserts 106  
  - assigning sends 105  
  - automation 112  
  - banking channels 111  
  - banking Master Fader tracks 112  
  - Channel View 97  
  - Console View 94, 97  
  - display options 100  
  - editing entry field values 103  
  - enabling 93  
  - Flip mode 110  
  - Insert View workflows (Console View) 96  
  - Memory Locations 110  
  - muting fader movement 112  
  - naming tracks 104  
  - navigating Edit window 108  
  - navigating entry fields 103  
  - navigating New Tracks dialog 103  
  - Output windows 107  
  - overview 37  
  - Pan View workflows 94 |
| Record enabling tracks | 108  
  - renaming tracks 95  
  - saving a session 93  
  - Send View workflows 95  
  - shortcuts 113  
  - Undo operations 110  
  - Processor Scheduling performance (Windows) 35  
  - Program Change dialog 154, 158 |
| Q |  
  - QuickPunch switch 52  
  - QuickTime installation (Windows) 16 |
| R |  
  - Read Automation  
    - LED 54  
    - switch 54  
  - Rec Arm switch 45  
  - recalling a Memory Location 110  
  - Record 50  
  - recording  
    - disabling tracks 108  
    - enabling tracks 108  
  - removing Pro Tools  
    - Windows 11, 19  
  - renaming a track 95  
  - Return to Zero 50  
  - REW 50  
  - Rewind 50  
  - Right Channel Meter LED 45  
  - rotary encoders 44  
    - Flip mode 110  
    - LEDs 44  
    - test  
  - RTAS Processors setting 23  
  - RTZ 50 |
| S |  
  - S/PDIF  
    - connecting Optical devices 87  
    - connecting RCA devices 87  
    - input and output ports 64, 74  
    - LED (003 Rack) 59  
    - LED (003 Rack+) 69  
    - LED (003) 41  
  - Safe Uninstall (Mac) 11 |
sample rate 61, 71
  default 27
Save switch 53
saving a session (003) 93
screen savers 168
scrolling the Edit window 109
SCSI requirements 160
selecting
  a range of tracks 94
  a track 94
  all tracks 95
  noncontiguous tracks 95
Send Flip mode 111
Send switch 48
Send View 95
sends
  adjusting send level 95, 100
  assigning 105
  displaying a Send position 95
  displaying sends on a track 99
  to external effects devices 89
  toggling pre- and post-fader 96, 100
  viewing level 101
  working with 95
Shuttle mode 51
Software Update (Mac), turning off 30
Solo switch 43
sound system
  connecting 77
Spotlight indexing (Mac), disabling 32
Stand-alone mode
  assigning CC 122
  assigning control channel 122
Standby mode 37
starting Pro Tools 8, 16
Startup items (Windows), disabling 35
Stop 50
Suspend switch 54
suspending automation 112
switches
  3/4-HP 2 (003 Rack) 58, 69
  3/4-HP 2 (003) 56
  Alt CR (003 Rack) 58
  Alt CR (003 Rack+) 69
  Alt CR (003) 56
  Automation modes 54
  Aux In (to Monitor) (003 Rack) 58, 69
  Aux In (to Monitor) (003) 56
  Aux In to 7/8 (003 Rack) 58
  Aux In to 7/8 (003 Rack+) 69
  Aux In to 7/8 (003) 56
  Bank switch 52
  Channel View 48
  Console View 47
  Default 46
  Display Mode 41
  Dynamics 49
  Edit window 52
  Enter 53
  EQ 49
  ESC 49
  Fader Flip 46
  Fader Mute 53
  Focus 53
  HPF (003 Rack) 58, 68
  HPF (003) 55
  Input 46
  Insert (Channel View) 49
  Insert (Console View) 48
  Insert/Send Position 48
  Line-DI (003 Rack+) 68
  Loop Play 52
  Loop Rec 52
  Mem Loc 52
  Mic/DI (003 Rack) 58
  Mic/DI (003) 55
  MIDI Edit 53
  MIDI Map 53
  MIDI mode 120
  MIDI Recall 53
  Mix window 52
  Monitor Mute (003 Rack) 58
  Monitor Mute (003 Rack+) 69
  Monitor Mute (003) 56
  Mono (003 Rack) 58
  Mono (003 Rack+) 69
  Mono (003) 56
  Nudge switch 52
  Operating Level 63
  Page 49
  Pan 48
  Pan/Send 49
  Phantom Power 62
  Plug-In Master Bypass 49
  Plug-In window 52
  QuickPunch 52
  Save 53
Send 48
Suspend 54
testing 147
Undo 53
Utility 53
Zoom switch 52

SYNC LEDs
003 41
003 Rack 59
003 Rack+ 69

system
optional optimizations (Windows) 34
recommended optimizations (Windows) 34
required optimizations (Windows) 32
shutting down 21
starting up 21

system optimization
Mac 30
Windows 34

system requirements 3

system settings
Cache Size 26
Clock Source 28
configuring 22
CPU Usage Limit 24
Hardware Buffer Size 22
I/O Setup 29
Optical format 29
Plug-In Streaming Buffer 27
Plug-In Streaming Buffer Size 26
Sample Rate 27

T
technical support 172
product registration required 169
testing
audio connections 149
faders 147
LCD 146
LEDs 146
MIDI connections 149
rotary encoders 147
switches 147
Third-Party Software mode 38
toggling plug-in views 53
Touch Automation
LED 54
switch 54

Touch test 148
tracks
adding comments 104
decreasing number of 103
increasing number of 103
naming 104
navigating New Tracks dialog 103
renaming 95
selecting 94
selecting a range 94
selecting all 95
selecting noncontiguous tracks 95
Transport
and MMC 120
controls in MIDI mode 120
moving one frame at a time 109

U
Undo operations 110
Undo switch 53
uninstalling Pro Tools
Mac 11
Windows 19
User Account Control (UAC)
disabling 34
Utility mode 38, 145
accessing 145
Audio tests 149
automated Fader tests 147
Encoder test
exiting 145
Fader Group test 148
Fader tests 147
firmware version 146
LCD test 146
LED test 146
MIDI test 149
navigating 145
Switch test 147
Touch test 148
Vegas mode 148
Utility switch 53

V
Vegas mode 148
W

W Clk LED
  003 41
  003 Rack 59
  003 Rack+ 69

WaveDriver 17

window show/hide switches 52

Word Clock
  In and Out ports 65, 74
  LED (003 Rack) 59
  LED (003 Rack+) 69
  LED (003) 41
  Pro Tools as master 87
  Pro Tools as slave 88

working
  in Channel View 97
  in Console View 94, 97
  in Insert View (Console View) 96
  in Pan View 94
  in Send View 95

Write Automation
  LED 54
  switch 54

Z

Zoom switch 52

zooming 108